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1 Document information

1.1 Document function

These Operating Instructions contain all the information that is required in various phases
of the life cycle of the device: from product identification, incoming acceptance and
storage, to mounting, connection, operation and commissioning through to
troubleshooting, maintenance and disposal.

Integrated Operating Instructions

At the push of a button, the device displays operating instructions directly on the screen.
This manual complements the operating instructions in the device and explains what is
not directly described in the operating instructions.

1.2 Symbols used

1.2.1  Safety symbols

Symbol Meaning

DANGER!
PINDYYYESEY | This symbol alerts you to a dangerous situation. Failure to avoid this situation will result in
serious or fatal injury.

WARNING!
A\ WARNING | | This symbol alerts you to a dangerous situation. Failure to avoid this situation can result in
serious or fatal injury.

CAUTION!
A CAUTION | This symbol alerts you to a dangerous situation. Failure to avoid this situation can result in
minor or medium injury.

NOTE!
NOTICE This symbol contains information on procedures and other facts which do not result in
personal injury.

1.2.2  Electrical symbols

Symbol Meaning Symbol Meaning
—_— Direct current ~ Alternating current
~ Direct current and alternating current ] Ground connection
= A grounded terminal which, as far as
the operator is concerned, is
grounded via a grounding system.
@ Protective ground connection @ Equipotential connection
A terminal which must be connected A connection that has to be connected
to ground prior to establishing any to the plant grounding system: This
other connections. may be a potential equalization line
or a star grounding system depending
on national or company codes of
practice.

Endress+Hauser
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1.2.3  Symbols for certain types of information

Symbol | Meaning

Permitted
Procedures, processes or actions that are permitted.

Preferred
Procedures, processes or actions that are preferred.

Forbidden
Procedures, processes or actions that are forbidden.

Tip
Indicates additional information.

Reference to documentation

Reference to page

Reference to graphic

BB E @

B
w

Series of steps

Result of a step

Help in the event of a problem

)] B ¥

©

Visual inspection

[A
>

1.2.4  Symbols in graphics

Symbol Meaning
1,2,3,.. Item numbers
BB E. . Series of steps
AB,GC, ... Views

A-A, B-B, C-C, ... | Sections

= Flow direction

A0013441

A Hazardous area
Indicates a hazardous area.

A0011187

& Safe area (non-hazardous area)
Indicates a non-hazardous area.

A0011188

1.3 Terminology

To improve clarity, abbreviations or synonyms are used in these instructions for the
following terms:

= Endress+Hauser:
Term used in these instructions: "Manufacturer" or "Supplier"
= Memograph M RSG45:
Term used in these instructions: "Device" or "Measuring device"

1.4 Registered trademarks

HART®
Registered trademark of the HART FieldComm Group, Austin, USA

Endress+Hauser 7
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PROFIBUS®
Registered trademark of the PROFIBUS User Organization, Karlsruhe, Germany

PROFINET®
Registered trademark of the PROFIBUS & PROFINET International User Organization e.V.,
Karlsruhe, Germany

Modbus®
Registered trademark of SCHNEIDER AUTOMATION, INC.

EtherNet/IP™
Registered trademark of ODVA, INC.

Internet Explorer®, Excel™
Registered trademarks of the Microsoft Corporation

Mozilla Firefox®
Registered trademark of the Mozilla Foundation

Opera®
Registered trademark of Opera Software ASA.

Google Chrome™
Registered trademark of Google INC.

2 Basic safety instructions

Reliable and safe operation of the device is guaranteed only if the user reads these
Operating Instructions and complies with the safety instructions they contain.

ﬂ Requirements concerning operating staff to ensure compliance with FDA 21 CFR
Part 11:

In order to fully comply with the requirements of 21 CFR Part 11, the operators/users
must be properly trained.

2.1 Requirements concerning the staff

The personnel for installation, commissioning, diagnostics and maintenance must fulfill

the following requirements:

» Trained, qualified specialists: must have a relevant qualification for this specific
function and task

» Are authorized by the plant owner/operator

Are familiar with federal/national requlations

» Before beginning work, the specialist staff must have read and understood the
instructions in the Operating Instructions and supplementary documentation as well as
in the certificates (depending on the application)

» Following instructions and basic conditions

v

The operating personnel must fulfill the following requirements:

» Being instructed and authorized according to the requirements of the task by the
facility's owner-operator

» Following the instructions in these Operating Instructions

2.2 Designated use

This device is designed for the electronic capture, display, recording, analysis, remote
transmission and archiving of analog and digital input signals.

Endress+Hauser
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= The manufacturer accepts no liability for damages resulting from incorrect use or use
other than that designated. It is not permitted to convert or modify the device in any
way.

s The device is designed for installation in a panel and must only be operated in an
installed state.

2.3 Workplace safety

For work on and with the device:
» Wear the required personal protective equipment according to federal/national
regulations.

2.4 Operational safety

Risk of injury.
» Operate the device in proper technical condition and fail-safe condition only.
» The operator is responsible for interference-free operation of the device.

Conversions to the device

Unauthorized modifications to the device are not permitted and can lead to unforeseeable
dangers.
» If, despite this, modifications are required, consult with the manufacturer.

Repair

To ensure continued operational safety and reliability,

» Carry out repairs on the device only if they are expressly permitted.

» Observe federal/national requlations pertaining to repair of an electrical device.
» Use original spare parts and accessories from the manufacturer only.

Hazardous area

To eliminate a danger for persons or for the facility when the device is used in the

hazardous area (e.g. explosion protection, pressure vessel safety):

» Based on the nameplate, check whether the ordered device is permitted for the
intended use in the hazardous area.

» Observe the specifications in the separate supplementary documentation that is an
integral part of these Instructions.

2.5 Product safety

This measuring device is designed in accordance with good engineering practice to meet
state-of-the-art safety requirements, has been tested, and left the factory in a condition in
which it is safe to operate.

It meets general safety standards and legal requirements. It also complies with the EC
directives listed in the device-specific EC Declaration of Conformity. The manufacturer
confirms this by affixing the CE mark to the device.

2.6 Safety information for table version (option)

= The mains plug should only be inserted into a socket with a ground contact.

= The protective effect may not be suspended by an extension cable without a protective
ground.

= Relay outputs: U (max) = 30 Vi (AC)/60 V (DC).



Product description

Memograph M, RSG45

10

2.7 IT security

The manufacturer only provides a warranty if the device is installed and used as described
in the Operating Instructions. The device is equipped with security mechanisms to protect
it against any inadvertent changes to the device settings.

IT security measures in line with operators' security standards and designed to provide
additional protection for the device and device data transfer must be implemented by the
operators themselves.

3 Product description

3.1 Product design

This device is best suited for the electronic acquisition, display, recording, analysis, remote
transmission and archiving of analog and digital input signals.

The device is intended for installation in a panel or cabinet. There is also the option of
operating it in a table-mounted or field-mounted housing.

4 Incoming acceptance and product
identification

4.1 Incoming acceptance

On receipt of the goods, check the following points:

= [s the packaging or the content damaged?

= [s the delivery complete? Compare the scope of delivery against the information on your
order form.

4.2 Scope of delivery

The scope of delivery of the device comprises:

= Device (with terminals, as per order)

= 2 fastening clips

= Version with navigator and front interfaces: USB cable

= Sealing rubber towards control panel wall

» 'Industrial Grade" SD card, industry standard:
Version with navigator and front interfaces: card is located in the SD slot behind the flap
on the front of the housing (optional).
Version with stainless steel front and touchscreen: card is in the device and cannot be
replaced or retrofitted.

= "Field Data Manager (FDM)" analysis software on DVD (Essential, Demo or Professional
version, depending on order)

= 'FieldCare Device Setup / DeviceCare" configuration software on DVD

= Delivery note

= Multilanguage Brief Operating Instructions, hard copy

= Ex Safety Instructions, hard copy (optional)

Endress+Hauser
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4.3 Product identification

4.3.1 Nameplate

Compare the nameplate with the following diagram:

(Made in Germany, 2015 D-87484 Nesselwang )
1—Memograph M Endress+Hauser {Z1J
Ord.cd.: RSG45-XX/XXX Front: IP65 Rear: IP20 +——8
2 —+Ser. no.: XXXXXXXXXXX
Ext. ord. cd.: RSG45-XXXXXXXXX XXX 12ATEXxX xx X 9
3 ——1100-230 VAC (£10%) ~50/60 Hz 40 VA 112G Ex px IIC Gb
Ly ——1-10°C (14°F) < Ta < +50°C (122°F) 112D Ex pD IlIC Db
5 | FW: XX XX.XX Inst. per XA01362R/09/A3/xx.xx
i MAC: XX-XX-XX-XX-XX-XX
o [EtherNelt/IP
MAC 1: XX-XX-XX-XX-XX-XX
c € T “ TAG T-XXXXXXXXXXX % 10
7 | s C us TAG2-XXXXXXXXXXX

A0025806

1 Device nameplate (example)

Device designation, manufacturer details

Order code, serial number, extended order code

Power supply, mains frequency and maximum power consumption

Ambient temperature range

Firmware version; MAC address (Ethernet)

Fieldbus interface with MAC address (optional)

Device approvals

Degree of protection of the device

Approval in hazardous area (optional) with number of the relevant Ex documentation (XA...)
0 TAG name (optional); 2D-matrix code

4.4 Storage and transport

Compliance with the permitted environmental and storage conditions is mandatory. For
precise specifications, see the "Technical data" section of the Operating Instructions.

Please note the following:

= Pack the device so that is protected against impact for storage and transport. The
original packaging provides optimum protection.

= The permitted storage temperature is =20 to +60 °C (-4 to +140 °F).

5 Installation

5.1 Installation conditions

Overheating due to buildup of heat in the device
» To avoid heat buildup, always ensure that the device is sufficiently cooled.

The device is designed for use in a panel.

ﬂ The device must be installed in a pressurized enclosure system for operation in the
hazardous area. To ensure safe installation, it is essential to follow the installation
instructions for the cabinet and the installation instructions in the Ex-related Safety
Instructions (XA).

Endress+Hauser 11
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= Operating temperature range: -10 to +50 °C (14 to 122 °F)
= Climate class as per [EC 60654-1: Class B2
» Degree of protection: IP65, NEMA 4 at front / [P20 rear of housing

5.1.1 Installation dimensions

= [nstallation depth (excluding terminal cover): approx. 159 mm (6.26 in) for device incl.
terminals and fastening clips.

= Installation depth including terminal cover (option): approx.198 mm (7.8 in)

» Panel cutout: 138 to 139 mm (5.43 to 5.47 in) x 138 to 139 mm (5.43 to 5.47 in)

= Panel thickness: 2 to 40 mm (0.08 to 1.58 in)

= viewing angle range: 50° in all directions from the display central axis

= A minimum distance of 12 mm (0.47 in) between the devices must be observed if
aligning the devices vertically above one another or horizontally beside one another.

= The grid dimension of the panel cutouts for multiple devices must be at least
208 mm (8.19 in) horizontally and at least 162 mm (6.38 in) vertically (tolerance not
considered).

= Securing to DIN 43 834

5.2 Mounting the measuring device

ﬂ Mounting tool: For installation in the panel, all you need is a screwdriver.

Endress+Hauser
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1. From the rear of the device, push the sealing rubber (B) (supplied) as far as the front
frame of the device (A).

2. Slide the device (A) through the panel cutout from the front (C). To avoid the buildup
of heat, maintain a distance of >12 mm (>0.47 in) from walls and other devices.

3. Hold the device (A) level and hang the fastening clips (D) in the openings (1 x left, 1
x right).

4. Evenly tighten the screws on the fasting clips (D) using a screwdriver to guarantee a
secure seal to the control panel (torque 100 Ncm).

5.3 Post-installation check

= [s the sealing ring undamaged?

® Does the seal run all around the housing collar?

= Are the fastening clips tightened?

= [s the device fixed firmly in the center of the control panel cutout?

6 Electrical connection
6.1 Connection conditions
A WARNING

Danger! Electric voltage!

» The entire connection of the device must take place while the device is de-energized.

» The mixed connection of safety extra-low voltage and dangerous contact voltage to the
relay is not permitted.

» Apart from the relays and the supply voltage, only energy-limited circuits according to
[EC/EN 61010-1 may be connected.

Danger if protective ground is disconnected
» The ground connection must be made before all other connections.

NOTICE
Cable heat load
» Use suitable cables for temperatures of 5 °C (9 °F) above ambient temperature.

Incorrect supply voltage can damage the device or cause malfunctions
» Before commissioning the device, make sure that the supply voltage matches the
voltage specifications on the nameplate.

Check emergency shutdown for device
» Provide suitable switch or circuit breaker in building installation. This switch must be
provided close to the device (within easy reach) and marked as a circuit breaker.

Protect the device from overload
» Provide overload protection (nominal current = 10 A) for power cable.

Incorrect wiring may result in the device being destroyed
» Note terminal designation on the rear of the device.

Endress+Hauser
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Energy-rich transients in the case of long signal lines.
» Install suitable overvoltage protection (e.g. E+H HAW562) upstream.

ﬂ Special requirements according to FDA 21 CFR Part 11:

= The user must have the appropriate skills and qualifications to connect the device.
Connection errors can only be prevented in this way.

= The user is responsible for selecting the right input ranges and for connecting
suitable sensors.

= Users must ensure that the connected sensors cannot be tampered with by making
sure they are suitably mounted and wired.

= An optional terminal cover is available to prevent tampering at the device terminals
and terminal temperature measurement. It is the responsibility of the user to verify
that the device is correctly installed and sealed following validation.

= The user is responsible for compliance with the EMC limit values at the installation
location (see technical data).

6.2 Connection instructions

6.2.1  Cable specification

Cable specification, spring terminals

All connections on the rear of the device are designed as pluggable screw or spring
terminal blocks with reverse polarity protection. This makes the connection very quick and
easy. The spring terminals are unlocked with a slotted screwdriver (size 0).

Please note the following when connecting:

= Wire cross-section, auxiliary voltage output, digital I/0 and analog I/0: max. 1.5 mm?
(14 AWG) (spring terminals)

= Wire cross-section, mains: max. 2.5 mm? (13 AWG) (screw terminals)

= Wire cross-section, relays: max. 2.5 mm? (13 AWG) (spring terminals)

= Stripping length: 10 mm (0.39 in)

ﬂ No ferrules must be used when connecting flexible wires to spring terminals.

Shielding and grounding

Optimum electromagnetic compatibility (EMC) can only be guaranteed if the system
components and, in particular, the lines - both sensor lines and communication lines - are
shielded and the shield forms as complete a cover as possible. A shielded line must be used
for sensor lines that are longer than 30 m. A shield coverage of 90% is ideal. In addition,
make sure not to cross sensor lines and communication lines when routing them. Connect
the shield as often as possible to the reference ground to ensure optimum EMC protection
for the different communication protocols and the connected sensors.

To comply with requirements, three different types of shielding are possible:

= Shielding at both ends

= Shielding at one end on the supply side with capacitance termination at the device
= Shielding at one end on the supply side

Experience shows that the best results with regard to EMC are achieved in most cases in
installations with one-sided shielding on the supply side (without capacitance termination
at the device). Appropriate internal device wiring measures must be taken to allow
unrestricted operation when EMC interference is present. These measures have been
taken into account for this device. Operation in the event of disturbance variables as per
NAMUR NE21 is thus guaranteed.

Where applicable, national installation regulations and guidelines must be observed
during the installation! Where there are large differences in potential between the
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individual grounding points, only one point of the shielding is connected directly with the
reference ground.

ﬂ If the shielding of the cable is grounded at more than one point in systems without
potential matching, mains frequency equalizing currents can occur. These can damage
the signal cable or significantly impact signal transmission. In such cases the shielding
of the signal cable is to be grounded on one side only, i.e. it may not be connected to
the ground terminal of the housing. The shield that is not connected should be
insulated!

6.3 Connecting the measuring device

6.3.1 Terminals on back of device

@
+ LW
JZa
g 6
A8 A A]|
| | o o
< o O 0 5
4
3
2
1
0
Ethernet usB RS 232/ RS 485 Bus Interface

AD024605

®

4 Terminals on back of device

Slot 6: Power supply with relays

Slot 5: Multifunction card or HART® card (channels 17-20) or digital card
Slot 4: Multifunction card or HART® card (channels 13-16)

Slot 3: Multifunction card or HART® card (channels 9-12)

Slot 2: Multifunction card or HART® card (channels 5-8)

Slot 1: Multifunction card or HART® card (channels 1-4)

Slot 0: CPU card with interfaces

Q=N W uo

6.3.2  Electrical connection, terminal assignment

Circuit diagram

16 Endress+Hauser



Memograph M, RSG45 Electrical connection
- P ———— B il Bl
D 777777777 I J,l R Termination
RL | I T h 1 D = resistor
: | s ! ! Lo 7 (typical 120 Q) RS 485
fffffffff e~ - ———————— -
| l ' % RXD/TxD/(+)
| RxD/TxD(-)
| Further units
|
|
! 12-24 VDC Digital in (D)
>5mA 1gital In
| Analog =il g
! Power suppl v
| pply outputs (0) GNDx GNDx
| 100-230 VAC | 24 V AC/DC (Selectable in unit setup)
| (£10%) (-10%; +15%) 1 2 = x -
| 50/ 60 Hz 50/ 60 Hz Pulse + = 2 Dx1 Dx1
| L+ N- PEQ@ L ‘ ‘ ‘ ‘ G M) 12-24 VDC
} T 10Kk] I +
|
! Xﬂ Lo o2ave
I g
| g
|
|
|
| T
|
} 24V Out: max. 250 mA
|
|
; Slot 6: Power supply slot (standard)
! ARAA [FAAA [AAAR
! ettt f ettty ettt
| = 5
; FBEEEEEEEEEEE Slot 5: analog input / HART 17-20 or digital-1/0 (option)
RS 232 |
| Slot 4: analog input / HART 13-16 (option)
o] Bl
To modem: Cable with
6 \? Slot 3: analog input / HART 9-12 (option
9 pol. Sub-D socket @1 ° 39 9P (option)
0% b o Slot 2: analog input / HART 5-8 (option)
|
| Slot 1: analog input / HART 1-4 (option)
|
|
|
‘ L ]
Il
To PC: Cable with P 5 Slot 0: CPU (standard)
9 pol. Sub-D plug O (S5yae) @ | Etvemst
RxD-3  GND-5 —= 558‘9
D3 TR
|
- .
Analog inputs
x1 x2 x3 x4 x5 x6 x1 x2 x3 x4 x5 x6 x1 x2 x3 x4 x5 x6
Pt46, Pt50, Pt100,
) ) ) Pt500, Pt1000,
RTD Cu50, Cu53, Cul00
* 0..20 mA, 4..20 mA, 0...5 mA, +20 mA
I (Volt drop <1V, R, £50 Ohm)
x1 x2 x3 x4 x5 x6 -
a)>1V b) <1V
T T a)0..5V,1..5V,0..10V,+10V, +30 V
b) 0.1V, +150 mV, 1V
u
4
TC A,B,C,D,JKLN,TRS
x1 x2 x3 x4 x5 x6
24V ! |
{Re12K] - j‘o—“\i
I + I
Pulse/ LOW =0..7 mA
frequency vl vl HIGH = 13..20 mA
A0026669-EN
5 For connection examples of the HART® inputs (optional), see the Operating Instructions > B 23

Endress+Hauser
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Supply voltage (power unit, slot 6)

Power unit type Terminal
R
JZ2a 92
(1 4 4
‘ ‘L oo o
BEH| |55 5
A0019103
100-230 VAC L+ N- PE
Phase L Zero conductor N Ground
24V AC/DC L+ N- PE
Phase L or + Zero conductor N or - Ground

Relay (power unit, slot 6)

Type Terminal (max. 250V, 3 A)
sl Ldd Lhld Lardly
“hFrx BOBF ZEREEE
‘ ‘LDDD oooo [oooooao
HEB| [5538][5533]|555555
A0019103
Alarmrelay1 |R11 R12 R13
Changeover Normally Normally open
contact closed contact | contact (NO) %
(Ney Y
Relay 2 to 6 Rx1 Rx2
Switching contact | Normally open
contact (NO )

1) NC = normally closed (breaker)
2) NO = normally open (maker)

ﬂ The open or close function (= activation or deactivation of the relay coil) in a limit
event can be configured in the setup: "Setup -> Advanced setup -> Outputs -> Relay ->
Relay x". However, in the event of a power failure, the relay adopts its quiescent switch
state regardless of the setting programmed.

Digital inputs; auxiliary voltage output (power unit, slot 6)

Type Terminal

e @MY

22
[ I
E]E]N

Digital input | D11 to D61 GND1
1to6

o| R11
p| R12
p| R13

@i}
on
on

A0019103

Digital input 1 to 6 (+) | Ground (-) for digital
inputs 1 to 6

18 Endress+Hauser
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Type Terminal
R
JZo0 -9 ¢Q
X o o
‘ ‘LDDD
BEQ)| (555

A0019103

Auxiliary 24V Out - 24V Out +
voltage

output, not - Ground + 24V (£15%)
stabilized,

max. 250 mA

ﬂ If the auxiliary voltage is to be used for the digital inputs, the 24 V out - terminal of
the auxiliary voltage output must be connected with the GND1 terminal.

Analog inputs (slot 1-5)

The first digit (x) of the two-digit terminal number corresponds to the associated channel:

Type

Terminal

Lo
EE%%
O

50000

x6|0

A0019303

x1 X2

x3

x4

x5 X6

Current/pulse/frequency
input b

Voltage > 1V

Voltage < 1V

(+)

Resistance thermometer
RTD (2-wire)

Resistance thermometer
RTD (3-wire)

b (sense)

Resistance thermometer
RTD (4-wire)

a (sense)

b (sense)

Thermocouples TC

(+)

()

1)

If a universal input is used as a frequency or pulse input, a series resistor must be used in series connection
with the voltage source. Example: 1.2 kQ series resistor at 24 V
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HART® inputs (slot 1-5)

The first digit (x) of the two-digit terminal number corresponds to the associated channel:

Type Terminal
9 | |
S ====== 1 _ 2500 100 |
9000000 ' T j
— N M N O NN I N O
I MoK M X X X
A0024862
x1 X2 x3 x4 x5 X6
HART® (4 to 20 mA) SHD H 1 H 2 Reom I+ I-

= A 250 Q communication resistor (load) is installed on the device side between
terminals x4 and x5.

= A 10 Q resistor (shunt) is installed on the device side at the current input between
terminals x5 and x6.

= Terminals x2 and x3 (H_1 and H_2) are jumpered internally.

» The internal HART® modem is located between terminals x2/x3 and x6.

Relay extension (digital card, slot 5)

Type Terminal (max. 250V, 3 A)
AAAA[AAAAI[EAAA]
_l_ﬂﬂl_ﬂﬂl_ﬂﬂl_ﬂ Il | ) | o o | L[]
000
ERER BEREZ 72
A0024736
Relay 7, 8 RA RB RC RD
Relay 9, 10 RE RF RG RH
Relay 11, 12 RI RJ RK RL
Switching contact | Normally open Switching contact | Normally open contact
contact (V) R
1) NO)
2) NO)

The open or close function (= activation or deactivation of the relay coil) in a limit

event can be configured in the setup: "Setup -> Advanced setup -> Outputs -> Relay ->
Relay x". However, in the event of a power failure, the relay adopts its quiescent switch
state regardless of the setting programmed.

Analog outputs (digital card, slot 5)

Type

Terminal

ARAARAIAAEA A

06006600

émUD ww O T
X x o X o o o«

A0024736

Analog
output 1-2

015 016 025

026

Analog output 1 (+) | Ground, analog output

1()

Analog output 2 (+)

Ground, analog output
2(-)

20
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Extension of digital inputs (digital card, slot 5)

Type Terminal

AAAA |

AR |

5 s

L5 o o |

QOOOOOQO]]

émUD ww O T

X x o X @ o o

A0024736

Digital input 7 to | D71 to DE1 GND2

GND2

14
Digital input 7 to 14 (+)

to 14

Ground (-) for digital inputs 7

Ground (-) for digital inputs 7
to 14

If the auxiliary voltage is to be used for the digital inputs, the 24 V out - terminal of
the auxiliary voltage output (power unit, slot 6) must be connected with the GND2

terminal.

6.3.3  Connection example: Auxiliary voltage output as transmitter

power supply for 2-wire sensors

* ||

CA| 3

24V Out: max. 250 mA

2
28

A0024729

6 Connecting the auxiliary voltage output when using as a transmitter power supply for 2-wire sensors in

the current measuring range

1  Sensor 1 (e.qg. Cerabar from Endress+Hauser)

2 Sensor 2
3 External indicator (optional) (e.g. RIA16 from Endress+Hauser)
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6.3.4  Connection example: Auxiliary voltage output as transmitter
power supply for 4-wire sensors

-

+
1 a=
24V Out: max. 250 mA

GND1
+

8

28

A0024730

7 Connecting the auxiliary voltage output when using as a transmitter power supply for 4-wire sensors in
the current measuring range

1 Sensor 1 (e.g. temperature switch TTR31 from Endress+Hauser)

2 Sensor2
3 External indicator (optional) (e.g. RIA16 from Endress+Hauser)
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6.3.5 Connection example: HART® input in a point-to-point

connection

Chx

A0024864

Connection example: HART® inputs in a point-to-point connection

Active 4-wire sensor (slave)

Power supply for 4-wire sensor

Power supply (electricity source) for actuator
Actuator (e.g. adjuster or valve)

Passive 2-wire sensor (slave)

Power supply (voltage source) for sensor

The internal auxiliary voltage (24 V OUT) can also be used as the transmitter power
supply.

6.3.6  Connection example: HART® input in a Multidrop connection

Information on HART® Multidrop topology:

= The analog signal is not available for the process variable. Only the digital signal is
used.

= Multidrop topology is not recommended for time-critical applications due to the
slower update rate.

= The device supports a maximum of 5 sensors per current loop. The address should
be in the 1 to 15 range (compatibility with HART®5).

®9

1
2
3

A0024860

Connection example: HART® input in a Multidrop connection

Sensor (slave 1)
Sensor (slave 2)
Sensor (slave 3-5)

The internal auxiliary voltage (24 V OUT) can also be used as the transmitter power
supply.
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6.3.7

RS232/RS485 interface (CPU card, rear of device, slot 0)

ﬂ Use shielded signal lines for serial interfaces!

A combined RS232/RS485 connection is available on a shielded SUB D9 socket at the rear
of the device. This can be used for data transfer and to connect a modem. For
communication via modem, we recommend an industrial modem with a watchdog

function.

To PC: Cable with
9 pol. Sub-D plug

RxD -3 GND - 5

TxD - 2

oo

| 8 |
Cable
D R 9 DRF resistance
i 3 . H
i | T reavmo +)
L——— RxD/TxD(-)
Further units
RS 232
,—ﬂ‘ 819
To modem: Cable with 6, 9
9 pol. Sub-D socket @ o ’ @
T 5 =)
23 b B9

: i <
e
: =)

23 5‘8‘9

A0024732-EN

Type Pin of the SUB-D9 socket
1|2 3 5 678 9
RS232 TxD (data RxD (data GND
assignment output) input)
RS485 GND RxD/TxD - RxD/TxD +
assignment
Unoccupied connections should be left empty.
Maximum cable length:
RS232:2 m (6.6 ft)
RS485: 1000 m (3280 ft)
ﬂ Only one interface can be used at any one time (RS232 or RS485).
Endress+Hauser
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Option: Modbus RTU master

As a Modbus master, the device can interrogate other Modbus slaves via RS485. The
Modbus RTU master can be operated in parallel with the Profibus DP slave, EtherNet/IP
adapter, PROFINET I/0 device or Modbus TCP slave.

Up to 40 analog inputs can be transmitted via Modbus and stored in the device.

Option: Modbus RTU slave
The device can be interrogated as a Modbus slave by another Modbus master via RS485.

Up to 40 analog inputs and 20 (14 real + 6 virtual) digital inputs can be transmitted via
Modbus and stored in the device.

ﬂ A Modbus RTU master and RTU slave cannot be operated in parallel.

Remote interrogation with analog or GSM/GPRS wireless modem:

Analog modem:

An analog modem for industrial use (e.g. Devolo or WESTERMO), which is connected to
the RS232 interface with a special modem cable (see Accessories ), is

recommended.> 79

GSM/GPRS wireless modem:

A GSM/GPRS wireless modem (e.g. Cinterion, INSYS or WESTERMO, incl. antenna and
power unit) for industrial use, which is connected to the RS232 interface with a special
modem cable (see Accessories), is recommended. - 79

Important: the wireless modem needs a SIM card and data transfer subscription. In
addition, it must be possible to deactivate the PIN prompt.

6.3.8  Ethernet connection (CPU card, rear of device, slot 0)

The Ethernet interface can be used to integrate the device via a hub or switch into a PC
network (TCP/ IP Ethernet). A standard patch cable (e.g. CAT5E) can be used for the
connection. Using DHCP, the device can be fully integrated into an existing network
without the need for additional configuration. The device can be accessed from every PC in
the network.

= Standard: 10/100 Base T/TX (IEEE 802.3)
= Socket: RJ-45

= Max. cable length: 100 m

= Galvanic isolation; testing voltage: 500 V

The following functions are implemented:

= Data communication with PC software (analysis software, configuration software, OPC
server)

= Web server

Meaning of the LEDs

Beneath the Ethernet connection (see rear of device) there are two light emitting diodes

which indicate the status of the Ethernet interface.

= Yellow LED: link signal; is lit when the device is connected to a network. If this LED is not
illuminated then communication is impossible.

= Green LED: Tx/Rx; flashes irreqularly if the device is transmitting or receiving data.

Requirements with regard to a network printer

The printer must support PCL5c (or higher). Laser jet and ink jet printers are supported.
The printouts are always color printouts (if supported by the printer). The printout has
different shades of gray if you use a black/white printer.
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Reference list: HP Color LaserJet CP1515n, HP Color Laser]et Pro CP1525n, Kyocera FS-
C5015N.

ﬂ GDI printers are not supported!

Option: Ethernet Modbus TCP master

As a Modbus master, the device can interrogate other Modbus slaves via Ethernet. The
Modbus TCP master can be operated in parallel with the Profibus DP slave, Modbus RTU,
Modbus TCP slave, EtherNet/IP adapter or PROFINET I/0 device.

Up to 40 analog inputs can be transmitted via Modbus and stored in the device.

Option: Ethernet Modbus TCP slave

The Modbus TCP interface is used to connect to higher-ranking SCADA systems (Modbus
master) to transmit all measured values and process values.

Up to 40 analog inputs and 20 (14 real + 6 virtual) digital inputs can be transmitted via
Modbus and stored in the device.

6.3.9  Option: Anybus® interface (CPU card, rear of device, slot 0)

PROFIBUS-DP slave:

The device can be integrated into a fieldbus system as per the PROFIBUS-DP standard by
means of the PROFIBUS-DP interface. Up to 40 analog inputs and 20 (14 real + 6 virtual)
digital inputs can be transmitted via PROFIBUS-DP and stored in the device. For
bidirectional communication in cyclic data transfer. Connection via Sub-D socket.

Baud rate: maximum 12 Mbit/s.

EtherNet/IP adapter (slave):

Up to 40 analog inputs and 20 (14 real + 6 virtual) digital inputs can be transmitted via
EtherNet/IP and stored in the device. The built-in module corresponds to I/0 server
category (Level 2). It has an integrated 2-port switch, thereby supporting EtherNet/IP
communication with line or ring topology. Connection via 2 RJ45 standard sockets.

PROFINET 170 device:

Up to 40 analog inputs and 20 (14 real + 6 virtual) digital inputs can be transmitted via
PROFINET IO and stored in the device. The 2-port module for Profinet 10 meets
compliance class B. The integrated switch enables communication in line or ring topologies
without an additional external switch. Connection via 2 RJ45 standard sockets.

6.3.10 USB connection, type A (host) (CPU card, rear of device, slot 0)

Two USB 2.0 ports are available on shielded USB A sockets at the rear of the device. A USB
stick as a memory medium, for example, can be connected to these ports. An external
keyboard/mouse for device operation, a USB hub, a barcode reader or a printer (PCL5c or
higher) may also be connected.
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6.3.11 Connections on front of device (only for version with navigator

and front interfaces)
5
: Oy
e
4 3 2

A0024737

0  Version with navigator and front interfaces with open flap

Slot for SD card

USB B socket "Function"e.g. to connect to PC or laptop

USB A socket "Host" e.g. for USB memory stick, external keyboard/mouse, USB hub, barcode reader or printer
LED at SD slot. Yellow LED lit or flashing when the device writes to the SD card or reads it

1

1 Navigator
2

3

4

5

USB connection type A (host)

A USB 2.0 port is available on a shielded USB A socket at the front of the device. A USB
stick as a memory medium, for example, can be connected to this port. An external
keyboard/mouse for device operation, a USB hub, a barcode reader or a printer (PCL5c or
higher) may also be connected.

USB connection type B (function)

A USB 2.0 port is available on a shielded USB B socket at the front of the device. This can
be used to connect the device for communication with a laptop, for example.

ﬂ USB-2.0 is compatible with USB-1.1 or USB-3.0, i.e. communication is possible.

Requirements with regard to the SD card
Industrial grade SD-HC cards with max. 32 GB are supported.

ﬂ Use only the industrial-grade SD cards described in the "Accessories" section of the
Operating Instructions. These have been tested by the manufacturer and guaranteed
to function faultlessly in the device. > B 79

ﬂ The SD card must be formatted to FAT or FAT32. NTFS format is not readable.

6.3.12 General information on USB devices

The USB devices are detected by the "plug-and-play" function. If several devices of the same
type are connected, only the USB device that was connected first is available. Settings for
the USB devices are made in the setup. A maximum of 8 external USB devices (incl. USB
hub) can be connected if they do not exceed the maximum load of 500 mA. If overloaded,
the corresponding USB devices are automatically disabled. An active USB hub can be used
for higher power ratings.
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Requirements with regard to the USB stick

There is no guarantee that all manufacturers' USB sticks will function faultlessly. That is
why an industrial grade SD card is recommended to ensure the reliable recording of data.
> B879

The USB stick must be formatted to FAT or FAT32. NTFS format is not readable. The
system supports only USB sticks with max. 32 GB.

The USB stick must not be connected to the device via a USB hub. Interference from
other USB devices may result in data loss.

Requirements with regard to an external USB keyboard

The system only supports keyboards which can be addressed using generic drivers (HID
keyboard - Human Interface Device). Special keys are not supported (e.g. Windows keys).
Users can only enter characters that are available in the entry character set of the device.
All unsupported characters are rejected. It is not possible to connect a wireless keyboard.
The following keyboard layouts are supported: DE, CH, FR, USA, USA International, UK, IT.
See setting under "Setup -> Advanced setup -> System -> Keyboard layout".

Requirements with regard to an external USB barcode reader

The connected barcode reader has to act like a HID keyboard (human interface device)
(universal keyboard driver). The barcode reader must complete every barcode with a
carriage return (OxOD) + line feed (0x0A).

Checking the barcode reader at a PC

Before connecting the barcode reader to the device, it should be checked at a Windows®
PC.

1. Connect the barcode reader to the PC and wait until Microsoft Windows® recognizes
the device as a HID keyboard and installs it (check with the Windows Device
Manager).

2. Configure the barcode reader as specified in the Operating Instructions of the barcode
reader.

Start the Notepad (editor).
4. Using the barcode reader, read in a barcode (as it is used later) and check it.

Do not connect the barcode reader to the device until the barcode reader has been
correctly configured and tested on the PC.

6. Select the character set at the device under "Setup -> Advanced setup -> System ->
Barcode reader -> Character set". The following character sets are supported: DE, CH,
FR, USA, USA International, UK, IT. Note: This setting has to be identical to the
configuration of the barcode reader! The system only reads characters that are
available in the entry character set of the device. All other characters are rejected.

7. The barcode reader should also be tested at the device via "Main menu -> Diagnostics
-> Simulation -> Test barcode reader".
If problems arise, please contact the manufacturer of the barcode reader.

Reference list: Datalogic Gryphon D230, Metrologic MS5100 Eclipse Series, Symbol
LS2208, Datalogic Quickscan 1, Godex GS220, Honeywell Voyager 9590.

Requirements with regard to an external USB printer

The printer must support PCL5c (or higher). Laser jet and ink jet printers are supported.
The printouts are always color printouts (if supported by the printer). The printout has
different shades of gray if you use a black/white printer.
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Reference list: HP Color LaserJet CP1515n, HP Color Laser]et Pro CP1525n, Kyocera FS-
C5015N.

ﬂ GDI printers are not supported!

6.4 Post-connection check

Device condition and specifications Notes

Are cables or the device damaged? Visual inspection

Electrical connection Notes

Does the supply voltage match the specifications on the nameplate? -

Are all terminals firmly engaged in their correct slot? -

Are the mounted cables strain-relieved? -

Are the power supply and signal cables correctly connected? See connection diagram and
rear of device.
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7

7.1

The device can be operated directly onsite with the Navigator and USB keyboard/mouse or

Operation options

Overview of operation options

via interfaces (serial, USB, Ethernet) and operating tools (Web server, FieldCare/
DeviceCare configuration software).

7.2

7.2.1

Structure and function of the operating menu

Operating menu for operators and maintenance personnel

Maintenance

[ [Operation |—»{ Change group |

| Lock operation | | Signal analysis ﬂ'l
<] -
5 Login || Search in trace [ Printout ﬂ'l
=t
O

SD card/USB stick | Change display mode ﬂ] Adjust brightness
Histogé [l Store text Limits

Setup |—>| Change date/time |

| Advanced setup |—>| System |—> Date/time setup

Security

External memory
Messages

Screen saver
Barcode reader

Device options,...

L

Universal inputs
Digital inputs
Output I—} Universal output 1-2
Relay 1-12 |
Ethernet ]
HART |
Serial interface |
Modbus |
Profibus,... |
Application |—> Maths
Signal analysis |
Diagnostics —>| Diagnostics list [l
[Limits ]
Event logbook |
Signal groups |
Device information |
E-mail |
Measured values |
[Printer ]
Outputs |
Softkeys |
Simulation
—— | Texts.. ]
)

A0024770-EN
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7.2.2  Operating menu for experts

Expert

Expert |—>| Enter Access code |

System |—> (see before)

TTr— TR
T TE— T T
[Commion | [ )
T PR

Diagnostics |—>| Diagnosis list [l

A0019596-EN

7.2.3 Submenus and users

Certain parts of the menu are assigned to certain user roles. Each user role corresponds to
typical tasks within the lifecycle of the device.

User role

Typical tasks

Menu Content/meaning

Operator

Tasks during operation:
= Configuration of the display.
® Reading measured values.

"Operation” Contains all the parameters that are required in
ongoing operation: configuration of the measured value
display (displayed values, display format, etc.).

Maintenance

Commissioning:

= Configuration of the measurement.

s Configuration of data processing.

"Setup" Contains all parameters for commissioning:
= Change date/time
s "Advanced setup" submenu

Contains additional submenus and parameters:

- System: Basic settings required for operating the
device.

- Inputs: Settings for analog and digital inputs.

— Outputs: Setup required only if outputs (e.g.
relays) are to be used.

- Communication: Setup required if you are using
the USB, RS232, RS485 or Ethernet interface or
the HART® inputs of the unit (PC operation, serial
data read-out, modem operation, etc).

- Application: Define different application-specific
settings (e.g. group settings, limit values, etc.).

Once values have been set for these parameters, the
measurement should generally be completely
configured.

Endress+Hauser
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User role

Typical tasks

Menu

Content/meaning

Fault elimination:

= Diagnosing and eliminating process errors.

= Interpretation of device error messages and
correcting associated errors.

'‘Diagnostics"

Contains all parameters for detecting and analyzing

errors:

= Diagnosis list
All diagnosis messages are listed in chronological
order.

= Event logbook
Events such as limit value violations and power
failures are listed in chronological order.

= Device information
Displays important device information (e.g. serial
number, firmware version, device options for
hardware and software, memory information, etc.).

= Measured values
Display of current measured values of device.

= Outputs
Displays the current status of the outputs e.g. switch
status of relay outputs.

= Simulation
Various functions/signals can be simulated for test
purposes here.
Note: In Simulation mode, normal recording of the
measured values is interrupted and the intervention
is logged in the event log.

= HART®
Displays the exact device information of a selected
HART® device and the HART® communication signal
quality.

= Initialize modem
Initializes the modem connected to the serial
interface (for automatic call answering).

Expert

Tasks that require detailed knowledge of the

function of the device:

s Commissioning measurements under difficult
conditions.

s QOptimal adaptation of the measurement to
difficult conditions.

= Detailed configuration of the communication
interface.

s Error diagnostics in difficult cases.

‘Expert"

Contains all parameters of the device (including those
that are already in one of the other menus). The expert
menu is protected by a code. Factory setting: 0000. This
menu is structured according to the function blocks of
the device:
= "System" submenu
Contains all higher-order device parameters that do
not concern the measurement or measured value
communication.
= "[nputs" submenu
Contains all parameters for configuring the analog
and digital inputs.
= "Qutput" submenu
Contains all parameters for configuring the outputs
(e.g. relays).
= "Communication" submenu
Contains all parameters for configuring the
communication interfaces.
= "Application" submenu
Contains all parameters for configuring application-
specific settings (e.g. group settings, limit values
etc.).
= "Diagnostics" submenu
Contains all parameters needed to detect and
analyze operational errors.
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7.3 Measured value display and operating elements
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11  Device front (left: version with navigator and front interfaces; right: version with stainless steel front and
touchscreen)

Item Operating function (display mode = display of measured values)

No. (Setup mode = operating in the Setup menu)

a Slot for SD card

b USB B socket "Function" e.g. to connect to PC or laptop

c USB A socket "Host" e.g. for USB memory stick, external keyboard, barcode reader or printer

d LED at SD slot. Yellow LED lit or flashing when the device writes to the SD card or reads it.
Do not remove the SD card if the LED is lit or flashing! Risk of data loss!

1 "Navigator": jog/shuttle dial for operating with additional press/hold function.
In display mode: turn the dial to switch between the various signal groups. Press the dial to display the
main menu.

In setup mode or in a selection menu: turn the dial anticlockwise to move the bar or the cursor
upwards or counterclockwise, changes the parameter. Turning clockwise moves the bar or cursor
down or clockwise, changes parameter. Press = select highlighted function, start parameter change
(ENTER key).

2 Functions of LED indicators (according to NAMUR NE44:)

= Green LED (top) lit: power supply OK

= Red LED (bottom) flashing: maintenance required, caused by external factor (e.g. cable open circuit
etc.), or a message/notification requiring acknowledgment is pending, calibration is running.

3 Variable "soft keys", keys 1 to 4 (from left to right)
4 Function indicator of the "soft keys"
5 In display mode: current group name, type of analysis;

In setup mode: name of the current operating item (dialog title)

6 In display mode: displays current date/time
In setup mode: --

7 In display mode: user ID (if function is active)
In setup mode: --
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Item
No.

Operating function (display mode = display of measured values)
(Setup mode = operating in the Setup menu)

In display mode: alternating display indicating the percentage space on the SD card or USB stick that
has already been used.

Status symbols are also displayed in alternation with the memory information (e.g. simulation mode,
data storage active, operation locked, batch active)

In setup mode: the current "direct access" operating code is displayed

In display mode: window for measured value display (e.g. curve display).
Display of current measured values and the status in the event of an error/alarm condition. In the case
of counters, the type of counter is displayed as a symbol.

@ If a measuring point has limit value status, the corresponding channel identifier is highlighted
in red (quick detection of limit value violations). During a limit value violation and device
operation, the acquisition of measured values continues uninterrupted.

In setup mode: display of operating menu

10

In display mode: alternating status display (e.g. set zoom range) of the analog or digital inputs in the
appropriate color of the channel.
In setup mode: different information is displayed here depending on the display type.

7.4

Display representation of symbols used in operation

Item Function Description
No.
9 Symbols for counters:
21,22,23,%4 Intermediate analysis 1 to 4 / external analysis 1 to 4
>D Daily analysis
>W Weekly analysis
~M Monthly analysis
>Y Annual analysis
> Totalizer
9 Channel-related symbols:
b 4 Violation of lower limit value
ry Violation of upper limit value or limit value on counter
3 Violation of upper and lower limit values at the same time
S "Out of specification"
e.g. input signal too high/low
F Error message "Failure detected"
An operating error has occurred. The measured value is no longer valid (e.g.
a channel not displayed in the current group is defective).
M "Maintenance required"
Maintenance is required. The measured value is still valid.
----- Error, measured value not displayed.
Possible causes: Sensor / input error, line break, invalid value, input signal
too high/low
8 Symbol for status signals:

a "Device locked"
Setup is locked via a control input. Disable setup lock via a control input.

S "Out of specification"
The device is being operated outside its technical specifications (e.g. during
startup or cleaning).

C "Function check"
The device is in Service mode.
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Item
No.

Function

Description

"Maintenance required"
Maintenance is required. The measured value is still valid.

Error message "Failure detected"
An operating error has occurred. The measured value is no longer valid (e.g.
a channel not displayed in the current group is defective).

"External communication"
The device is communicating externally (e.g. via Modbus).

"Simulation"

Simulation is active.

"Historical data"

Historical data are currently shown on screen.

7.4.1

Symbols in operating menus

Symbol for setup

Symbol for diagnostics

Symbol for expert setup

Symbol for user administration according to "FDA 21 CFR Part 11"

X koSl

7.4.2

Back

Use the "Back’ function, which can be found at the bottom of each menu/submenu, to move up
a level in the menu structure.

E] To quit the menu immediately, press and hold "Back" (>3 sec.) in the Navigator. The

Symbols in the event logbook

devices switches to display mode.

Setup changes

Power on

Clolw

Power off

Limit value on

Limit value off

Digital on (on/off message)

Digital off (on/off message)

Service

User administration

Hlk| <o~ 0K

Texts saved / comments added

=}
-

Acknowledging message

*

Back

-

7.5

Continue searching

Entering text and numbers (virtual keyboard)

A virtual keyboard is available for entering text and numbers. This is opened automatically
if needed. Here, turn and press the navigator, or use the touchscreen or mouse, to select
the appropriate character.

The following characters are available for entering free text:
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< Jump one position to the left.
If this symbol is selected, the cursor jumps one position to the left.

> Jump one position to the right.
If this symbol is selected, the cursor jumps one position to the right.

€©x Delete backwards.
If this symbol is selected, the character to the left of the cursor position is deleted.

X Delete forwards.
If this symbol is selected, the character to the right of the cursor position is deleted.

c Delete all.
if this symbol is selected, the entire entry is deleted.

x Reject entry.
If this symbol is selected, the entry is rejected and you quit editing mode. The previously set text
remains.

W Accept entry.

If this symbol is selected, the entry is applied at the position specified by the user, and you quit
editing mode.

7.6 Channel color assignment

Channel color assignment is performed in the main menu under "Setup -> Advanced
setup -> Application -> Signal groups -> Group x". 8 predefined colors are available per
group and can be assigned to the desired channels.

7.7 Access to the operating menu via the local display

Using the "Navigator" (jog/shuttle dial with additional press function), the soft keys or the
touchscreen (option), all settings can be made directly onsite at the device.

7.8 Device access via operating tools

7.8.1  Field Data Manager (FDM) analysis software (SQL database
support)

The PC analysis software offers external, centralized data management with visualization
for recorded data. The analysis software enables the complete archiving of all measuring
point data e.g. measured values, diagnostic events and protocols. The analysis software
stores data in an SQL database. The database can be operated locally or in a network
(client / server). Access is via RS232/RS485, USB or Ethernet interface (network).

Function scope:

= Export of saved data (measured values, analyses, event log)

= Visualization and processing of saved data (measured values, analyses, event log)
= Safe archiving of exported data in a SQL database

The following versions of the software are available:
= Essential version (free, with limited functionalities)
= Professional version (see accessories > 79)

= Demo version (time-limited Professional version)

ﬂ An "Essential" version of the analysis software is supplied with the device.

For details, see the Operating Instructions on the analysis software DVD provided.
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7.8.2 Web server

A web server is integrated into the device. This makes the current measured values of the
device available in real time. Access is via an Ethernet interface from a PC in the network
via the standard browser. The installation of additional software is not required.

The Web server offers the following range of functions:

= Display of current and historical data and measured value curves via a standard Web
browser > B 51

s FEasy configuration without additional installed software > & 40

= Remote access to device and diagnostic information

7.8.3  OPC server (optional)

The OPC server makes it possible to access data on the device. These data are made
available to OPC clients in real time. The OPC server meets the requirements of the OPC
specifications regarding the supply of data to an OPC client. Access is via RS232/RS485,
USB or Ethernet interface (network). Communication takes place using automatic device
detection; the operator does not need to make any additional settings. The OPC server
enables the flexible and powerful exchange of data and is easy and convenient to use.

The following momentary values can be provided:
= Analog channels

= Digital channels

s Mathematics

= Totalizer

For details, see Operating Instructions BAOO223R/09/xx

7.8.4  FieldCare/DeviceCare configuration software (included in the
delivery)

Function scope

The configuration software is an FDT/DTM-based system asset management tool. It can
configure all smart field devices in a system and helps you manage them. By using the
status information, it is also a simple but effective way of checking their status and
condition. Access is via USB or Ethernet interface (network).

Typical functions:

= Device configuration

= Loading and saving device data (upload/download)
= Documentation of the measuring point

For details, see the Operating Instructions on the configuration software DVD
provided

Overview of device description files (DTM)

Information and files are available free of charge at:

ﬂ See online at: www.de.endress.com/fieldcare
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8 System integration

8.1 Integrating the measuring device in the system

8.1.1 General notes

The device has (optional) fieldbus interfaces for exporting process values. Measured values
and statuses can also be transmitted to the device via fieldbus. Note: Counters cannot be
transferred.

Alarms or errors in the context of data transmission are displayed depending on the bus
system (e.g. status byte).

The process values are transferred in the same devices that are used for display at the
device.

ﬂ Information on compliance with FDA 21 CFR Part 11 requirements when using
fieldbus systems:

If no measured values are received by fieldbus, the device activates a floating
switching contact (e.g. relay) after a configurable timeout period. The evaluation of
the switching contact is the responsibility of the user.

8.1.2 Ethernet

Setup > Advanced setup > Communication - Ethernet

The IP address can be entered manually (fixed IP address) or assigned automatically using
DHCP.

The port for data communication is preset to 8000. The port can be changed in the Expert
- Communication > Ethernet menu.

The following functions are implemented:

= Data communication with PC software (analysis software, configuration software, OPC
server)

= Web server

The following connections are possible at the same time:

= 1x Port 8000 (configuration software, OPC server or analysis software)
= 1x Port 8002 (OPC server only)

= 1x Port 5094 (HART® IP)

= 4x Modbus slave TCP

= 5x Web server

ﬂ Ports can be changed!

As soon as the maximum number of connections has been reached, new connection
attempts are blocked until an existing connection has been terminated.

8.1.3 Modbus RTU/TCP slave

The device can be connected to a Modbus system via RS485 or Ethernet interface. The
general settings for the Ethernet connection are made in the Setup - Advanced setup ->
Communication - Ethernet menu. Configuration for Modbus communication is done in
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the Setup - Advanced setup - Communication > Modbus slave menu. Up to 12 analog
inputs and 6 digital inputs can be transmitted via Modbus and stored in the device.

Menu position RTU (RS485) Ethernet

Device address: 1to 247 IP address manual or automatic
Baud rate: 9600/19200/38400/57600/115200 -

Parity: Even/Odd/None -

Stop bits: 1/2 -

Port: - 502

Transfer of values
The actual Modbus TCP protocol is located between layer 5 to 6 in the ISO/OSI model.

To transfer a value, 3 registers of 2 bytes each (2-byte status + 4-byte float) or 5 registers
of 2 bytes each (2-byte status + 8-byte double) are used.

More detailed information about Modbus is provided in the supplementary
documentation.

9 Commissioning

9.1 Function check

Make sure that all post-connection checks have been carried out before putting your device
into operation:

= 'Post-installation check" checklist .- 14

= 'Post-connection check' checklist .- B 29

9.2 Switching on the measuring device

Once the operating voltage is applied, the display lights up and the device is ready for
operation.

If you are commissioning the device for the first time, program the setup as described in
the following sections of the Operating Instructions.

If you are commissioning a device that is already configured or preset, the device starts
measuring immediately as defined in the settings. The values of the channels currently
activated are shown on the display.

ﬂ Remove the protective film from the display as this would otherwise affect the
readability of the display.

9.3 Setting the operating language
Factory setting: English or ordered local language.
Version with stainless steel front and touchscreen, or when operating with the
external USB mouse:
Calling the main menu, configuring the operating language:
1. Press or click the "Menu" soft key at the bottom edge of the screen

2. The main menu appears on the display with the "Sprache/Language" option
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3. To change the default language setting: press or click 'Sprache/Language" and select
the desired language from the drop-down menu

4. Use "Back' or "ESC" to quit the main menu

The operating language has been changed.

Version with navigator and front interfaces:
Calling the main menu, configuring the operating language:
1. Pressthe navigator
2. The main menu appears on the display with the "Sprache/Language" option

3. Change the default language setting: press the navigator, turn it to select the
preferred language and press the navigator again to accept the setting

4. Use"Back'or "ESC" to quit the main menu
The operating language has been changed.
Use the » "Back' function, which can be found at the bottom of each menu/submenu,
to move up a level in the menu structure.

To quit the menu immediately and return to the measured value display, press and
hold "Back" (>3 sec.). The changes made are accepted and saved.

9.4 Configuring the measuring device (Setup menu)

Access to the setup is enabled when the device leaves the factory and can be locked in
various ways e.g. by entering a 4-digit access code or by user administration.

When locked, basic settings can be checked but not changed. You can also use a PC to
commission or configure your device.

Device configuration options:

= Setup directly at the device

= Setup via SD card or USB stick by transferring the parameters stored on it

= Setup via Web server using Ethernet

= Setup via FieldCare/DeviceCare configuration software using USB interface or Ethernet

ﬂ Information on configuration using FieldCare/DeviceCare configuration software
= Offline configuration: Most of the parameters are available (depending on the
device configuration).
= Online configuration: Only parameters marked "Online configuration" are available.
> B 109

9.4.1  Step-by-step: to the first measured value

Procedure and necessary settings:
1. Check the date/time in the main menu under "Setup" and set it if necessary

2. Make settings for the interfaces and communication in the main menu under "Setup
-> Advanced setup -> Communication"

3. Create universal or digital inputs in the main menu under "Setup -> Advanced setup
-> Inputs -> Universal inputs/Digital inputs": Add input: select "Universal input
x" or "Digital input x" with which the input signal should be detected. Then select the
newly created input and configure it

4. Activate relays or analog outputs (optional) in the main menu under "Setup ->
Advanced setup -> Outputs"

5. Assign activated inputs to a group in the main menu under "Setup -> Advanced
setup -> Application -> Signal groups -> Group x"

6. Use 'Back' or "ESC' to quit the main menu. The changes made are accepted and saved
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The device is in the measured value display mode and displays the measured values.

9.4.2  Step-by-step: set or delete the limit values

Procedure for setting limit values:

1. Open the limit values in the main menu under "Setup -> Advanced setup ->
Application -> Limits"

2. Add a limit value: select "Yes"
3. Select and configure "Limit value x"
4. Use "Back' or "ESC" to quit the main menu. The changes made are accepted and saved

The device is in the measured value display mode and displays the measured values.

Procedure for deleting limit values:

1. Open the limit values in the main menu under "Setup -> Advanced setup ->
Application -> Limits"

2. Delete a limit value: select "Yes"
3. Select the limit value to be deleted from the list
4. Use "Back' or "ESC" to quit the main menu. The changes made are accepted and saved

The device is in the measured value display mode and displays the measured values.

9.4.3  Step-by-step: read HART® values (option)

Procedure for reading measured values from a HART® device/sensor:

1. Make settings for HART® communication (HART® master, connection attempts)
under "Setup -> Advanced setup -> Communication -> HART"

2. Add new value to be read by selecting "Add value -> Yes"
Open the configuration for "Value x"

4. Select the physical interface to which the HART® device is connected "Connection ->
Channel x"

5. Set the address of the connected device, the HART® value to be read and the channel
identifier

6. Activate the universal input in the main menu under "Setup -> Advanced setup ->
Inputs -> Universal inputs"

7. Select the "HART" signal type and assign the previously defined HART® values. Make
the selection using the channel identifier of the HART® value

Other settings of the universal input are the same as for standard analog inputs

Assign activated inputs to a group in the main menu under "Setup -> Advanced
setup -> Application -> Signal groups -> Group x"

10. Use "Back” or "ESC" to quit the main menu. The changes made are accepted and saved

The device is in the measured value display mode and displays the measured values.

9.4.4  Step-by-step: HART® communication between an FDT Frame
application (FieldCare) and a HART® device/sensor (optional)

The RSG45 HART® CommDTM enables HART® communication between a PC with an FDT

Frame application and a HART® device. At this point, the RSG45 acts as a gateway/modem

between the PC and the HART® devices that are connected to the HART® input cards of
the RSG45. Communication between the PC and the RSG45 is via the TCP/IP protocol only.
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Procedure for establishing a connection:
1. Start RSG45 HART® CommDTM in the FDT Frame application

2. Setthe communication parameters, I[P address of Memograph M RSG45, port for
HART® communication and scan range (scan range O for a point-to-point
connection)

3. Open the "Create network” menu to call up the "Select communication channel"
dialog field to select the channel

4. Tick the check box beside the slot/channel to which one or more HART® devices are
connected. Press "OK" to confirm and to start the scanning process

5. All the HART® devices found are displayed in the FDT Frame application and can
now be called up

ﬂ Detailed help is provided with the RSG45 HART® CommDTM.

9.4.5  Setup directly at the device

In the "Setup" menu and in the "Advanced setup" submenu, you will find the most
important settings for the device:

Parameters Possible settings Description
Change date/time UTC time zone Change the date and time
dd.mm.yyyy hh:mm:ss
Advanced setup Advanced settings for the device e.g. system settings,

inputs, outputs, communication, application etc.

System Basic settings that are needed to operate the device,
(e.g. date/ time, security, memory management,
messages, etc.)

Inputs Settings for analog and digital inputs

Outputs Settings only required if outputs (e.g. relays or
analog outputs) are to be used

Communicati Settings required if the USB, RS232/RS485 or
on Ethernet interface of the device is to be used (PC
operation, serial data export, modem operation, etc.)

The different interfaces (USB, RS232/RS485,
Ethernet) can be operated in parallel. However,
simultaneous use of the RS232 and RS485
interface is not possible.

Application Configure various application-specific settings (e.g.
group settings, limit values, etc.)

ﬂ A detailed overview of all the operating parameters is provided in the appendix at the
end of the Operating Instructions. > 109

9.4.6  Setup via SD card or USB stick

An existing device configuration ("Setup data" *.DEH) from another Memograph M RSG45
or from FieldCare/DeviceCare can be uploaded directly to the device.

Import new setup directly at the device: The function used to load the setup data can be
found in the main menu under "Operation -> SD card (or USB stick) -> Load setup" ->
Select directory -> Next".

9.4.7  Setup via Web server

To configure the device via the Web server, connect the device via Ethernet to your PC.
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Please observe the information and communication settings for Ethernet and the Web
server under .~ B 38

ﬂ To configure the device via a Web server, you must have Administrator or Service
access. ID and password administration is performed in the main menu under "Setup
-> Advanced setup -> Communication -> Ethernet -> Configuration Web server ->
Authentication".

Default value for ID: admin; Password: admin
Note: The password should be changed during commissioning!

If security settings are according to "FDA 21 CFR Part 11", you must have
Administrator rights to configure the device via a Web server.

Establishing a connection and setup

Procedure for setting up a connection:
1. Connect the device to the PC via Ethernet

2. Start the browser at the PC; open the Web server for the device by entering the IP
address: http://<ip-address> Note: Leading zeros in IP addresses must not be entered
(e.g. enter 192.168.1.11 instead of 192.168.001.011)

Enter ID and password, and confirm each by clicking "OK"

4. The Web server shows the instantaneous value display of the device. Click "Menu ->
Setup -> Advanced setup" in the Web server function bar

5. Starting configuration
Continue with device configuration in accordance with the Operating Instructions for the
device. The complete Setup menu i.e. all of the parameters listed in the Operating

Instructions, can also be found on the Web server. After configuration, accept the setup
with "Save settings".

Procedure to establish a direct connection via Ethernet (point-to-point connection):
> B5sl

Undefined switching of outputs and relays
» During configuration using a Web server, the device may assume undefined statuses!
This may result in the undefined switching of outputs and relays.

An existing device configuration (‘Setup data" *.DEH) from another Memograph M
RSG45 or from FieldCare/DeviceCare can be uploaded directly to the device via the
Web server.
Procedure for uploading a new setup via the Web server:
1. Make the connection to the device with the Web server > B 43
2. Click "Data management -> Import device settings" in the Web server function bar
3. Select the setup file and press "OK" to confirm
4. The file is transferred, checked and accepted
5

Once the device settings have been accepted, information to this effect is displayed in
the Web server

9.4.8  Setup via FieldCare/DeviceCare configuration software
(included in the delivery)

To configure the device using the configuration software, connect the device to your PC via
USB or Ethernet.

43



Commissioning Memograph M, RSG45

Establishing a connection and setup

For details, see the Operating Instructions on the configuration software DVD
provided.

Continue with device configuration in accordance with the Operating Instructions for the
device.

ﬂ Information on configuration using FieldCare/DeviceCare configuration software
= Offline configuration: Most of the parameters are available (depending on the
device configuration).
= Online configuration: Only parameters marked "Online configuration" are available.
»> B 109

Undefined switching of outputs and relays
» During configuration using the configuration software, the device may assume
undefined statuses! This may result in the undefined switching of outputs and relays.

9.5 Advanced settings (Expert menu)

ﬂ The Expert menu is protected by the code "0000". If an access code is set up under
"Setup -> Advanced setup -> System -> Security -> Protected by -> Access code",
this must be entered here.

If security settings are according to "FDA 21 CFR Part 11", you must be logged in as a
user with Administrator rights to access the Expert menu.

The "Expert" menu contains all of the device settings:

Parameters Possible settings Description
Direct access 000000-000 Direct access to parameters (fast access)
System Basic settings that are needed to operate the device,

(e.g. date/ time, security, memory management,
messages, etc.)

Inputs Settings for analog and digital inputs

Outputs Settings only required if outputs (e.g. relays or
analog outputs) are to be used

Communication Settings required if the USB, RS232/RS485 or
Ethernet interface of the device is to be used (PC
operation, serial data export, modem operation, etc.)

The different interfaces (USB, RS232/RS485,
Ethernet) can be operated in parallel. However,
simultaneous use of the RS232 and RS485
interface is not possible.

Application Configure various application-specific settings (e.g.
group settings, limit values, etc.)

Diagnosis Device information and service functions for a swift
device check

ﬂ A detailed overview of all the operating parameters is provided in the appendix at the
end of the Operating Instructions. > 109
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9.6 Configuration management

ﬂ You can save the setup data ("Configuration") to an SD card or a USB stick, to a PC
drive via the Web server, or store them in a database using the configuration
software. This allows additional devices to be configured very easily using the same
settings.

Save setup: The function used to save the setup files can be found in the main menu under
"Operation -> SD card (or USB stick) -> Save setup".

A CAUTION
If the SD card or USB stick are removed directly:

Risk of data loss on SD card or USB stick.
» To remove the SD card or the USB stick, always select "Operation -> SD card (or USB
stick) -> Remove safely" in the main menu!
Procedure for saving a setup via the Web server:
1. Make the connection to the device with the Web server > B 43
Click "Data management -> Save device settings" in the Web server function bar
Select the setup file

Transfer the file

Verify and accept

= B B B B

Once the device settings have been accepted, information to this effect is displayed in
the Web server

ﬂ The function for saving the setup data must be enabled at the device for the Web
server under "Setup -> Advanced setup -> Communication-> Ethernet -> Web
server settings; Setup -> Yes".

9.7 Simulation

Various functions/signals can be simulated for test purposes here.

Selecting simulation: Simulation of the relays and the WebDAYV client can be found in
the main menu under "Diagnostics -> Simulation". The simulation of the measured
values can be found in the main menu under "Expert -> Diagnostics -> Simulation".
Only the simulated values are recorded during simulation. The simulation is recorded in
the event logbook.

» Do not start simulation if measured value recording must not be interrupted!

9.8 Protecting settings from unauthorized access

After configuration, the setup should be protected against unauthorized access. The
following options are available:

= Protection per control input

= Protection via release code

= Protection via user roles

= Protection via user administration according to 'FDA 21 CFR Part 11"

In order to change any parameter, the correct code must first be entered or the device must
be unlocked using the control input.
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Setup lock via control input: The settings for the control input can be found in the main
menu under "Setup -> Advanced setup -> Inputs -> Digital inputs -> Digital input X ->
Function: Control input; Action: Lock setup".

ﬂ It is preferable to lock the setup using a control input.

Setting up an access code: The settings for the access code can be found in the main
menu under "Setup -> Advanced setup -> System -> Security -> Protected by -> Access
code". Factory setting: "open access", i.e. modifications can always be made.

ﬂ Make a note of the code and store in a safe place.

Setting up user roles: The settings for the user roles (operator, admin and service) are
provided in the main menu under "Setup -> Advanced setup -> System -> Security ->
Protected by -> User roles" . Factory setting: "open access', i.e. modifications can always
be made.

ﬂ The passwords should be changed during commissioning.
Make a note of the code and store in a safe place.

Setting up user administration according to "FDA 21 CFR Part 11": The settings for user
administration can be found in the main menu under "Setup -> Advanced setup ->
System -> Security -> Protected by -> FDA 21 CFR Part 11". Factory setting: "open
access', i.e. modifications can always be made.
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10 Fulfilling requirements in accordance with
"FDA 21 CFR Part 11"

10.1 General notes

Before applying electronic signatures the

Office of Regional Operations (HFC-100)
5600 Fishers Lane

Rockville, MD 20857

USA

is to be informed, by means of an informal letter with handwritten signature, that the
company intends to use electronic documents/signatures in future. Administrators and
users must be instructed / trained in accordance with 21 CFR 11 or must already possess
the relevant knowledge or qualifications. Commercial software used in electronic recording
systems in accordance with 21 CFR 11 must be validated. The suitability of the device and
the associated PC software (incl. operating system) for the application in question must be
specified, validated, and documented (e.g. with regard to data confidentiality, printout of
the device parameters, security backup of the set parameters, assignment of access
authorizations in the PC software, suitability of the software used for commercial purposes
- such as operating system, etc.).

The identity of the relevant person must be verified before assigning / determining the
electronic signature (or elements of this electronic signature, e.g. unique ID / initialization
password). The administrator must ensure and document the uniqueness of the ID and its
correct assignment to the relevant person. Electronic signatures may only be used by
authorized users. They must not be passed on to third parties. Administrators and users
must undertake not to misuse their user IDs and passwords (including initialization
passwords).

Written procedural instructions, which make individuals responsible for all actions carried
out using their electronic signature, must be drawn up and observed so as to provide a
deterrent mechanism for the falsification of documents and signatures.

Suitable checks of system documentation must be made (distribution, access, and use of
documentation for system operation and maintenance). Revision and change control
procedures must be implemented for the system documentation in which the
chronological order of the development and change to system documentation is
documented. The system is not intended for use in Internet applications/open systems.
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The user is responsible for observing the following instructions for ensuring
compliance with FDA 21 CFR Part 11:

>

The scope of application for this FDA 21 CFR Part 11 evaluation refers to the
Memograph M RSG45 and the associated Field Data Manager (FDM) PC software,
which have been produced and tested by the manufacturer. The overall system must be
subjected to a final evaluation by the end user.

Recordings from the device and the associated PC software in accordance with "'FDA
Guidance for Industry: Computerized Systems Used in Clinical Investigations: 2007"
cannot be used for clinical studies.

In order to satisfy the requirements of FDA 21 CFR Part 11 with regard to the
electronic signature, the device may only be read out with the associated Field Data
Manager (FDM) PC software.

The device and the associated PC software do not take into account the requirements
of FDA 21 CFR Part 11, §11.30 for "Open systems". Operation within the context of an
open system must be excluded.

The operator must take suitable management precautions to prevent the loss of
password access data/authentication data.

The printer must be connected correctly and its long-term function guaranteed, even in
the event of local changes (e.g. network printer).

Due to the aging of components, the device must be calibrated at regular intervals.
Regular maintenance must also be carried out.

Measures must be taken to prevent the device from being moved (e.g. physical
protection).

No data will be recorded in the event of a power failure.

The battery buffer for the backup clock is checked and, where necessary, a warning
issued.

Wireless transmission may not be used between the device and the PC software. In the
case of wired transmission, operation is only permitted within the closed company
network. This must be checked during the validation of the complete system.

The user is responsible for observing the following instructions for ensuring
compliance with FDA 21 CFR Part 11:
Requirements for connected hardware components:

>

>

Associated hardware components (e.qg. a PC connected to the device) are part of the
system but must be provided by the user. Backup measures designed to prevent hard
disk defects or a memory overrun are the responsibility of the user.

Wired peripherals, such as a USB keyboard for the device or a keyboard for the PC, can
be scanned in using "Keylogger". It is the user's responsibility to prevent the use of so-
called "sniffers".
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10.2 Important device settings

In order to satisfy the requirements from 21 CFR 11, certain device functions are
required. In particular, some user administration settings must be made:

>

Activate user administration and password protection according to FDA 21 CFR Part
11: In the main menu go to "Setup -> Advanced setup > System -> Security ->
Protected by -> FDA 21 CFR Part 11"

Create a user: In the main menu go to "User administration -> Create user account"
to create a new user.

Make general user administration settings and define password rules: In the main
menu go to "User administration -> General". Recommendation: Password valid for
60 days in order to prevent it from becoming too familiar to the user.

Assign the permitted rights to users in the main menu under "User administration ->
General -> User rights"

All changes to the device are automatically recorded in the event logbook. The event
logbook can be opened from the main menu under "Diagnostics -> Event logbook"

The user is responsible for observing the following instructions for ensuring
compliance with FDA 21 CFR Part 11:
Requirements for the device:

>
>

The device must be regarded as a closed system.

Administrator rights are required to change the configuration. The device must be
locked via hardware protection (terminal cover) and a digital input assigned. Changes
are documented in the event logbook / audit trail. The event logbook can be opened
from the main menu under "Diagnostics -> Event logbook".

User administration with ID and password must be active.

All changes must always be documented with the user's name in the event logbook. It is
essential that user administration is active for this. All users must be created
accordingly under User administration.

All settings relating to password complexity and validity period are the responsibility of
the administrator.

During commissioning, the special requirements for the admin role must be taken into
account (stricter password rules). User administration can only be disabled by the
administrator. Under certain circumstances the administrator may lock users out of the
system or sabotage user administration.

The initial password set by the administrator must be changed on the first login
(configurable).

If the wrong password is entered repeatedly (max. number of attempts is adjustable),
access is blocked and an alarm can be sent by e-mail.

After setting up/using the device, the user must log out. Automatic logout after a
configurable time must be activated.

Communication interfaces can be blocked by the administrator. The interface for using
the modem must be switched off.

Hardware locking must be performed for the device update. This ensures that only the
administrator can perform a firmware update.

Any manipulation of the time synchronization is the responsibility of the user.

In order to prevent a loss of data, the data must be read out regularly from the memory.
Administrator rights are required in order to delete the internal memory. A hardware
lock can also be used to prevent the memory from being deleted.

The device produces a diagnosis list in which faults are documented. The diagnosis list
must be checked regularly; this can be done in the main menu under "Diagnostics ->
Diagnosis list ".

Proof testing of the error log is recommended; this is done from the main menu under
"Diagnostics -> Device information -> Error log".
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The user is responsible for observing the following instructions for ensuring
compliance with FDA 21 CFR Part 11:
Requirements for the external memory:

>

The external storage medium (SD card/USB stick) must only be removed using the
function "Operation -> SD card/USB stick -> Remove safely".

In contrast to the protected data format, which features CRC16 protective measures,
the stored data can be manipulated when using the open format (*.csv).

In order to prevent unauthorized access (e.g. through theft), the external memory can
also be disabled or removed.

10.3 Important settings in the Field Data Manager (FDM)

PC software

In order to satisfy the requirements according to FDA 21 CFR Part 11, certain
functions are required in the associated PC software. In particular, some user
administration settings must be made.

>

>

Use only operating systems with user administration (e.g. MS Windows® 2000/XP/
Vista/7/8).

Create an administrator: Create an administrator under "Extras -> User
administration".

Activate user administration and password protection according to FDA 21 CFR Part
11: Under "Extras -> Settings -> User administration" select "Activate user
management" and "Password protection in compliance with FDA 21 CFR Part 11"
The software applies the settings following a restart.

Additional users can now be created under "Extras -> User administration" with the
corresponding access roles.

All changes made to the software are recorded in the "Audit trail". This can be opened
via "Extras -> Audit trail".

Where appropriate, use the high-performance automatic functions of the PC software
(e.g. automatic read out, automatic backup function, automatic e-mail alert).
Note:Detailed instructions can be found on the DVD provided with the PC software.

The user is responsible for observing the following instructions for ensuring
compliance with FDA 21 CFR Part 11:

>

>
>
>

Modem operation cannot be implemented as a closed system.

User administration must be active in order to record the user names in the audit trail.
The password must be changed on the first login.

If the administrator forgets the password, a master password, which is only valid for a
limited period, may be used. Access is granted to the user on request and following
authorization.

If a user does not log out, an automatic lockout (screensaver) is activated via the
Windows® system setting.

It is possible to use the Field Data Manager PC software without identification or
password protection, but this is not compliant with FDA 21 CFR Part 11.

The ending of the automatic system service must be controlled via Windows® user
rights.

Since the PC date/time is used for the audit trail, it is theoretically possible to
manipulate the time stamp. This must be prevented by the user by means of Windows®
user rights.

Regular backups and preventive maintenance (e.g. by means of software updates) must
be carried out.

It is important to ensure that no data can be intercepted or manipulated during
communication between the device and the database.
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11 Operation

The "Operation" menu is geared towards the tasks and activities of the operator. It contains
all the parameters that are needed in ongoing operation. Historical values and analyses,
for example, can be displayed in the "Operation" menu and display settings can be made.
Any settings made for the onsite display have no effect on the measurement section or the
configured device parameters.

The unit's simple control system and the integrated help function enables you to perform
operation for many applications without the need for hard copy operating instructions.

11.1 Displaying and modifying current Ethernet settings

To establish communication with the device via Ethernet, the following settings must be
known or modified where necessary:

Display IP/MAC address (only if DHCP is enabled): The device's IP or MAC address can be
found in the main menu under "Diagnostics -> Device information -> Ethernet".

Display/change Ethernet settings: The device's Ethernet settings can be found in the
main menu under "Setup -> Advanced setup -> Communication -> Ethernet".
Procedure to establish a direct connection via Ethernet (point-to-point connection):

1. Configure the PC (depends on operating system): e.g. IP address: 192.168.1.1; subnet
mask: 255.255.255.0; gateway: 192.168.1.1

2. Disable DHCP on the device
3. Make communication settings on the device: e.qg. I[P address: 192.168.1.2; subnet
mask: 255.255.255.0; gateway: 192.168.1.1

ﬂ A crossover cable is not required.

11.2 Reading the device locking status

If setup is locked via a control input, a padlock symbol g appears on the top right of the
screen. The setup must first be unlocked via the control input before device parameters can
be edited.

Setup lock via control input: The settings for the control input can be found in the main
menu under "Setup -> Advanced setup -> Inputs -> Digital inputs -> Digital input X ->
Function: Control input; Action: Lock setup".

If setup is locked via the access code, all the operating parameters can be displayed, and
can also be edited as soon as the access code is entered.
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11.3 Reading measured values

41.11.2014 15:01:53

A0024709

12 Device front (left: Version with navigator and front interfaces; right: Version with stainless steel front and

touchscreen)
a  Slot for SD card
b USB B socket "Function"e.g. to connect to PC or laptop
c USB A socket "Host"e.g. for USB memory stick, external keyboard, barcode reader or printer
d  Yellow LED for read/write access to the SD card
1 Navigator: press briefly to open the main menu and confirm messages (=Enter); press for longer to open the
online help
2 Green LED (top) lit: Power supply present. Red LED (bottom) flashing: Maintenance required
3 Variable 'Softkey" keys 1-4 (from left to right)
4 Function indicator of "Softkey" keys
5 Header: group name, analysis type
6  Header: current date/time
7 User ID (when function is active)
8  Header: alternating display indicating the percentage space on the SD card or USB stick that has already been

used. Status symbols are also displayed in alternation with the memory information

9  Area for measured value display (e.g. curve display). Display of current measured values and the status in the
event of an error/alarm condition. In the case of counters, the type of counter is displayed as a symbol

10  Status bar

ﬂ An overview of all the symbols and icons is provided in the operating options section.
> B34

ﬂ If a measuring point has limit value status, the corresponding channel identifier is
highlighted in red (quick detection of limit value violations). During a limit value
violation and device operation, the acquisition of measured values continues
uninterrupted.

ﬂ Information on how to rectify a problem in the event of an error is provided in the
"Troubleshooting" section. > B 66

Endress+Hauser



Memograph M, RSG45

Operation

Endress+Hauser

11.4 Reading measured values via the Web server

A Web server is integrated into the device. If the device is connected via Ethernet, it is
possible to display the measured values via the Internet using a Web server.

Activation of Web server in the menu Setup - Advanced setup - Communication >
Ethernet > Web server - Yes or the menu Expert > Communication - Ethernet >
Web server - Yes.

The Web server port is preset to 80. The port can be changed in the Expert -
Communication > Ethernet menu.

ﬂ If the network is protected by a firewall, the port may need to be activated.

The following web browsers are supported:
= MS Internet Explorer 11 and higher

= Mozilla Firefox 15 and higher

= Opera 12.x and higher

= Google Chrome 23.x and higher

ﬂ In order to use the full functionality of the Web server, it is recommended that the
latest version of the browser is used.

To configure the device via a Web server, you must have Administrator or Service
access. Prior to accessing the Web server, create an ID and password in the main
menu under "Setup -> Advanced setup -> Communication -> Ethernet ->
Configuration Web server -> Authentication".

Default value for ID: admin; Password: admin
Note: The password should be changed during commissioning!

Data can be exported via the Web server in HTML or XML format.

11.4.1 Access to the Web server via HTTP (HTML)

When using an Internet browser, you just need to enter the address http://<ip-address>
to have the HTML view displayed in the browser.

Note: Leading zeros in IP addresses must not be entered (e.g. enter 192.168.1.11
instead of 192.168.001.011).

As on the display, you can alternate between the display groups in the Web server. The
measured values are automatically updated. In addition to the measured values, status and
limit value flags are displayed.

11.4.2 Access to the Web server via XML

XML format is available in addition to HTML format and contains all measured values of a
group. This can be integrated into additional systems as the user wishes.

The XML file is available in ISO-8859-1 (Latin-1) coding at http://<ip-address>/
values.xml (alternative: http://<ip-address>/xml). However, some special characters,
such as the Euro symbol, cannot be displayed in this file. Texts such as digital statuses are
not transmitted.

ﬂ Note: Leading zeros in IP addresses must not be entered (e.g. enter 192.168.1.11
instead of 192.168.001.011).

The decimal separator is always displayed as a point in the XML file. Also, all times
are given in UTC. The time difference in minutes is noted in the following entry.
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The structure of the channel values for the XML file is explained as follows:

<device id="AIO1IV" tag="Channel 1" type="INTRN">

<v1>50.0</v1>

<ul>%</ul>

<vtime>20130506-140903</vtime>

<ystslvl1>0</vstslvl1>

<hlsts1>L</hlsts1>
<param><min>0.0</min><max>100.0</max><hh></hh><hi></hi><lo></lo><II></II></
param>

<tag>Channel 1</tag>

<man>Manufacturer</man>

</device>
Day Description
device id Unique ID of measuring point
tag Channel ident.
type Data type (INTRN, MODBUS)
vl Measured value of channel as a decimal value
ul Unit of measured value
vtime Date and time
vstslvll Error level
0=0K, 1 =warning, 2 = error
hlsts1 Limit value status
H = upper limit value, L = lower limit value, LH = upper and lower limit value violation
param Parameter (optional)
min Lower zoom
max Upper zoom
hh Upper alarm limit
hi Upper warning limit
lo Lower warning limit
11 Lower alarm limit
MAN Manufacturer

11.4.3 Remote control via the Web server

Remote control of the device is possible via Web server. In the Web server, remote control
can be found under "Measured values -> Remote control". Here the display shown
corresponds directly to the device display. The device is operated using buttons below this
display. The interval for refreshing the display can be set in the "Refresh" menu.

Enabling remote control on the device:

1. Inthe menu Setup -> Advanced setup -> Communication -> Ethernet ->
Configuration Web server -> Remote control, select "Yes" or under

2. Expert -> Communication -> Ethernet -> Configuration Web server -> Remote
control, select "Yes".

11.5 Data analysis and visualization with the Field Data
Manager software (FDM) provided

The analysis software offers centralized data management with visualization for recorded
data.
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This enables all measuring point data to be completely archived, e.g.:
s Measured values

= Diagnostic events

= Protocols

The analysis software stores data in an SQL database. The database can be operated locally
or in a network (client/server). You can install and use the free Postgre™SQL database
provided on the DVD.

For details, see the Operating Instructions on the analysis software DVD provided.

11.5.1 Structure/layout of a CSV file

The CSV files are comprised as follows:

File name (=serial number + | Description Coding
file number + configuration
number + date and start
time + data type)

H4000504428 0000000279 | Contains all the measured values of the group from the ANSI
0000000185 2013-11-07 starting time indicated in the file name. An individual CSV
11-18-00 GROUPO1.csv file is created for each group.

H4000504428 0000000279 | Contains the signal analyses of the active channels from ANSI
0000000185 2013-11-07 the starting time indicated in the file name. An individual
11-30-00 ANALYSISO1.csv CSV file is created for every analysis (01 - 04).

H4000504428 0000000279 | Contains the event log from the starting time indicated in | Unicode UTF-8

2013-11-07 11-18-34 the file name. (see the notes in
EVENTS.csv the following
section)

Meaning of the values under 'Status" and "Limit" when analyzing a group:
Status of the channel:
0: 0K
1: Open circuit
2: Input signal too high
3: Input signal too low
4:Invalid measured value
6: Error value, i.e. not the calculated value (for mathematics if an input variable is invalid)
7: Sensor/input error
Bit 8: Not assigned
Bit 9: Alarm storage
Bit 10..13: Not assigned
Bit 14: Use error value

Bit 15: Not assigned

General status:

1: High speed storage is active
2: Additional hour for summer/normal time changeover

Note: A combination of 1 and 2 is also possible.
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Status of the limit value ("Limit"):
0: OK, no limit value has been violated

Bit 0: Lower limit value
Bit 1: Upper limit value
Bit 2: Increasing gradient
Bit 4: Decreasing gradient

Note: A combination is also possible.

11.5.2 Importing UTF-8-encoded CSV files into spreadsheets
You might encounter problems displaying information if importing UTF-8-encoded CSV
files directly into more recent versions of MS Excel™ (2007 and higher).
Importing CSV data from the event logbook ("Events") into MS Excel™ (version 2007
and higher):

1. Select the menu "Data -> Get external data - From text"

2. Select the CSV file

3. Follow the instructions in the wizard

4. Select file origin "Unicode UTF-8"

11.6 Change group

The group to be displayed can be changed in the main menu under "Operation -> Change
group". Alternatively, the group can also be changed by turning the navigator.

Version with stainless steel front and touchscreen:
The active groups can be changed with a horizontal "swiping" movement.

ﬂ Only the active groups are displayed here. The settings for this can be made in the
main menu under "Setup -> Advanced setup -> Application -> Signal groups ->
Group x".

11.7 Block keyboard/navigator

Local operation can be blocked in the main menu under "Operation -> Lock operation" to
prevent unintended or incorrect operation (e.g. when cleaning the device).

ﬂ The device is unlocked by pressing the navigator or the OK operating key for 3 s.
When using an external keyboard, the device is unlocked with the key combination
"Ctrl-Alt-Del".

11.8 Log on/log out
Log onto the device, or log out the user currently logged on.

ﬂ Only when user administration is active (FDA 21 CFR Part 11) or in the case of role-
based access protection.

11.9 Change password

Change your user password.
ﬂ Only when user administration is active (FDA 21 CFR Part 11).
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11.10 SD card/USB stick

11.10.1 Function of SD card or USB stick

Without affecting the internal memory, data packets are copied block by block (min. 1 x
daily, midnight) to the SD card. Tests are also made to determine whether the data have
been written without any errors. Once a new SD card is inserted, the device starts saving
the data automatically after 5 minutes. The use of a USB stick is only recommended if
certain data ranges should be copied. The USB stick is not used for storing the measured
values continuously, i.e. this is not automatically updated.

Data are saved in two different folders on the storage media depending on the storage

method:

= All data are copied cyclically to the rec_data_<Device name> folder if a data packet is
complete or the function "Update" is activated under "Operation -> SD card/USB stick -
> Update".

= The data for the time range selected under "Operation -> SD card/USB stick -> Save
measured value" is copied to the rng_data_<Device name> folder. The copying of this
data has no effect on the saving of data in the rec_data_<Device name> folder.

ﬂ = Only use new, formatted SD cards recommended by the manufacturer (see

"Accessories").~> B 79

= During normal operation, the used memory space on the SD card or USB stick is
displayed on the top right of the display ("SD: xx%" or "USB: xx%").
Dashes "-" on this display mean that no SD card is inserted.

® The SD card must not be write-protected.

= Prior to removing the external data carrier, select "Operation -> SD card/USB stick
-> Update". The current data block is closed and saved to the external data carrier.
This ensures that all current data (until the last save) is included on it.

= Depending on the configuration of the unit (see "Setup —> Advanced setup ->
System —> Ext. memory —> Warning at"), an acknowledgeable message on the
display informs you that the external data carrier has to be changed before the data
carrier is 100 % full.

= The device keeps track of which data have already been copied onto the SD card or
USB stick. Should you ever forget to change the data carrier in time (or if no SD card
has been inserted), the new external data carrier is filled with the missing data from
the internal memory - as long as the data are still available there. As measured
value acquisition/recording is assigned the highest priority, it may take several
minutes in this case for the data to be copied from the internal memory to the SD
card or USB stick.

11.10.2 Functions relating to the SD card or USB stick

You can find functions to save measured data and device settings on a removable medium
in the main menu under "Operation -> SD card/USB stick" (only if an SD card or USB stick
is provided).

Remove safely:

All internal access is terminated to ensure safe removal of the storage medium from the
device. You are notified when it is safe to remove the data storage medium. If the SD card
is not removed, the device automatically starts to save data to the storage medium again
after 5 minutes.

ﬂ Only remove the data storage medium using this function; otherwise data may be
lost!

Update:
Measurement data not yet saved on the storage medium are now saved. Please be patient!
Measured value acquisition is running in parallel and has top priority.

ﬂ Data from several devices can be saved onto one storage medium.

57



Operation

Memograph M, RSG45

58

= Save measured values:
A user-definable time range can be saved on the data storage medium.

= Load setup:
Loads device settings (setup) from the storage medium onto the device.

= Save setup:
All device settings (setup) are saved onto the storage medium. They can be archived or
used for other devices.

= Save setup as RTF:
Saves the setup on the storage medium in a readable format as an RTF file (rich text
format).
The RTF file can be opened and formatted using suitable word processing software (e.g.
MS Word), allowing printouts to be easily made.

= Screenshot:
Save the current measured value display as a bitmap on the SD card or USB stick.

= Update firmware:
Loads new firmware onto the device. Only visible if a firmware file is provided on the SD
card or USB stick.

ﬂ Caution: The device will restart. Save the setup and measured values beforehand on
the SD card or USB stick.

= Process-related graphic:
Load, export or delete process screen.
Load: Loads a process screen from the external storage medium to the device memory.
Export: Saves the current process screen in the device to the external storage medium so
that it can be transferred to another device.
Delete: Deletes the selected process screen from the device memory.
Procedure for creating and editing process pictures: .> 58

= Load user administration:
Loads all settings and user accounts from the storage medium to the device. The file has
the extension "ids2".

ﬂ Attention: All existing settings/accounts will be overwritten.

= Save user administration:
Saves all settings and user accounts to the storage medium. The file has the extension
"ids2".

= User administration as RTF:
Saves the user administration on the storage medium in a readable format as an RTF file
(rich text format).

= Import SSL certificate:
Uploads an SSL certificate (X.509) to the device. Certificates are needed so that an SSL
connection can be established in order to send encrypted e-mails, for instance. The
following are supported: DER, CER and CRT (binary or Base64-encoded).
Visible only if there is an SSL certificate on the SD card or USB stick.

Creating a process-related graphic with the process picture generator

ﬂ The DVD provided with the Field Data Manager (FDM) software includes a process
picture generator.

Alternatively, it can be downloaded from:
www.readwin2000.com/tools_files/ProcessPictureGenerator.zip

This program is used to generate a process screen quickly and easily.

Start the process picture generator and create the first project:

1. Copy the entire "ProcessPictureGenerator" directory from the DVD to a local directory
on the PC

2. Alternatively, unzip the downloaded ZIP file in a local directory on the PC

3. Double-click on the "FieldDiagramer.exe" application it contains
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4. The process picture generator is started and a new project is created

Select all fields required for the project such as project name, device type, etc. as well
as the background picture

6. Edit the process screen accordingly
Use the function "File -> Save" to save the current project

Use the function "File -> Export" to save the process screen ("PP_GROUP_<xx>.bmp")
with the required INI file ("PP_GROUP_<xx>.ini") to a USB stick or an SD card. Note:
The "xx" in the file name stands for the respective group (01-10)

9. Remove the USB stick or SD card from the PC

Further help can be called directly from the help menu of the process picture generator.

Load the process screen into the device:

1. [Insert the USB stick or SD card with the generated process-related graphic into the
device

2. Inthe main menu go to "Operation -> SD card/USB stick -> Process-related
graphic -> Group" and select the group to which the process screen should be
assigned

3. Inthe main menu go to "Operation -> SD card/USB stick -> Process-related
graphic -> Load", select the desired process screen, and load it into the device

4. In the main menu go to "Operation -> Change display mode" and change the
display mode to "Process-related graphic"
Editing process screens on the device
Process screens can be edited on the device.

The following functions are possible:

= Add or remove channels to/from the process screen
= Change the position, font size, and alignment

= Delete the process screen

Call up the Context menu: In the measured value display, press the Navigator or "Menu"
for longer than 3s.

In the context menu that is now open the "Process-related graphic' submenu can be

selected:
Parameters Parameter/description
"Edit" submenu Here you can edit the currently displayed process screen (position, font size, etc.).
"Channel 1-8" Here you can edit the selected channel of the process screen (activate, change position/
submenu font size, etc.).

Display in the process screen

Switch the channel in the process screen on or off.

Note: Does not affect the saving of measured values/configuration.
Options: No, Yes; Factory setting: No.

Channel ident.

Specify whether the channel identifier should be displayed in addition to the measured
value. The channel identifier is displayed above the measured value.

Options: No, Yes; Factory setting: No.

Alignment
Specify how the measured value should be aligned.

E] If "Align left" is selected, the x position is the top, left corner of the measured value.
If "Align right" is selected, the x position is the top, right corner of the measured
value.

Options: Left-aligned, right-aligned.
Factory setting: Right-aligned.
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Parameters Parameter/description

x-position
Select the x-position at which the measured value should be displayed.
Input: O to 799 pixels; factory setting: 10.

E] The point of origin (x-/y-zero point) is the top left. When the x-value is increased
the text moves to the right.

y-position
Select the y-position at which the measured value should be displayed.

[ﬂ The point of origin (x-/y-zero point) is the top left. When the y-value is increased
the text moves down.

Input: O to 450 pixels; factory setting: 50 (channel 1) to 260 (channel 8).

Font size
Select the font size in which the measured value should be displayed.
Options: Small, Medium, Large, Very large; factory setting: Large.

Accept changes Saves the changes to the process screen in the device memory.

Delete Deletes the selected process screen from the device memory. The device then changes to
the curve display.

11.10.3 Notes on e-mail encryption

In addition to sending unencrypted e-mails, it is also possible to send encrypted e-mails via
SSL (TLS). To do so, you can choose either of two ways:
= By SMTPS: fully encrypted via port 465.
The complete connection runs over TLS. The port is 465 by default but this value can be
changed in the Setup.
= Via port 25 or 587 using STARTTLS.
With this method the device first establishes a plain SMTP connection via port 25 and
continues this connection following agreement and switchover to encryption.

The required process can be selected as follows: "Setup -> Advanced setup -> Application
-> E-mail -> Server requires SSL" or under "Expert -> Application -> E-mail -> Server
requires SSL".

Only TLS V1.0 (=SSL 3.1) or TLS V1.1 is supported. Older standards are not supported.
The encryption method is automatically agreed with the counterparty.

A certificate must be installed in order to be able to send encrypted e-mails. These
certificates can be obtained from your e-mail service provider. The following file formats
are supported:

= * CER: DER- or Base64-encoded certificate

= * CRT: DER- or Base64-encoded certificate

= * DER: DER-encoded certificate

ﬂ The file name of the certificate may only contain the following characters: a..z, A..Z,
O"9Y +Y _7 -7 #7 (Y )7 !

To establish an SSL connection, the device automatically selects the certificate that best
suits the counterparty from all the installed certificates. An error message is displayed if
the device does not have any of the required certificates.

ﬂ When e-mail encryption is enabled, no e-mails can be sent if a valid certificate is not
available or if the certificate has expired.

11.10.4 Notes on WebDAYV encryption

In addition to sending unencrypted data to the WebDAV server, it is also possible to send
encrypted data via SSL (TLS). All data are sent in encrypted format via the SSL port of the
external WebDAV server.

The complete connection runs over TLS. The port is 80 by default but this value can be
changed in the Setup. The procedure to be used can be selected as follows: "Setup ->
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Advanced setup -> Application -> WebDAV Client -> Enable -> Yes (SSL)" or under
"Expert -> Application -> WebDAV Client -> Enable -> Yes (SSL)".

Only TLS V1.0 (= SSL 3.1) or TLS V1.1 is supported. Older standards are not supported.
The encryption method is automatically agreed with the counterparty.

A certificate must be installed in order to be able to send encrypted data. These certificates
can be obtained from your WebDAYV server service provider. The following file formats are
supported:

= * CER: DER- or Base64-encoded certificate

= * CRT: DER- or Base64-encoded certificate

= * DER: DER-encoded certificate

ﬂ The file name of the certificate may only contain the following characters: a..z, A..Z,
O"9I +7 _7 J— #7 (I )7 !

To establish an SSL connection, the device automatically selects the certificate that best
suits the counterparty from all the installed certificates. An error message is displayed if
the device does not have any of the required certificates.

ﬂ When WebDAV Client encryption is enabled, no data can be sent if a valid certificate
is not available or if the certificate has expired.

11.10.5 SSL certificates

Importing an SSL certificate

Installing a certificate via SD card or USB stick:
1. Copy a certificate on a PC to an SD card or USB stick
2. Insert the SD card or USB stick into the device

3. Inthe main menu, select "Operation -> SD card (or USB stick) -> Import SSL
certificate"

4. Select the required certificate from the list and follow the dialog on the display

ﬂ Up to 3 certificates can be installed simultaneously.

Verifying the installed SSL certificates

The installed certificates can be verified in the main menu under "Diagnostics -> Device
information -> SSL certificates". The most important certificate information, e.g. subject
key ID, organization and validity period, are displayed in the parameter list.

ﬂ Not all fields are completed on all the certificates. This is because the parties issuing
the certificates do not make all the information available.

Deleting an SSL certificate

In the main menu select the certificate to be deleted under "Diagnostics -> Device
information -> SSL certificate -> Certificate" and select "Yes" under "Delete certificate".

Period of validity of certificates

Certificates are valid for a defined period (valid from ... to ...). The device checks the
certificate validity once a day or each time the device is rebooted. 14 days before the
certificate expires the device notifies the user daily (by e-mail, screen display, entry in
event log) that the certificate will expire shortly.

If the certificate has expired the alarm relay switches (if activated) and a message is
displayed on the screen. An entry is also made in the event log. If a certificate is deleted all
errors related to this certificate are reset.
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11.11 Showing measured values history

You can scroll through the saved measured values in the main menu under "Operation ->
History". Turn the navigator clockwise or counterclockwise to scroll back and forth
between the measured value curves. Press the navigator to make other settings for the
historical data display (e.g. scroll speed, time scaling or change display mode) or to quit the
historical data function.

Version with stainless steel front and touchscreen:

The measured value curves can be scrolled back and forth with a horizontal "swiping"
movement.

The gray header in the display and the |~ symbol in the status bar indicate that
historical values are being displayed. In the instantaneous value display the color of
the header is blue.

11.11.1 Historical data: changing a group

It is possible to change the group to be displayed in the historical data under "Operation ->
Change group" in the data history.

11.11.2 Historical data: Scroll speed

It is possible to change the scroll speed in the historical data under "Operation -> Scroll
speed" in the data history.

The scroll speed can also be set via the soft key with the arrow symbol < or >. The speed
can be changed from < (slow) to <<<< (fast) by pressing the soft key repeatedly.

11.11.3 Historical data: Time scaling

It is possible to scale the displayed time range in the historical data under "Operation ->
Time scaling” in the data history.

ﬂ Notes:

= "1:1" option: Every measured value is displayed.

= "1:n" option: Only every nth measured value is displayed (increases the displayed
time range).

= No interpolation is performed, nor is the mean value determined.

= [f the value for 'n" is large, this can result in extended loading times.

= Time scaling does not affect the process for storing the measured value.

= The time range displayed per screen for the currently set time scaling is also
displayed in the menu.

11.11.4 Historical data: Time range displayed

The displayed time range is shown in the historical data under "Operation -> Time range
displayed" in the data history. This tells the user which time range is displayed per screen
in the standard memory cycle.

ﬂ If the alarm cycle differs from the standard memory cycle, this is not taken into
consideration.

11.11.5 Historical data: Screenshot

The current measured value display can be saved as a bitmap to an SD card or USB stick in
the historical data under "Operation -> Screenshot".
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11.11.6 Historical data: Change the display mode

It is possible to change the display mode of the active group in the historical data under
"Operation -> Change display mode" in the data history.

The following display modes are possible: Curve, Curve in ranges, Waterfall, Waterfall in
ranges, and Circular chart.

ﬂ The various display modes have no influence on the signal recording.

11.11.7 Historical data: Store text

You can store a text predefined in the list or a text of your own. This text is assigned to a
definable point in time.

A predefined text can be selected or a user-defined text can be saved in the historical data
under "Operation -> Store text".

11.12 Signal analysis

The analyses saved in the device are displayed in the main menu under "Operation ->
Signal analysis".

s Actual intermediate analysis:
Here, you can have the current (i.e. not yet completed) intermediate analysis displayed.
= External analysis 1-4:
Here, you can have current (i.e. not yet completed) external analyses displayed.
s Actual day:
Here, you can have the current (i.e. not yet completed) daily analysis displayed.
= Actual week:
Here, you can have the current (i.e. not yet completed) weekly analysis displayed.
= Actual month:
Here, you can have the current (i.e. not yet completed) monthly analysis displayed.
= Actual year:
Here, you can have the current (i.e. not yet completed) annual analysis displayed.
= Search:
Search and display of analyses. Select which analyses should be searched for/displayed:
Intermediate analysis, Daily analysis, Monthly analysis, Annual analysis.

11.13 Search in trace

In the main menu, the internal memory can be searched for events or times under
"Operation -> Search in trace".

Search for events: The event loghook forms the basis for searches for events. To search
more easily for certain events (e.g. setup changes), the search filter can be used to select
and search for the desired events. In the standard all events are shown. In the event list
displayed, it is possible to select an event and go directly to this point in the history (if still
in the memory).

Search for time: When searching for a time in the past, the user can enter a date and a
time to specify when the system should start displaying historical data. Once the date/time
have been entered and confirmed, the display goes to the selected time in the active group.

11.14 Changing the display mode

The display mode of the active group can be changed in the main menu under "Operation
-> Change display mode".
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The following display modes are possible: Curve, Curve in ranges, Waterfall, Waterfall in
ranges, Bargraph, Digital display, Instrument display, Circular chart, and Process screen.

ﬂ The various display modes have no influence on the signal recording.

11.15 Store text

You can store a text predefined in the list or a text of your own. This text is assigned to a
definable point in time.

A predefined text can be selected, or a user-defined text can be saved, in the main menu
under "Operation -> Store text".

11.16 Printout

The device settings, user administration data, event log, current measured values or a
screenshot of the measured value display can be printed out in the main menu under
"Operation -> Printout”.

Due to technical restrictions, the printout from the device is always in English when

using the following operating languages: Polish, Russian, Swedish, Czech, Japanese,

and Chinese.

Printout via PC:

» The device settings or user administration can be saved in the set language in the form
of an RTF file and printed out from the PC.

Due to technical restrictions, the event log cannot be printed out from the device

when using the following operating languages: Polish, Russian, Swedish, Czech,

Japanese, and Chinese.

Printout via PC:

» The event log can be printed out via the Field Data Manager (FDM) software.
Alternatively the event log can be saved as a CSV file and printed out from the PC.

11.17 Adjusting the brightness of the display

You can adjust the brightness of the display in the main menu under "Operation -> Adjust

brightness":
Parameters Possible settings Description
Adjust brightness 0-100 Sets the brightness of the display
Default: 80

11.18 Limit values

It is possible to change the limit values during operation in the main menu under
"Operation -> Limits".

This function must be enabled beforehand in the main menu under "Expert ->
Application -> Limits-> Change set points: Outside of setup also".

Detailed description of the limit values: > &8 223
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11.19 WebDAV Client

The function of the WebDAV client is to transmit recorded data automatically to a
connected WebDAV server (e.g. NAS drive). The recorded data are sent to the connected
WebDAV server cyclically every 15 minutes. The generated files correspond to the files
that are automatically saved to the SD card.

The client is configured via "Setup -> Advanced setup -> Application -> WebDAV
Client". The settings under "Setup -> Advanced setup -> System -> External memory"
are also used for this, with the exception of the SD card settings (memory build-up,
warning, and relay). The memory is regarded as a stack memory.

Detailed description of the parameters: > B 247

Note: With the WebDAV client, the data are transmitted to the WebDAV server in
accordance with the selection made in the .CSV or "protected format"

11.19.1 Access to the WebDAYV server via HTTP (HTML)
Address entry in browser: http://<ip-address>/webdav

The data are updated cyclically every 15 minutes. The data are automatically updated each
time a user logs in.

Note: Leading zeros in IP addresses must not be entered (e.g. enter 192.168.1.11
instead of 192.168.001.011).

ﬂ Administrator or service authentication is required. ID and password administration is
performed in the main menu under "Setup -> Advanced setup -> Communication ->
Ethernet -> Configuration Web server -> Authentication".

Default value for ID: admin; Password: admin
Note: The password should be changed during commissioning!

If security is activated in accordance with "FDA 21 CFR Part 11", authentication as a
user with administrator rights is required in order to establish a connection.

Note: For devices with a stainless steel front and touchscreen, the data are always
made available in "protected format" via the WebDAV server.
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12 Diagnostics and troubleshooting

To help you troubleshoot, the following section is designed to provide an overview of
possible causes of errors and initial remedial measures.

12.1 General troubleshooting

A WARNING

Danger! Electric voltage!
» Do not operate the device in an open condition for error diagnosis!

Display Cause Solution
No measured value display; no | No supply voltage connected Check the supply voltage of the device
LED lit
Supply voltage is applied; device or The power unit or the device must be
power unit is defective replaced
Diagnostic message is The list of diagnostic messages is provided in the following section
displayed

ﬂ Dead pixels: Dead pixels refer to pixels on LCD and TFT displays that are defective
due to the technology or manufacturing techniques used. The TFT display used can
have up to 10 dead pixels (Class III as per ISO 13406-2). These dead pixels do not
entitle the user to a warranty claim.

12.2  Troubleshooting

The Diagnostics menu is used for the analysis of the device functions and offers
comprehensive assistance during troubleshooting. Always proceed as follows to locate the
cause of the device errors or alarms.

General troubleshooting procedure

1. Open diagnosis list: lists the 30 most recent diagnostic messages. This can be used to
determine which errors are currently present and whether an error has repeatedly
occurred.

2. Diagnosis of current measured values: Verify the input signals by displaying the
current measured values or the scaled measuring ranges. To verify calculations, call
up calculated auxiliary variables if necessary.

3. Most errors can be rectified by performing steps 1 and 2. If the error persists follow
the troubleshooting instructions in the following sections.

4. If this does not rectify the problem, contact the Service Department. Any time you
contact the Service Department please always have the error number and the
information in the main menu under "Diagnostics -> Device information" (program
name, serial number etc.) ready.

The contact details of your Endress+Hauser representative can be found on the Internet at
www.endress.com/worldwide.

12.2.1 Device error/alarm relay

One relay can be used as an alarm relay. If the device detects a system error (e.g. hardware
defect) or a malfunction (e.g. cable open circuit), the selected output/relay switches. The
alarm relay is assigned in the main menu under "Setup -> Advanced setup -> System ->
Fault switching -> Relay x". Factory setting: Relay 1.

This "alarm relay" switches if "F'-type or "S'-type errors occur, i.e. "M'-type or "C'-type errors
do not switch the alarm relay.
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12.3

The diagnostic message consists of a diagnostic code and a message text.

Diagnostic information on the local display

The diagnostic code consists of the error category as per Namur NE 107 and the message
number.

Error category (letter in front of the message number)

s F = Failure. A malfunction has been detected.
The measured value of the affected channel is no longer reliable. The cause of the
malfunction is to be found in the measuring point. Any control system connected should
be set to manual mode. An alarm relay can be assigned to this error category in the
Advanced setup.

= M = Maintenance required. Action must be taken as soon as possible.
The device still measures correctly. Immediate measures are not necessary. However,
proper maintenance efforts would prevent a possible malfunction in the future.

= S = Out of specification. The measuring point is being operated outside specifications.
Operation is still possible. However, you run the risk of increased wear, shorter operating
life or lower measurement accuracy. The cause of the problem is to be found outside the

measuring point.
s C = Function check. The device is in Service mode.

Diagnostic | Message text Description Remedy

code

F100 Sensor/input error Sensor/input error Check connections and parameters

F101 Open circuit Cable open circuit Check connections

F105 Invalid value! Measured value is invalid (when calculating --> | Check connections and process variables

NAN)

F201 Device fault Device error Contact the Service Department

F261 Error: RAM No access to RAM Contact the Service Department

F261 Error: Flash No access to flash Contact the Service Department

F261 Error: SRAM No access to SRAM Contact the Service Department

F261 Analog card x out of order! | Hardware defect detected Contact the Service Department, replace card

F261 HART card out of order! Hardware defect detected Contact the Service Department, replace card

F261 Power supply out of order! | Hardware defect detected Contact the Service Department, replace power unit

F261 Digital card out of order! Hardware defect detected Contact the Service Department, replace card

F261 Fieldbus card out of order! | Hardware defect detected Check contacts of Anybus card, contact the Service
Department

M284 Firmware update Firmware has been updated No action required. Message can be acknowledged

F301 Error: Cannot load setup Setup defective Switch the device off and then on again, re-configure,
contact the Service Department if necessary

M302 Setup restored from backup | Setup has been loaded from backup Check setup

F303 Error: Device data Device data defective Contact the Service Department

M304 Backup: Device data Device data defective. However it was possible Check settings (e.g. serial number)

to continue working with the backup data
F307 Error: Customer preset Customer preset value defective
value defective

F309 Error: Date/time is not set | Invalid date/time (e.g. internal battery is empty) | Device was switched off too long. The date/time must
be set again. Battery might need to be replaced
(contact the Service Department)

F310 Error: Cannot save setup The setup could not be saved Contact the Service Department

F311 Error: Device data The device data could not be saved Contact the Service Department

F312 Error: Calibration data The calibration data could not be saved Contact the Service Department

defective
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Diagnostic | Message text Description Remedy
code
F312 Analog card x is not Analog card x is not calibrated! The device Contact the Service Department
calibrated! works with default values, i.e. the measured
values could possibly be inaccurate under
certain circumstances
M313 SRAM has been SRAM was defragmented after firmware update | No action required. Message can be acknowledged
defragmented
F314 Error: Option code Activation code is no longer correct (incorrect Enter new code
serial number/program name). Option has been
switched off and setup preset has been
performed
M315 No IP address could be No IP address could be obtained from the DHCP | Check the network cable
obtained from the DHCP server!
server!
M316 Invalid MAC address! No or incorrect MAC address Contact the Service Department
M317 Battery voltage < 2 V. Battery needs to be replaced (contact the Service
Please replace battery! Department)
F348 Firmware cannot be Firmware update has been aborted because the | Contact the Service Department
updated: firmware file is damaged or is not compatible
® Checksum incorrect with this device
= Firmware incompatible!
M350 Measured value acquisition | Measured value acquisition was interrupted/ No action required. Message can be acknowledged
interrupted for calibration/ | reactivated for service/maintenance purposes.
service work Causes include:
Measured value acquisition | = Calibration of inputs/outputs
restarted = Firmware update
M351 The device will restart The device is rebooting. No action required. Message can be acknowledged
Causes include:
= Following a firmware update
= Change of device options
F431 Error:Calibration Calibration data missing Contact the Service Department
M502 Device is locked! Device is locked! The message appears when an | Check lock per digital channel
attempt is made to update the firmware, for
example
F510 Setup was corrected. The device detected that the configuration was | Please check the configuration of the device. If
no longer correct. All the parameters affected hardware has been replaced, no other action is needed
have been reset to the factory default settings. | (recommendation: change the operating language so
Possible causes: that the error message no longer appears after the
= Input cards have been removed or replaced by next restart)
another type
= An input card is no longer working correctly
A firmware update has caused compatibility
problems
Note: This error message appears each time the
device is restarted until at least one change has
been made to the configuration
F510 User administration was The device detected that the user
corrected administration settings were no longer correct.
All the parameters affected have been reset to
the factory default settings
M520 SMTP: Name could not be Problem with name resolution (DNS). Check the corresponding settings

resolved (DNS)!

SNTP: Name could not be
resolved (DNS)!

SMTP: e-mail

SNTP: time synchronization
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Diagnostic | Message text Description Remedy
code
F526 = Support points not OK The support points for the specified Check support points
= Support points: x-value linearization table are not plausible
exists more than once
= Upper and lower support
points are identical
M528 Setup is not compatible with | An attempt was made to load a setup which is | Check whether the correct file has been selected
this firmware! not compatible with this firmware (e.g. another
device type)
M530 Cannot copy setup An error occurred when a setup was loaded Replace the SD card or USB stick
from an SD card or USB stick Setup file defective?
An error occurred when a setup was saved to an
SD card or USB stick
5901 Input signal too low Input signal too low Check Connections and parameters. Check connected
sensor/transmitter
5902 Input signal too high Input signal too high Check Connections and parameters. Check connected
sensor/transmitter
M905 Set point x Set point x has been violated Note: Error number only occurs if e-mails are sent
M906 End limit value x Set point x no longer violated Note: Error number only occurs if e-mails are sent
F907 Error DP flow Error during DP flow calculation
F910 This software is not enabled | The current firmware is not enabled for this Contact the Service Department
for this device hardware
M913 DP flow: Outside of ISO Error during DP flow calculation
5167
M914 DP flow: Density calculation | Error during DP flow calculation
M920 Too many messages that There are too many messages that need to be Acknowledge messages
need to be acknowledged! acknowledged. Another message could not be
added
M921 SD card x% full. External memory is full Replace SD card
M922 No cyclic measurement The instantaneous values were not read out for
transfer a set time
M922 No cyclic transfer The device was not read out via fieldbus for a Check the communication of the fieldbus. Check PLC
configurable time
M923 Error in printing Various problems while printing, e.qg.: Check the printer status on the printer
= Printer spooler is full
= Printer out of paper
= Printer not ready
= Please replace the toner/ink
M924 Error accessing SD card! Impossible to access the removable data Check/replace removable data medium
Error accessing USB stick! medium. Causes include:
SD card is not or wrong Memory is larger than 32 GB
forglatjtid‘! Invalid format (only FAT or FAT32 are
USB stick is not or wrong permitted)
formatted!
M925 SD card is write-protected! | SD card is write-protected! Remove write protection
M927 Insufficient space free on An attempt was made to save to the SD card or | Use other SD card/USB stick. Delete files that are no
data storage medium! USB stick (setup, screenshot, etc.), but not longer needed from the SD card/USB stick
enough free memory space is available
M927 Insufficient space free on An attempt was made to save the data onto the | Use other WebDAV server. Delete files no longer
data storage medium! WebDAV server, but there was not sufficient required from the WebDAYV server
memory available
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Diagnostic
code

Message text

Description

Remedy

F929

File is damaged!

The file that should be loaded is damaged/
invalid (e.g. wrong checksum).

This message can occur in connection with the
following actions, for instance:
Loading setup from SD card/USB stick

Firmware update

Loading process-related graphics

Create file again, use other storage medium

M940

E-mail could not be sent! (x)

E-mail could not be sent!

Optional: Error code (x) from server: e.g.:

= 451: Requested action aborted: local
processing error

= 554: Transaction failed. Possible reason: e-
mail was not sent as suspected of being
SPAM

= 1: No free buffer

= 2:No receiver specified

Check settings/network connection

= 451:Try again
® 554: Use other e-mail provider

M941

No connection to the e-mail
server!

A connection to the e-mail server could not be
established because:

= The entered connection data are incorrect
= The connection has been disconnected

Check settings/network connection

M942

SMTP: fault occurred (x).

An error occurred when sending an e-mail.
x= error code:

0: SMTP was switched off when the mail was
being sent

3: TCP/IP connection was denied

4: TCP/IP connection error

5: SMTP server denied

6: Error during authentication

7: Connection unexpectedly lost

8: Server responded with error code

9: Timeout

10: Internal protocol error

Check settings/network connection

M944

SMTP: authentication
failed!

Check settings/network connection

M945

SNTP: Time was not
synchronized!

Time could not be synchronized via SNTP.

Possible reasons:
= SNTP server temporarily unavailable
= Settings not correct

® Check settings
= Check whether the error occurs often. If it does,
choose another time server

M945

SNTP server 1 not
responding. Try server 2

Time could not be synchronized via SNTP.

Possible reasons:
= SNTP server temporarily unavailable
= Settings not correct

= Check settings
= Check whether the error occurs often. If it does,
choose another time server

M946

Screenshot could not be
saved (x)!

Screenshot could not be created.

Possible causes (x):

0: Error when writing

1: Insufficient free space

2: Bitmap could not be created

3: SD card/USB stick not available or ready

Check/replace the SD card or USB stick

M947

Modem could not be
initialized! Please check the
cable and modem

The connected modem could not be initialized
by the device

Please check the cable and modem

M950

Unable to load SSL
certificate

Unable to load SSL certificate. Cause:

= Invalid file format
= File is damaged

= Use a certificate with a valid file format
= Import certificate to device again

F951

SSL certificate ... has
expired!

Certificates have an expiry date, i.e. they must
be renewed from time to time

Install a new certificate

M952

SSL certificate '.." expires
on..!

The device warns the user shortly before the
certificate expires

Install a new certificate
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Diagnostic | Message text Description Remedy
code
M953 x certificates have already | The device can manage max. 3 X.509 Delete a certificate that is already installed and no
been installed. First of all, certificates longer required
please delete certificates
that are no longer required
M954 SSL certificate not found: Unable to establish SSL connection as a suitable | Install a suitable certificate
keyID = ... certificate is not installed
M955 SSL connection denied!
M956 Incorrect password. Your Incorrect password. User account has been Please contact your administrator to reactivate your
user account has been deactivated account
deactivated
M956 Incorrect password. Your An incorrect password was entered and the Wait until the temporary block has been disabled or
user account has been account has been temporarily blocked contact your administrator
deactivated for 10 minutes
M957 Wet steam alarm Warning for wet steam alarm Check the application (pressure, temperature inputs)
M965 SMS could not be sent SMS could not be sent because: Check connections and communication settings
= The entered connection data are incorrect
= There is no connection to the service provider
M971 No channels assigned to The batch functionality has been activated but | Check group settings
batch x no channels have been assigned to the batch
M980 No connection to the A connection to the WebDAV server could not | Check settings/network connection
WebDAV server be established because the entered connection
data are incorrect or the connection has been
disconnected
M981 WebDAV: Authentication Check settings
failed
M982 WebDAV: Directory or file | Set directory path does not exist Create a directory manually in the WebDAV server
could not be created
M983 WebDAV: Fault An unassigned error has occurred. The error is
displayed in English

HART® error messages

Diagnostic | Message text Description Remedy
code
M490 Channel x: Max. 5 devices | Max. 5 HART® devices may be connected to the | Use other channels
may be connected per input
channel in Multidrop mode.
M960 Value uncertain/ In the case of fieldbuses: The status of the value
communication faulty is uncertain
In the case of HART®: The current value is used
instead of the digital value
M970 Multi-master collision = Check additional master in the HART® network
(e.g. handheld)
= Check master settings (secondary/primary)
12.4 Pending, current diagnostic messages
The diagnostic message that is currently pending, the last diagnostic message and the last
device restart are displayed in the main menu under "Diagnostics -> Actual diagnostics",
"Diagnostics -> Last diagnostics" or under "Diagnostics -> Last restart".
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12.5 Diagnosis list

The last 30 diagnostic messages are displayed in the main menu under "Diagnostics ->
Diagnosis list" (messages with Fxxx, Sxxx or Mxxx-type error numbers).

The diagnosis list is designed as a ring memory, i.e. when the memory is full the oldest
messages are automatically overwritten (no message).

The following information is saved:
= Error number

= Error text

= Date/time

12.6  Event logbook

Events such as limit value violations and power failures are displayed in chronological
order in the event logbook. It can be found in the main menu under "Diagnostics -> Event
logbook". Individual events can be selected and details displayed.

12.7 Device information

Important device information, e.g. serial number, firmware version, device name, device
options, memory information, SSL certificates etc. are displayed in the main menu under
"Diagnostics -> Device information” .

ﬂ For further information open the online help on the device.

12.8 Diagnostics of measured values

Displays the current measured values in the main menu under "Diagnostics -> Measured
values". The input signals can be verified here by displaying the scaled and calculated
values. To verify calculations, call up calculated auxiliary variables if necessary.

12.9 Diagnostics of outputs

Displays the current states of the outputs (analog outputs, relays) in the main menu under
"Diagnostics -> Outputs".

12.10 Simulation

Various functions/signals can be simulated for test purposes here.

Selecting simulation: Simulation of the relays can be found in the main menu under
"Diagnostics -> Simulation". The simulation of the measured values can be found in
the main menu under "Expert -> Diagnostics -> Simulation".

Only the simulated values are recorded during simulation. The simulation is recorded in

the event logbook.

» Do not start simulation if measured value recording must not be interrupted!

12.10.1 Test barcode reader

The function (e.g. character set) of the barcode reader can be tested in the main menu
under "Diagnostics -> Simulation -> Test barcode reader".

ﬂ Only visible when a barcode reader is connected.
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12.10.2 E-mail test

A test mail can be sent to the selected recipient in the main menu under "Diagnostics ->
Simulation -> E-mail".

At least one e-mail address must be set beforehand. A message is provided on the
device to confirm if the email was sent or not.

12.10.3 Test WebDAV Client

A test file can be sent to the selected WebDAV server in the main menu under
"Diagnostics -> Simulation -> WebDAV Client".

ﬂ The settings for the WebDAYV server to be addressed must be set beforehand under
"Setup -> Advanced setup -> Application -> WebDAV Client".

12.10.4 Test telealarm

The telealarm functionality can be tested in the main menu under "Diagnostics ->
Simulation -> Test telealarm". During this test, alarms are simulated and triggered.

ﬂ Only possible with the "Tele-Alarm" device option.

Detailed descriptions of this device option can be found in the associated
documentation.

12.10.5 Test time synchronization/SNTP

Time synchronization (SNTP setting) can be tested in the main menu under "Diagnostics -
> Simulation -> SNTP".

SNTP must be enabled beforehand in the main menu under "Setup -> Advanced
setup -> System -> Date/time set-up -> SNTP".

Note: The test can take some time. A message is provided on the device once the test
has finished.

12.10.6 Test universal output

The active analog and pulse outputs can be tested in the main menu under "Diagnostics ->
Simulation -> Universal output".

12.10.7 Relay test

The relay selected under "Diagnostics -> Simulation -> Relay x" can be switched
manually in the main menu.

12.11 HART® diagnostics

Display of device information and status of the connected HART® devices/sensors in the
main menu under "Diagnostics -> HART".

ﬂ Note: It can take several seconds until all information is available from the device/
Sensor.

Attention: Measured value acquisition will be slower because additional information
needs to be read.

ﬂ For further information open the online help on the device.
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12.12 PROFINET diagnostics (option)

Display of diagnostic PROFINET information in the main menu under "Diagnostics ->
PROFINET".

12.13 Initialize modem

Initializes the modem connected (to automatically answer calls). The modem must support
the complete AT command syntax.

ﬂ = Set the baud rate in the main menu under "Setup -> Advanced setup ->
Communication -> Serial interface" and select "RS232" as the interface type.
= Connect the modem to the RS232 interface of the device. For this purpose only use
the modem cable, which is available as an accessory.

ﬂ A GSM modem can only be initialized if a SIM card is inserted and the PIN is entered
or the prompt to enter the PIN has been disabled.

12.14 GSM terminal

Information on the reception quality.
Only possible with the "Tele-Alarm" device option.

Detailed descriptions of this device option can be found in the associated
documentation.

12.15 Status telealarm

Information on the status of individual alarms.
ﬂ Only possible with the "Tele-Alarm" device option.

Detailed descriptions of this device option can be found in the associated
documentation.

12.16 Resetting the measuring device

The device can be reset to the as-delivered state with a PRESET. This function should only
be performed by a service technician.

The function can be found in the main menu under "Expert -> System -> PRESET".

ﬂ PRESET is only visible under "Expert" once the service code has been entered.

Procedure for resetting the measuring device

The PRESET returns all parameters to the factory default setup! The internal memory
content is deleted!

» Save the setup and measured values on the USB stick or SD card. Then perform a
PRESET.

= The device is reset to the factory default settings.
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12.17 Firmware history

Overview of unit software history:

Unit software Software FDM analysis Version of OPC server Operating

version/date modification software version Instructions

V02.00.00/08.201 | Original software | V01.03.00.00 and | V5.00.03.00 and higher | BAO01338R/

5 higher 09/01.15

V2.01.00/04.2016 | Extended V01.03.01.00 and | V5.00.03.00 and higher | BA013380/
functionality/bug | higher 09/02.16
fixes

V2.01.05/11.2016 | Extended V01.03.01.01 and | V5.00.03.00 and higher | BA013380/
functionality/bug | higher 09/03.16
fixes

13 Maintenance

No special maintenance work is required for the device.

13.1

Updating the device software ("firmware")

Updating the device software (‘firmware") via USB stick, SD card or Web server.

You can access this function in the main menu under "Operation -> SD card or USB stick -
> Update firmware".

ﬂ It is advisable to save the setup and measured values beforehand on the SD card or

USB stick.

The device software (‘firmware") should only be updated by a service technician.

The device will restart following the firmware update.

ﬂ Only special, approved firmware versions may be installed for the "EtherNet/IP" and
"PROFINET" options. Detailed descriptions of these device options can be found in the
associated documentation.

13.2

Instructions for enabling a software option

Various device options can be enabled via an activation code. Available device options can
be ordered as an accessory . > B 790nce you place your order, you receive instructions
on how to activate the option and a code which you must enter under "Main menu ->
Expert -> System -> Device options -> Activation code".

13.3

Cleaning

The front of the housing can be cleaned with a clean dry or damp cloth.
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14

14.1

Repairs

General notes

Repairs that are not described in these Operating Instructions must only be carried out
directly by the manufacturer or by the service department.

If ordering spare parts, please specify the serial number of the unit! Installation
instructions are included with the spare part.

14.2

Spare parts

ﬂ Accessories and spare parts currently available for your product can be found online
at: www.endress.com/spareparts_consumables - access to specific device
information - enter serial number.

13 Spare parts diagram

Spare parts list:

A0025589

interface cable for PC/modem

Item No. | Description Order No.
1 Power supply 24 V AC/DC for Slot 6 XPRO011-NB
1 Power supply 100-230 V AC (+/-10%) for slot 6 XPROO11-NA
2 Seal housing XPRO0O11-A1
3 Digital board extension (8x digital inputs + 6x relays + 2x analog outputs) | XPRO0O11-A7
for slot 5 (rear panel must also be ordered with the extension)
4 Rear panel analog inputs XPRO011-A2
4 Rear panel analog + digital inputs XPR0O0O11-A3
5 Terminal cover lead sealable XPRO011-A5
6 Analog board (4 channels) for slots 1-5 XPRO0O11-A6
6 HART® card (4 channels) for slots 1-5 XPROO11-A4
7 Jack screw short (1 piece) 71035184
RS232/RS485 adapter set, DIN rail, 230 V AC, galvanic isolation + RSG40A-S6
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Item No. | Description Order No.
RS232/RS485 adapter set, DIN rail, 150 V AC, galvanic isolation + RSG40A-S7
interface cable for PC/modem
SD card 'Industrial Grade" industry standard, 1 GB 71213190

3 Terminals:
Terminal plug 3 pole for mains connection "N L PE' RM5.08 - orange color | 71123475
atslot 6
Terminal plug 3 pole for power supply at slot 6 50078843
Terminal plug-in 3 pole FKC2,5/3-ST-5,08 for relay 1 (changeover) at 71037408
slot 6
Terminal plug-in 4 pole FMC1,5/4-ST-3,5 for digital board extension, slot | 71037350
5 (analog outputs)
Terminal plug-in 10 pole FMC1,5/10-ST-3,5 for digital board extension, | 71037351
slot 5 (digital inputs)
Terminal plug-in 4-pole FKC2.5/4-ST-5.08 for relay 2+3 on slot 6 or 71037410
relay 7+8 / 9+10/ 11+12 onslot 5
Terminal plug-in 6 pole FKC2,5/6-ST-5,08 for relays 4+5+6 at slot 6 71037411
Terminal plug-in 9 pole FMC1,5/9-ST-3,5 for digital inputs at slot 6 71037363
Terminal plug-in 6 pole FMC1,5/6-ST-3,5 for analog input at slots 1-5 51009211

Product structure for option retrofit

Item No. | Description Order code
Option retrofit (please enter the serial number) XPROO12-_
Software:
Without software application XPR0012-0 _
Mathematics XPROO12-B
Tele-Alarm + mathematics XPR0012-C
Batch + mathematics XPRO012-D _ _ _
Wastewater + stormwater overflow tank + Tele-Alarm + mathematics XPROO12-E _
Energy software, water + steam + mathematics XPROO12-F _ _
Tele-Alarm + energy software + water + steam + mathematics XPR0O012-G _
Communication Master functionality:
None XPRO012-_A
Standard + Modbus RTU/TCP master, max. 40 x analog XPR0OO12- B _
Communication Slave functionality:
None XPRO012-_ _ A _
Standard + Modbus RTU/TCP slave, max. 40 x analog XPRO0O12-_ B _
Option:
Standard XPROO12-_ A
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The software option can be enabled directly on the device. After ordering you will
receive instructions and a code that you must enter.

14.3

Return

The measuring device must be returned if it is need of repair or a factory calibration, or if

the wrong measuring device has been delivered or ordered. Legal specifications require

Endress+Hauser, as an ISO-certified company, to follow certain procedures when handling
products that are in contact with the medium.

To ensure safe, swift and professional device returns, please refer to the procedure and

conditions for returning devices provided on the Endress+Hauser website at
http://www.endress.com/support/return-material
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14.4 Disposal

The device contains electronic components and must therefore be disposed of as electronic
waste. Please pay particular attention to the national disposal reqgulations in your country.

78 Endress+Hauser



Memograph M, RSG45 Accessories

15 Accessories

Always quote the serial number of the device when ordering accessories! Installation
instructions are provided with the accessory!

Various accessories, which can be ordered with the device or subsequently from Endress
+Hauser, are available for the device. Detailed information on the order code in question is
available from your local Endress+Hauser sales center or on the product page of the
Endress+Hauser website: www.endress.com.

15.1 Device-specific accessories

Description Order No.

‘Industrial Grade" SD card, industry standard, 1GB 71213190

Field Data Manager analysis software with SQL database support (1 x workstation MS20-Al
license, Professional version)

OPC server software (full version on CD) RX020-11
Description Order No.
Accessories for RXU10 data manager RXU10- _
Designation:
Cable set RS232 for connection to PC or modem RXU10-B _
USB - RS232 converter RXU10-E _
Cable USB-A - USB-B, 1.8 m (5.9 ft) RXU10-F _
Configuration software 'FieldCare Device Setup" + USB cable RXU10-G _
Field housing IP65 RXU10-H _
320 (12.6)
@) ©
@

320 (12.6)

254 (10)

@ ©

A0024766

14  Dimensions in mm (in)
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Description Order No.
Desktop housing, cable with Schuko plug RXU10-T _
Desktop housing, cable with US plug RXU10-] _
Desktop housing, cable with Swiss plug RXU10-K _
293.4 (11.6)
| o ¥
© I
L
Q @
R
= [ ]
184 (7.24)
212.6 (8.37)
il
%
A0024767
15  Dimensions in mm (in)
Version:
Standard RXU10- _1
Neutral RXU10- _2
Description Order No.
Terminal cover lead sealable XPROO11-A5
An optional terminal cover is available to prevent tampering at the device terminals
and terminal temperature measurement.
A0029023
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16 Technical data

16.1 Function and system design

Measuring principle

Electronic acquisition, display, recording, analysis, remote transmission and archiving of
analog and digital input signals as well as calculated values.

The device is intended for installation in a panel or cabinet door. There is also the option of
operating it in a desktop housing or field housing.

Measuring system

Multichannel data recording system with multicolor TFT display (178 mm / 7" screen size),
internal memory, external memory (SD card and USB stick), galvanically isolated universal
inputs (U, [, TC, RTD, pulse, frequency), HART® inputs, digital inputs, transmitter power
supply, limit relays, digital and analog outputs, communication interfaces (USB, Ethernet,
RS232/485), optionally available with Modbus, Profibus DP or PROFINET 1/0 or
EtherNet/IP.

An Essential Version of the Field Data Manager (FDM) software is included for SQL-
supported data analysis at the PC.

The number of inputs available in the basic device can be individually increased using
a maximum of 5 plug-in cards. The device supplies power directly to connected two-
wire transmitters. The device is configured and operated via the navigator (jog/shuttle
dial) or by touchscreen (optional), using the integrated Web server and a PC, or via an
external USB keyboard or mouse or with the FieldCare / DeviceCare configuration
software. Online help supports the user during local operation.

ﬂ Ex version:
= The hazardous area version (Ex version) is only available in conjunction with the
stainless steel front and touch control.
= In this version, the SD card is integrated in the device and cannot be removed. The
card can be read out using the Field Data Manager (FDM) software supplied via USB
or Ethernet, or by WebDAV.

Application packages /
software options

Endress+Hauser

In the standard version, the Advanced Data Manager has a variety of functions, including
an end-to-end safety concept to meet the requirements of FDA 21 CFR Part 11. The
following application packages are available to help users meet the requirements of their
applications and save time:

= Mathematics

= Telealarm

= Batch management

= Wastewater + RSB (rain spillway basin)
= Energy calculation

The application packages contain the standard functions and the specific package
functions. The individual packages can be largely combined as the user requires. The
application packages can also be activated retroactively by entering the activation code.

Standard functions

= Signal analysis: external, 1 min to 12 h, day, week, month, year
= Web server

= User administration compliant with FDA 21 CFR Part 11

= Event log/audit trail

® Process screen

= Operation time counter

= Text entry/comments

= Change language
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= Time synchronization

= Linearization

= Access protection through release code

= E-mail notification in event of alarms and limit violation
= Encrypted e-mail transmission via SSL (TLS)

= Operation via external USB keyboard and mouse

= External USB or network printer

Mathematics

With the mathematics package, measured values of the inputs or the results of other math
channels can be linked mathematically. A formula with up to 200 characters can be
created using a formula editor. Once entered, the user can then check the plausibility of
the formula.

Functions:

® 12 math channels

= Mathematics functions via formula editor

= Basic arithmetic operations, relational operators, logic operations and functions

Telealarm software

The Telealarm software facilitates user mobility, allowing users to respond to events while
they are on the road. E-mails or SMS messages triggered by process alarms or other
important process events can be sent to several recipients simultaneously or automatically
forwarded to a recipient/destination. Messages can be confirmed, relays controlled
remotely and current values queried by cellular phone. The Advanced Data Manager with
GSM (GPRS) or Ethernet is ideal both for environmental applications to monitor unstaffed
outstations, and for tank monitoring applications.

ﬂ The Telealarm software contains the mathematics package.

Functions:

= Advanced SMS/e-mail notification in the event of an alarm
= [nstantaneous values queried by cellular phone

= Remote relay switching

= Alarm confirmation by SMS

Batch software

Batch management allows users to reliably record and visualize discontinuous processes.
User-definable or externally controlled analysis intervals are possible for up to four
batches simultaneously. Batches are assigned batch-specific values and the measured data,
the start, end and duration of every batch, along with the current batch status, are
displayed on the device and in the Field Data Manager software. At the end of the batch, a
batch print-out is automatically started directly at the device (USB or network printer) or is
printed out at a PC with the Field Data Manager software.

ﬂ The batch software contains the mathematics package.

Functions:

= Batch report for 4 batches simultaneously
= USB barcode reader

= Automatic batch printout

= Preset counter

Wastewater + RSB (rain spillway basin)

The water/wastewater software supports operations monitoring of the water/wastewater
sewage network to obtain information about the quality and efficiency of the plant. The
daily, weekly, monthly and yearly maximum and minimum value is determined per
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quantity channel. Infiltration water recording and the monitoring of rain spillway basins
for reservoir and overflow events are also functions of this software option.

ﬂ The water/wastewater software contains the mathematics package and the telealarm
software.

Functions:

= Rain spillway basin (reservoir/overflow)

= Highest and lowest values for quantities

= Highest and lowest values from Ys-hourly averages
s Determination of infiltration water

Energy package (water + steam)

The energy package allows users to calculate the mass and energy flow in water and steam
applications on the basis of the flow, pressure and temperature (or temperature
difference) input variables. Furthermore, energy calculations are also possible using glycol-
based refrigerant media.

By balancing the results against one another or by linking the results to other input
variables (e.g. gas flow, electr. energy), users can calculate overall balances, efficiency
levels etc. These values are important indicators for the quality of the process and form the
basis for process optimization and maintenance.

The internationally recognized standard IAPWS-IF 97 is used to calculate the
thermodynamic state variables of water and steam.

In the energy software, it is also possible to compensate differential pressure flow
measurement ("'DP-Flow"). The calculation of flow based on the differential pressure
method is a special form of flow measurement. Volumes or mass flow rates that are
determined using the DP method require specific correction. By solving the calculation
equations listed in the standard in an iterative manner, highly accurate results for DP flow
measurements can be achieved. The measurement (orifice plate, nozzle, Venturi pipe) is
performed in accordance with ISO5167. Flow measurement based on the dynamic
pressure method uses the interrelation between differential pressure and flow.

ﬂ The energy package contains the mathematics package.

Additional functions:

= 12 math channels
(Channels 1-8: energy-specific formulas and formula editor, channels 9-12: formula
editor)

= Heat quantity + mass calculation for water and steam applications

= Efficiency calculation

Dependability
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Reliability

Depending on the device version, the mean time between failures (MTBF) is between 52
years and 16 years (calculated based on SN29500 standard at 40°C)

Maintainability

Battery-backed time and data memory. It is advisable to have the backup battery replaced
by a service technician after 10 years.

Real time clock (RTC)

= Automatic or manual summer time changeover

= Battery buffer. It is advisable to have the backup battery replaced by a service technician
after 10 years.

» Drift: <10 min/year.

= Time synchronization possible via SNTP or via digital input.
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Standard diagnostic functions as per Namur NE 107

The diagnostic code is made up of the error category as per Namur NE 107 and the
message number.

= Cable open circuit, short-circuit

= [ncorrect wiring

= Internal device errors

= Overrange/underrange detection

= Ambient temperature out-of-range detection

Device error/alarm relay

One relay can be used as an alarm relay. The selected relay switches if the device detects a
system error (e.g. hardware defect) or a malfunction (e.g. cable open circuit).

This "alarm relay" switches if the device status is "F" (Failure). If the device status is "M"
(Maintenance required), the alarm relay does not switch.

Safety

Recorded data are saved in a tamper-proof format and can be exported and archived with
manipulation protection using the Field Data Manager software.

16.2 Input

Measured variables

84

Analog universal inputs

Standard version without universal inputs. Optional multifunction cards (slot 1-5) with 4
universal inputs (4/8/12/16/20) each.

You are free to choose between the following measured variables for each universal input:
U, [, RTD, TC, pulse input or frequency input.

Integration of input variable for totalization e.g. flow (m3/h) in quantity (m3).

HART® inputs

Standard version without HART® inputs. Optional HART® input cards (slot 1-5) with 4
inputs (4/8/12/16/20) each.

Both the digital HART® values and the 4 to 20 mA signal can be evaluated at every input.

The 4 HART® values (PV, SV, TV, QV) of a sensor can be evaluated and the analog HART®
value (PV) can be measured via the digital HART® signal. Up to 40 digital HART® values
can be recorded in total. It is possible to access the HART® sensor in the field from a PC
tool (e.g. FieldCare). In this way, the sensor can be configured from the control room and
the status information of the sensor can be analyzed/displayed. The Memograph M acts as
a HART® Gateway.

ﬂ Access to the connected sensors is only possible if the device is connected by Ethernet.

Port 5094 must be open in the firewall.

Digital inputs
Standard version: 6 digital inputs

Optional digital card (slot 5): 8 additional digital inputs, 6 additional relays and 2 analog
outputs
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Math channels

12 math channels (optional). Mathematics functions can be freely edited via a formula

editor.

Integration of calculated values e.g. for totalization.

Limit values

60 limit values (individual channel assignment)

Calculated values

The values of the universal and HART® inputs can be used to perform calculations in the

math channels.

The results of the math channels can also be used for calculations in other math channels.

Measuring range

User-definable measuring ranges per universal input of the multifunction card:

measured value.

According to I[EC 60873-1: An additional display error of +1 digit is permitted for every

Measured Measuring range Maximum measured error of Input
variable measuring range (oMR), resistance
temperature drift
Current (I) 0to 20 mA; 0 to 20 mA quadratic +0.1% oMR Load: 50 Q
Oto5mA Temperature drift: +0.01%/KoMR | +1Q
410 20 mA; 4 to 20 mA quadratic
+20 mA
Overrange: up to 22 mA or -22 mA
Voltage (U) | 0to 10V; 0 to 10 V quadratic +0.1% oMR >1 MQ
>1V Oto5V Temperature drift: +0.01%/K oMR
1to5V;1to5V quadratic
+10V
+30V
Voltage (U) |0to1V;0to 1V quadratic +0.1% oMR >2.5 MQ
<1V 1V Temperature drift: +0.01%/K oMR
+150 mV
Resistance Pt100: -200 to 850 °C (-328 to 1562 °F) (IEC 60751:2008, 0=0.00385) 4-wire: £0.1% oMR
thermometer | Pt100: -200 to 510 °C (-328 to 950 °F) (JIS C 1604:1984, 0=0.003916) 3-wire: £(0.1% oMR + 0.8 K)
(RTD) Pt100: -200 to 850 °C (-328 to 1562 °F) (GOST 6651-94, a=0.00391) 2-wire: £(0.1% oMR + 1.5 K)
Pt500: -200 to 850 °C (-328 to 1562 °F) (IEC 60751:2008, a=0.00385) Temperature drift: +0.01%/K oMR
Pt500: -200 to 510 °C (-328 to 950 °F) (JIS C 1604:1984, 0=0.003916)
Pt1000: -200 to 600 °C (-328to 1112 °F) (IEC 60751:2008, 0=0.00385)
Pt1000: -200 to 510 °C (-328 to 950 °F) (JIS C 1604:1984, 0=0.003916)
Cu50: -50 to 200 °C (-58 to 392 °F) (GOST 6651-94, a=4260) 4-wire: +0.2% oMR
Cu50:-200 to 200 °C (-328 to 392 °F) (GOST 6651-94, 0=4280) 3-wire: £(0.2% oMR + 0.8 K)
Pt50:-200 to 1100 °C (-328 to 2012 °F) (GOST 6651-94, a=0.00391) 2-wire: £(0.2% oMR + 1.5 K)
Cul00:-200 to 200 °C (-328 to 392 °F) (GOST 6651-94, 0=4280) Temperature drift: +0.02%/K oMR
Pt46:-200 to 1100 °C (-328 to 2012 °F) (GOST 6651-94, a=0.00391) 4-wire: £0.3% oMR
Cu53:-200to 200 °C (-328 to 392 °F) (GOST 6651-94, a=4280) 3-wire: £(0.3% oMR + 0.8 K)
2-wire: £(0.3% oMR + 1.5 K)
Temperature drift: +0.02%/K oMR
Thermocoupl | Type J (Fe-CuNi): -210 to 1200 °C (-346 to 2192 °F) (IEC 60584:2013) +0.1% oMR from -100 °C (-148 °F) | >1 MQ
es (TC) Type K (NiCr-Ni): -270 to 1300 °C (-454 to 2372 °F) (IEC 60584:2013) +0.1% oMR from -130 °C (-202 °F)
Type L (NiCr-CuNi): -200 to 800 °C (-328 to 1472 °F) (GOST R8.585:2001) +0.1% oMR from -100 °C (-148 °F)
Type L (Fe-CuNi): -200 to 900 °C (-328 to 1652 °F) (DIN 43710-1985) +0.1% oMR from -100 °C (-148 °F)
Type N (NiCrSi-NiSi): -270 to 1300 °C (-454 to 2372 °F) (IEC 60584:2013) +0.1% oMR from -100 °C (-148 °F)
Type T (Cu-CuNi): -270 to 400 °C (-454 to 752 °F) (IEC 60584:2013) +0.1% oMR from -200 °C (-328 °F)
Temperature drift: +0.01%/K oMR
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Measured Measuring range Maximum measured error of Input
variable measuring range (oMR), resistance
temperature drift
Type A (W5Re-W20Re): 0 to 2500 °C (32 to 4532 °F) (ASTME 988-96) +0.15% oMR from 500 °C (932 °F) | >1 MQ
Type B (Pt30Rh-Pt6Rh): 42 to 1820 °C (107.6 to 3308 °F) (IEC 60584:2013) +0.15% oMR from 600 °C (1112 °F)
Type C (W5Re-W26Re): 0 to 2315 °C (32 to 4199 °F) (ASTME 988-96) +0.15% oMR from 500 °C (932 °F)
Type D (W3Re-W25Re): 0 to 2315 °C (32 to 4199 °F) (ASTME 988-96) +0.15% oMR from 500 °C (932 °F)
Type R (Pt13Rh-Pt): -50 to 1768 °C (-58 to 3214 °F) (IEC 60584:2013) +0.15% oMR from 100 °C (212 °F)
Type S (Pt10Rh-Pt): -50 to 1768 °C (-58 to 3214 °F) (IEC 60584:2013) +0.15% oMR from 100 °C (212 °F)
Temperature drift: +0.01%/K oMR
Pulse input | Min. Pulse length 40 ps, max. 12.5 kHz; 0 to 7 mA = LOW; 13 to 20 mA = HIGH Load: 50 Q
K +1Q
Frequency 0 to 10 kHz, overrange: up to 12.5 kHz; 0 to 7 mA = LOW; 13 to 20 mA = HIGH | £0.02% @ f <100 Hz of reading
input (1) Y +0.01% @ f >100 Hz of reading
Temperature drift: 0.01% of
measured value over the entire
temperature range

1) If a universal input is used as a frequency or pulse input, a series resistor must be used in series connection with the voltage source. Example: 1.2
kQ series resistor at 24 V

Current measuring range of the HART® card:

Measured Measuring range Maximum measured error of Input
variable measuring range (oMR), impedance
temperature drift
Current (I) 4to 20 mA +0.1% oMR Load: 10 Q
Overrange: up to 22 mA Temperature drift: +0.01%/K oMR +1Q

Maximum load and additional input parameters of the multifunction cards

Limit values for input voltage and current as well as cable open circuit detection/line influence/temperature compensation:

Measured variable

Limit values (steady-state, without
destroying input)

Cable open circuit detection/line influence/temperature compensation

Current (I)

Maximum permitted input voltage: 2.5 V
Maximum permitted input current: 50 mA

4 to 20 mA range with disengageable cable open circuit monitoring to NAMUR
NE43. The following error ranges apply when NAMUR NE43 monitoring is
switched on:

<3.8 mA: underrange

>20.5 mA: overrange

< 3.6 mA or > 21.0 mA: open circuit (display shows: - - - -)

Pulse, frequency (I)

Maximum permitted input voltage: 2.5V
Maximum permitted input current: 50 mA

No cable open circuit monitoring

Voltage (U) >1V

Maximum permitted input voltage: 35V

1 to 5 V range with disengageable cable open circuit monitoring:
<0.8 V or >5.2 V: cable open circuit (display shows: - - - -)

Voltage (U) <1V

Maximum permitted input voltage: 24 V

Resistance
thermometer (RTD)

Measuring current: <1 mA

Maximum barrier resistance (or line resistance):

4-wire: max. 200 Q; 3-wire: max. 40 Q

Maximum influence of barrier resistance (or line resistance) for Pt100, Pt500
and Pt1000: 4-wire: 2 ppm/Q, 3-wire: 20 ppm/Q

Maximum influence of barrier resistance (or line resistance) for Pt46, Pt50,
Cu50, Cu53, Cul00 and Cu500: 4-wire: 6 ppm/Q, 3-wire: 60 ppm/Q

Cable open circuit monitoring if any connection is interrupted.

Thermocouples (TC)

Maximum permitted input voltage: 24 V

Influence of line resistance: <0.001%/Q
Error, internal temperature compensation: < 2 K
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Maximum load and additional input parameters of the HART® cards

Limit values for input voltage and current as well as cable open circuit detection:

Measured variable | Limit values (steady-state, without Cable open circuit detection
destroying input)

Current (1) Maximum permitted input voltage: 0.5 V 4 to 20 mA range with disengageable cable open circuit monitoring to NAMUR
Maximum permitted input current: 50 mA NE43. The following error ranges apply when NAMUR NE43 monitoring is

switched on:

<3.8 mA: underrange

>20.5 mA: overrange

< 3.6 mA or > 21.0 mA: open circuit (display shows: - - - -)

Scan rate
Current/voltage/pulse/frequency input: 100 ms per channel

Thermocouples and resistance temperature detector: 1 s per channel

Data storage / memory cycle

Choose from the following for the memory cycle: off / 100 ms / 1s/ 2s / 3s / 4s / 5s/
10s/ 15s/ 20s / 30s / 1min / 2min / 3min / 4min / 5min / 10min / 15min / 30min / 1h

ﬂ Highspeed storage (100 ms) can be selected for up to 8 channels in Group 1 only.

Highspeed storage is not available in the energy package (option).

Typical recording length

Prerequisites for following tables:

= No limit value violation / integration

= Digital input not used

= Signal analysis 1: off, 2: day, 3: month, 4: year
= No active math channels

ﬂ Frequent entries in the event log reduce the memory availability!

256 MB internal memory:

Analog Channels in groups Storage cycle (weeks, days, hours)

inputs 5 min 1 min 30s 10s 1s

1 1/0/0/0/0/0/0/0/0/0 | 1796, 6, 13 362, 5,17 181, 4,9 60, 4, 3 6,0, 10
4 4/0/0/0/0/0/0/0/0/0 | 1319, 2,23 267,5,17 134,1,2 44,5, 10 4,3,8

8 4/4/0/0/0/0/0/0/0/0 | 661, 4,3 133,6,21 67,0, 16 22,2,17 2,1, 16
12 4/4/4/0/0/0/0/0/0/0 | 441,3,8 89,2,9 44,53 14,6,11 1,3,10
20 4/4/4/4/4/0/0/0/0/0 | 265, 0, 15 53,4,7 26,5,21 8,6, 16 0,6,6
40 4/4/4/4/4/4/4/4/4/4 | 132, 4,8 26,5,16 13,2,23 4,3,8 0,3,3
External memory, 1 GB SD card:

Analog Channels in groups Storage cycle (weeks, days, hours)

inputs 5 min 1 min 30s 10s 1s

1 1/0/0/0/0/0/0/0/0/0 | 12825, 5, 20 2580, 4, 18 1291,2,5 430, 4, 14 43,0, 12
4 4/0/0/0/0/0/0/0/0/0 | 8672,5, 12 1749, 6, 13 875, 6, 13 292,1,8 29,1, 14
8 4/4/0/0/0/0/0/0/0/0 | 4343,1,1 875,1,17 438,0, 6 146, 0, 17 14, 4,7
12 4/4/4/0/0/0/0/0/0/0 | 2896, 6, 13 583, 3,21 292,0,6 97,2,20 9,54
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Analog Channels in groups Storage cycle (weeks, days, hours)
inputs N .
5 min 1 min 30s 10s 1s
20 4/4/4/4/4/0/0/0/0/0 | 1738,6, 4 350, 1,3 175,1, 14 58,3, 2 5,5,22
40 4/4/4/4/4/4/4/4/4/4 | 869, 5,0 175, 0, 15 87, 4,7 29,1,13 2,6,11

ﬂ The available storage capacity of the internal and external memory can be displayed
in the main menu under "Diagnostics - Device information - Memory
information". The storage capacity depends on the specific device set-up.

Converter resolution
24 bit

Totalization

The interim value, daily value, weekly value, monthly value, annual value and overall value
can be determined (13-digit, 64 bit).

Analysis

Recording of quantity/operating time (standard function), also a min/max/median
analysis within the set time frame.

Digital inputs

Input level Logical "0" (corresponds to -3 to +5 V), activation with logical "1" (corresponds to
+12 to +30V)

Input frequency max. 25 Hz

Pulse length Min. 20 ms (pulse counter)

Pulse length Min. 100 ms (control input, messages, operating time)

Input current max. 2 mA

Input voltage Max. 30V

Selectable functions

= Functions of the digital input: control input, ON/OFF message, pulse counter (13-digit,
64-bit), operating time, message+operating time, quantity from time, Profibus DP,
EtherNet/IP, PROFINET.

= Functions of the control input: start recording, screensaver on, lock setup, time
synchronization, change group, limit value monitoring on/off, individual LV on/off,
block keyboard/navigator, start/stop analysis.

Additionally for the batch software option: reset batch number, batch limit values on/
off.

16.3 Output

Auxiliary voltage output

88

The auxiliary voltage output can be used for loop power supply or to control the digital
inputs. The auxiliary voltage is short-circuit proof and galvanically isolated.

Output voltage 24 Vpe £15%

Output current Max. 250 mA
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Analog and pulse outputs

Number

Optional digital card (slot 5): 2 analog outputs which can be operated as current or pulse
outputs.

Analog output (current output)

Output current: 0/4 to 20 mA with 10% overrange

Max. output voltage: approx. 16 V

Accuracy: <0.1% of end of range value

Temperature drift: <0.015%/K of end of range value

Resolution: 13 Bit

Load: 0 to 500 Q

Error signal as per NAMUR NE43: 3.6 mA or 21 mA can be configured

Digital output (pulse output)
Output voltage:

<5V corresponds to LOW
>12 V corresponds to HIGH

Short-circuit proof (maximum 25 mA)

Speed: max. 1000 pulses/s
Pulse width: 0.5 to 1000 ms
ﬂ The pulse pause is at least as long as the pulse width.

Load: >1 kQ

Relay outputs

Endress+Hauser

A mix of low voltage (230 V) and safety extra low voltage (SELV circuits) is not permitted
at the connections of the relay contacts.

Alarm relay

1 alarm relay with changeover contact.

Standard relay

5 relays with NO contact, e.qg. for limit value messages (can be configured as NC contact).

Optional relays

Optional digital card (slot 5): 6 additional relays with NO contact e.g. for limit value alarms
(can be configured as an NC contact).

Relay switching capacity

= Max. relay switching capacity: 3 A @ 30 VDC
= Max. relay switching capacity: 3 A @ 250 V AC
= Min. switching load: 300 mW

Switching cycles
>10°
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Galvanic isolation

All inputs and outputs are galvanically isolated from each other and designed for the
following test voltages:

Relay | Digital | Analog | Analog | Ethern | RS232/ | USB Auxiliary voltage output
in in/ out et RS485
HART®
Relay 500 2 kVDC 2 kVDC 2 kVDC 2 kVDC 2 kVDC 2 kVDC 2 kVDC
Vnc

Ve Ve Vnc Vnc

but: Y
Analog 2 kVDC 500 500 500 500 500 VDC 500 VDC 500 VDC
in/HART® Vpe Ve Ve Ve
Analog 2 kVDC 500 500 500 500 500 VDC 500 VDC 500 VDC
out Ve Ve Vie Ve
Ethernet |2 kVpc | 500 500 500 - 500 Vpe | 500 Vpe 500 Vpc
Vnc Ve Ve
RS232/ 2 kVpe | 500 500 500 500 - 500 Vpc 500 Vpc
USB 2 kVpe | 500 500 500 500 500 Vp¢ | Galvanicall | 500 Vpc
Ve Ve Ve Ve y
connected

Auxiliary |2kVpe (500 [500  |500 |500 | 500Vpe |500Vpe |-

VOltage VDC VDC VDC VDC
output
1) Test voltage applies between inputs on power unit (terminals D11 to D61) to inputs on optional digital

card (terminals D71 to DE1). The inputs are galvanically connected on the same plug-in connector.

Cable specification

90

Cable specification, spring terminals

All connections on the rear of the device are designed as pluggable screw or spring
terminal blocks with reverse polarity protection. This makes the connection very quick and
easy. The spring terminals are unlocked with a slotted screwdriver (size Q).

Please note the following when connecting:

= Wire cross-section, auxiliary voltage output, digital I/0 and analog I/0: max. 1.5 mm?
(14 AWG) (spring terminals)

= Wire cross-section, mains: max. 2.5 mm? (13 AWG) (screw terminals)

= Wire cross-section, relays: max. 2.5 mm? (13 AWG) (spring terminals)

= Stripping length: 10 mm (0.39 in)

ﬂ No ferrules must be used when connecting flexible wires to spring terminals.

Shielding and grounding

Optimum electromagnetic compatibility (EMC) can only be guaranteed if the system
components and, in particular, the lines - both sensor lines and communication lines - are
shielded and the shield forms as complete a cover as possible. A shielded line must be used
for sensor lines that are longer than 30 m. A shield coverage of 90% is ideal. In addition,
make sure not to cross sensor lines and communication lines when routing them. Connect
the shield as often as possible to the reference ground to ensure optimum EMC protection
for the different communication protocols and the connected sensors.

To comply with requirements, three different types of shielding are possible:

= Shielding at both ends

= Shielding at one end on the supply side with capacitance termination at the device
= Shielding at one end on the supply side

Experience shows that the best results with regard to EMC are achieved in most cases in
installations with one-sided shielding on the supply side (without capacitance termination
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at the device). Appropriate internal device wiring measures must be taken to allow
unrestricted operation when EMC interference is present. These measures have been
taken into account for this device. Operation in the event of disturbance variables as per
NAMUR NE21 is thus guaranteed.

Where applicable, national installation regulations and guidelines must be observed
during the installation! Where there are large differences in potential between the
individual grounding points, only one point of the shielding is connected directly with the
reference ground.

ﬂ If the shielding of the cable is grounded at more than one point in systems without
potential matching, mains frequency equalizing currents can occur. These can damage
the signal cable or significantly impact signal transmission. In such cases the shielding
of the signal cable is to be grounded on one side only, i.e. it may not be connected to
the ground terminal of the housing. The shield that is not connected should be
insulated!

16.4 Power supply

Terminals on back of device

@
+ LW
4 Z 0o
600 6
A6 A]|
H_IHH_IHH_IHH_IH7H_IHH_IHH_IHH_H\iH_HHl_lHH_lHH_lH
< o O QO wuw O T - o X 4 5
rr&er Xoaer o
4
3
2
1
Ly
|prTe 0
= —
Ethernet usB RS 232/RS 485 Bus Interface

A0024605

6  Terminals on back of device

1
6  Slot 6: Power supply with relays

5 Slot 5: Multifunction card or HART® card (channels 17-20) or digital card
4 Slot 4: Multifunction card or HART® card (channels 13-16)

3 Slot 3: Multifunction card or HART® card (channels 9-12)

2 Slot 2: Multifunction card or HART® card (channels 5-8)

1 Slot 1: Multifunction card or HART® card (channels 1-4)

0  Slot 0: CPU card with interfaces

Supply voltage

= Extra-low voltage power supply unit +24 V AC/DC (-10% / +15%) 50/60Hz
= Low voltage power supply unit 100 to 230 V AC (£10%) 50/60Hz

ﬂ Overcurrent protection (rated current < 10 A) must be installed for the power cable.

Power consumption
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= 100 to 230 V: max. 40 VA
s 24 V:max. 30 VA
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The power actually consumed depends on the individual operating state and the device
version (LPS, USB, brightness of screen, number of channels, etc). The active power here is

approx. 3 Wto 25 W.

Power supply failure

Battery-backed time and data memory. The device starts automatically following a power

failure.

Electrical connection

Details about the electrical connection: > 16

Electrical connection,
terminal assignment

92

Circuit diagram
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e P~ B i R
D 777777777 I J,l Termination
RL | [ T | 1 DR:resAstor
: | s ! ! Lo 7 (typical 120 Q) RS 485
777777777 L S Sl Sl S it £ S
| l ' % RXD/TxD/(+)
| RxD/TxD(-)
| Further units
|
|
! 12-24 VDC Digital in (D)
! >5mA igital in
} Analog +7 v
| Power supply outputs (0) oNDx aNDx
| 100-230 VAC | 24V AC/DC (Selectable in unit setup)
| (£10%) | (-10%; +15%) 12 o x -
! 50/60Hz | 50/60Hz Pulse + S g Dxl Dxl
| L+ N-PE@ L ‘ ‘ ‘ ‘ 12-24'VDC
| ~—
| 10Kk] I +
|
} D + 24V +
I g
| g
|
|
|
| T
|
} 24V Out: max. 250 mA
|
|
; Slot 6: Power supply slot (standard)
! ARAA [FAAA [AAAR
} g oo
| = 5
; FBEEEEEEEEEEE Slot 5: analog input / HART 17-20 or digital-1/0 (option)
RS 232 |
| Slot 4: analog input / HART 13-16 (option)
o] Bl
To modem: Cable with
6 \? Slot 3: analog input / HART 9-12 (option
9 pol. Sub-D socket @1 ° 39 9P (option)
0% b o Slot 2: analog input / HART 5-8 (option)
|
| Slot 1: analog input / HART 1-4 (option)
|
|
|
‘ [ ]
Il
To PC: Cable with P 5 Slot 0: CPU (standard)
9 pol. Sub-D plug O (S5yae) @ | Etvemst
RxD-3  GND-5 —= 558‘9
B ]
|
- .
Analog inputs
XL x2 x3 x4 X5 x6 x1 X2 x3 x4 x5 x6 XL x2 x3 x4 X5 x6
Pt46, Pt50, Pt100,
o 9 o Pt500, Pt1000,
RTD Cu50, Cu53, Cul00
* 0..20mA, 4..20 mA, 0..5 mA, £20 mA
I (Volt drop <1V, R, £50 Ohm)
x1 x2 x3 x4 x5 x6 -
a)>1V b) <1V
¥ rn a)0..5V,1..5V,0..10V, £10 V, £30 V
U b) 0.1V, +150 mV, 1V
+
TC A,B,CD,J,KLNTRS
XL x2 x3 x4 x5 x6
24V L
{Re12K] - j‘o—“\i
I + I
Pulse/ LOW = 0..7 mA
frequency vl o HIGH = 13..20 mA
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17  For connection examples of the HART® inputs (optional), see the Operating Instructions > B 23
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Supply voltage (power unit, slot 6)

Power unit type Terminal
R
JZ2a 92
(1 4 4
‘ ‘L oo o
BEH| |55 5
A0019103
100-230 VAC L+ N- PE
Phase L Zero conductor N Ground
24V AC/DC L+ N- PE
Phase L or + Zero conductor N or - Ground

Relay (power unit, slot 6)

Type Terminal (max. 250V, 3 A)
sl Ldd Lhld Lardly
“hFrx BOBF ZEREEE
‘ ‘LDDD oooo [oooooao
HEB| [5538][5533]|555555
A0019103
Alarmrelay1 |R11 R12 R13
Changeover Normally Normally open
contact closed contact | contact (NO) %
(Ney Y
Relay 2 to 6 Rx1 Rx2
Switching contact | Normally open
contact (NO )

1) NC = normally closed (breaker)
2) NO = normally open (maker)

ﬂ The open or close function (= activation or deactivation of the relay coil) in a limit
event can be configured in the setup: "Setup -> Advanced setup -> Outputs -> Relay ->
Relay x". However, in the event of a power failure, the relay adopts its quiescent switch
state regardless of the setting programmed.

Digital inputs; auxiliary voltage output (power unit, slot 6)

Type Terminal

e @MY

22
[ I
E]E]N

Digital input | D11 to D61 GND1
1to6

o| R11
p| R12
p| R13

@i}
on
on

A0019103

Digital input 1 to 6 (+) | Ground (-) for digital
inputs 1 to 6
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Type Terminal
R
JZo0 -9 ¢Q
X o o
‘ ‘LDDD
BEQ)| (555

A0019103

Auxiliary 24V Out - 24V Out +
voltage

output, not - Ground + 24V (£15%)
stabilized,

max. 250 mA

ﬂ If the auxiliary voltage is to be used for the digital inputs, the 24 V out - terminal of

the auxiliary voltage output must be connected with the GND1 terminal.

Analog inputs (slot 1-5)

The first digit (x) of the two-digit terminal number corresponds to the associated channel:

Type

Terminal

Lo
EE%%
O

50000

x6|0

A0019303

x1 X2

x3

x4

x5

Current/pulse/frequency
input b

Voltage > 1V

Voltage < 1V

(+)

Resistance thermometer
RTD (2-wire)

Resistance thermometer
RTD (3-wire)

b (sense)

Resistance thermometer
RTD (4-wire)

a (sense)

b (sense)

Thermocouples TC

(+)

()

1)

If a universal input is used as a frequency or pulse input, a series resistor must be used in series connection
with the voltage source. Example: 1.2 kQ series resistor at 24 V
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HART® inputs (slot 1-5)

The first digit (x) of the two-digit terminal number corresponds to the associated channel:

Type Terminal
9 | |
S ====== 1 _ 2500 100 |
9000000 ' T j
— N M N O NN I N O
I MoK M X X X
A0024862
x1 X2 x3 x4 x5 X6
HART® (4 to 20 mA) SHD H 1 H 2 Reom I+ I-

= A 250 Q communication resistor (load) is installed on the device side between
terminals x4 and x5.

= A 10 Q resistor (shunt) is installed on the device side at the current input between
terminals x5 and x6.

= Terminals x2 and x3 (H_1 and H_2) are jumpered internally.

» The internal HART® modem is located between terminals x2/x3 and x6.

Relay extension (digital card, slot 5)

Type Terminal (max. 250V, 3 A)
AAAA[AAAAI[EAAA]
_l_ﬂﬂl_ﬂﬂl_ﬂﬂl_ﬂ Il | ) | o o | L[]
000
ERER BEREZ 72
A0024736
Relay 7, 8 RA RB RC RD
Relay 9, 10 RE RF RG RH
Relay 11, 12 RI RJ RK RL
Switching contact | Normally open Switching contact | Normally open contact
contact (V) R
1) NO)
2) NO)

The open or close function (= activation or deactivation of the relay coil) in a limit

event can be configured in the setup: "Setup -> Advanced setup -> Outputs -> Relay ->
Relay x". However, in the event of a power failure, the relay adopts its quiescent switch
state regardless of the setting programmed.

Analog outputs (digital card, slot 5)

Type

Terminal

ARAARAIAAEA A

06006600

émUD ww O T
X x o X o o o«

A0024736

Analog
output 1-2

015 016 025

026

Analog output 1 (+) | Ground, analog output

1()

Analog output 2 (+)

Ground, analog output
2(-)
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Extension of digital inputs (digital card, slot 5)

Type Terminal
aNaNaNallaNaNaNal]
QOOOOOQO]]
ERER BERz
A0024736
Digital input 7 to | D71 to DE1 GND2 GND2
14

Digital input 7 to 14 (+)

Ground (-) for digital inputs 7
to 14

Ground (-) for digital inputs 7
to 14

If the auxiliary voltage is to be used for the digital inputs, the 24 V out - terminal of
the auxiliary voltage output (power unit, slot 6) must be connected with the GND2
terminal.

Connector

= Panel-mounted device: connected to mains via plug-in screw terminals with reverse
polarity protection
= Desktop version (option): connected to mains via IEC connector

Overvoltage protection

To avoid high-energy transients on long signal cables, connect a suitable surge arrester
upstream (e.g. EYH HAW562) in series upstream.

Connection data interface,
communication

Endress+Hauser

USB interfaces:

1 x USB port type A (host) on the front of device (only for version with navigator and front
interfaces)

A USB 2.0 port is available on a shielded USB A socket at the front of the device. A USB
stick as a memory medium, for example, can be connected to this port. An external
keyboard/mouse for device operation, a USB hub, a barcode reader or a printer (PCL5c or
higher) may also be connected.

1 x USB port type B (function) on the front of device (only for version with navigator and
front interfaces)

A USB 2.0 port is available on a shielded USB B socket at the front of the device. This can
be used to connect the device for communication with a laptop, for example.

2 x USB port type A (host) on the rear of the device (standard)

Two USB 2.0 ports are available on shielded USB A sockets at the rear of the device. A USB
stick as a memory medium, for example, can be connected to these ports. An external
keyboard/mouse for device operation, a USB hub, a barcode reader or a printer (PCL5c or
higher) may also be connected.

ﬂ = USB-2.0 is compatible with USB-1.1 or USB-3.0, i.e. communication is possible.

= The assignment of the USB interfaces complies with the standard such that shielded
standard cables with a maximum length of 3 meters (9.8 ft) can be used here.

= The USB devices are detected by the "plug-and-play" function. If several devices of
the same type are connected, only the USB device that was connected first is
available.

= A maximum of 8 external USB devices (incl. USB hub) can be connected if they do
not exceed the maximum load of 500 mA. If overloaded, the corresponding USB
devices are automatically disabled. An active USB hub can be used for higher power
ratings.
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Reference list for USB printers:
HP Color Laser]Jet CP1515n, HP Color LaserJet Pro CP1525n, ECOSYS P602 1cdn.

ﬂ The printer must support PCL5c (or higher). GDI printers are not supported!

Reference list for USB barcode readers:
Datalogic Gryphon D230; Metrologic MS5100 Eclipse Series; Symbol LS2208, Datalogic
Quickscan 1, Godex GS220, Honeywell Voyager 9590.

Ethernet interface (standard):

Ethernet interface on back, 10/100 Base-T, plug type RJ45. The Ethernet interface can be
used to integrate the device via a hub or switch into a PC network (TCP/ IP Ethernet). A
standard patch cable (e.g. CAT5E) can be used for the connection. Using DHCP, the device
can be fully integrated into an existing network without the need for additional
configuration. The device can be accessed from every PC in the network. Normally only the
automatic assignment of the IP address must be configured at the client. When the device
is started, it can automatically retrieve the IP address, subnet mask and gateway from a
DHCP server. If a DHCP is not used (depending on the specific network) these settings
must be made directly in the device. Two Ethernet function LEDs are located on the rear of
the device.

The following functions are implemented:

= Data communication with PC software (analysis software, configuration software, OPC
server)

= Web server

= WebDAV (Web-based Distributed Authoring and Versioning) is an open standard for
the provisioning of files via the HTTP protocol. The data saved on the device's SD card
can be read out using a PC. A web browser or dedicated WebDAYV client can be selected
as network drive on the PC for this purpose.

Requirements with regard to a network printer

Network printer reference list:
HP Color LaserJet CP1515n, HP Color Laser]et Pro CP1525n, ECOSYS P602 1cdn

ﬂ The printer must support PCL5c (or higher). GDI printers are not supported!

Ethernet Modbus TCP master (option):

As a Modbus master, the device can interrogate other Modbus slaves via Ethernet. The
Modbus TCP master can be operated in parallel with the Profibus DP slave, Modbus
RTU/TCP slave or PROFINET I/0 Device.

Up to 40 analog inputs can be transmitted via Modbus and stored in the device.

Ethernet Modbus TCP slave (option):
Connection to SCADA systems (Modbus master).

Up to 40 analog inputs and 20 (14 real + 6 virtual) digital inputs can be transmitted via
Modbus and stored in the device.

Serial RS232/RS485 interface:

A combined RS232/RS485 connection is available on a shielded SUB D9 socket at the rear
of the device. This can be used for data transfer and to connect a modem. For
communication via modem, we recommend an industrial modem with a watchdog
function.
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s The following baud rates are supported: 9600, 19200, 38400, 57600, 115200
= Max. cable length with a shielded cable: 2 m (6.6 ft) (RS232), or 1000 m (3281 ft)
(RS485)

ﬂ Only one interface can be used at any one time (RS232 or RS485).

Modbus RTU master (option):

As a Modbus master, the device can interrogate other Modbus slaves via RS485. The
Modbus RTU master can be operated in parallel with the Profibus-DP slave, PROFINET I/0
Device or Modbus TCP slave.

Up to 40 analog inputs can be transmitted via Modbus and stored in the device.

Modbus RTU slave (option):
The device can be interrogated as a Modbus slave by another Modbus master via RS485.

Up to 40 analog inputs and 20 (14 real + 6 virtual) digital inputs can be transmitted via
Modbus and stored in the device.

ﬂ A Modbus RTU master and RTU slave cannot be operated in parallel.

Remote interrogation with analog or GSM/GPRS wireless modem:

Analog modem:

An analog modem for industrial use (e.g. Devolo or WESTERMO), which is connected to
the RS232 interface with a special modem cable (see Accessories ), is

recommended.»> B 79

GSM/GPRS wireless modem:

A GSM/GPRS wireless modem (e.g. Cinterion, INSYS or WESTERMO, incl. antenna and
power unit) for industrial use, which is connected to the RS232 interface with a special
modem cable (see Accessories), is recommended. - 79

Important: the wireless modem needs a SIM card and data transfer subscription. In
addition, it must be possible to deactivate the PIN prompt.

AnyBus® interface (CPU card, slot 0, optional)
PROFIBUS-DP slave:

The device can be integrated into a fieldbus system as per the PROFIBUS-DP standard by
means of the PROFIBUS-DP interface. Up to 40 analog inputs and 20 (14 real + 6 virtual)
digital inputs can be transmitted via PROFIBUS-DP and stored in the device. Bidirectional
communication with cyclic data transfer is possible. Connection via Sub-D socket.

Baud rate: maximum 12 Mbit/s.

EtherNet/IP adapter (slave):

Up to 40 analog inputs and 20 (14 real + 6 virtual) digital inputs can be transmitted via
EtherNet/IP and stored in the device. The built-in module corresponds to I/0 server
category (Level 2). It has an integrated 2-port switch, thereby supporting EtherNet/IP
communication in line or ring topologies. Connection via 2 RJ45 standard sockets.

PROFINET 1/0 device:

Up to 40 analog inputs and 20 (14 real + 6 virtual) digital inputs can be transmitted via
PROFINET IO and stored in the device. The 2-port module for PROFINET 10 meets
compliance class B. The integrated switch enables communication in line or ring topologies
without an additional external switch. Connection via 2 RJ45 standard sockets.
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16.5 Performance characteristics

Response time

Input Output Time [ms]
Current, voltage, pulse Relays, OC, analog output <550

RTD Relays, OC, analog output <1150

TCV Relays, OC, analog output <1550

Cable open circuit detection, current input Relays, OC, analog output <1150

Sensor error RTD, TC Relays, OC, analog output <5000

Digital input Relays, OC, analog output <350

HART® input Relays, OC, analog output Non-deterministic
1) If internal measuring point temperature compensation is used, otherwise values as for voltage

Reference operating

Reference temperature 25°C (77 °F) 5K

conditions - -

Warm-up period 120 min.

Humidity 20 to 60 % rel. humidity
Hysteresis Can be configured for limit values in the setup

Long-term drift

As per IEC 61298-2: max. £0.1%/year (of measuring range)

16.6 Installation

Panel mounting: mounting
location and installation
dimensions

100

The device is designed for use in a panel.

ﬂ The device must be installed in a pressurized enclosure system for operation in the
hazardous area. To ensure safe installation, it is essential to follow the installation
instructions for the cabinet and the installation instructions in the Ex-related Safety
Instructions (XA).
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18  Panel mounting and dimensions in mm (in).

A Version with navigator and front interfaces
B Version with stainless steel front and touchscreen
C  Grid dimensions of panel cutouts for multiple devices

Installation dimensions

= [nstallation depth (excluding terminal cover): approx. 159 mm (6.26 in) for device incl.
terminals and fastening clips.

= [nstallation depth including terminal cover (option): approx.198 mm (7.8 in)

= Panel cutout: 138 to 139 mm (5.43 to 5.47 in) x 138 to 139 mm (5.43 to 5.47 in)

= Panel thickness: 2 to 40 mm (0.08 to 1.58 in)

= viewing angle range: 50° in all directions from the display central axis

= A minimum distance of 12 mm (0.47 in) between the devices must be observed if
aligning the devices vertically above one another or horizontally beside one another.

s The grid dimension of the panel cutouts for multiple devices must be at least
208 mm (8.19 in) horizontally and at least 162 mm (6.38 in) vertically (tolerance not
considered).

s Securing to DIN 43 834

Field housing assembly and
design (optional)

Endress+Hauser

As an option, the device can be ordered ready-mounted in a field housing with IP65.

Dimensions (B x H x D) approx.: 320 mm (12.6 in) x 320 mm (12.6 in) x 254 mm (10 in)
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Desktop housing assembly
and design (optional)

As an option, the device can be ordered ready-mounted in a desktop housing.

Dimensions (B x H x D) approx.: 293 mm (11.5 in) x 188 mm (7.4 in) x 213 mm (8.39 in)
(dimensions with bracket, feet and installed device)

16.7 Environment

Ambient temperature
range

-10to +50°C (14 to 122 °F)

Storage temperature

-20to +60 °C (-4 to +140 °F)

Humidity

5 to 85 %, not condensating

Climate class

To IEC 60654-1: Class B2

Electrical safety Class I equipment, overvoltage category II
Pollution level 2
Altitude <2000 m (6561 ft) above MSL

Degree of protection

Front IP65 / NEMA 4 (not assessed by UL)

Rear P20

Electromagnetic
compatibility

EMC to all relevant requirements of the I[EC/EN 61326- series and NAMUR NE21. For
details see declaration of conformity.

= Interference immunity: as per IEC/EN 61326 series (industrial environment) / NAMUR
NE21

Maximum measured error <1% of measuring range
= Interference emissions: as per [IEC 61326-1 Class A

16.8 Mechanical construction

Design, dimensions

Information about design and dimensions > & 100

Weight = Panel-mounted device with navigator and front interfaces (with maximum
configuration): approx. 2.7 kg (5.9 lbs)
= Panel-mounted device with stainless steel front and touchscreen (with maximum
configuration): approx. 3.2 kg (7 lbs)
= Desktop housing (excluding device): approx. 2.3 kg (5 lbs)
= Field housing (excluding device): approx. 4 kg (8.8 lbs)
Materials Version with navigator and front interfaces
Front frame Zinc die cast GD-Z410, powder-coated
Display glass Transparent Makrolon® plastic (FR clear 099) UL94-V2
102 Endress+Hauser
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Version with navigator and front interfaces

Flap; jog/shuttle dial ("Navigator") Plastic ABS UL94-V2

Membrane keypad Polyester membrane PC-ABS UL94-V2
Intermediate frame (front towards control panel) Plastic PA6-GF20 UL94-V2

Seal towards panel wall; seal in flap; seal towards Rubber EPDM 70 Shore A

navigator

Casing; rear panel Galvanized sheet steel St 12 ZE

Version with stainless steel front and touchscreen

Front frame AISI 316L

Display glass 6 mm single-pane safety glass (soda-lime glass)
Intermediate frame (front towards control panel) Plastic PA6-GF20 UL94-V2

Seal towards control panel wall Rubber EPDM 70 Shore A

Window seal between front frame and glass Rubber EPDM 60 Shore A

Casing; rear panel Galvanized sheet steel St 12 ZE

Designation Short form Properties

AISI 316L (corresponds to X2CrNiMo17-13-2, Austenitic, stainless steel

1.4404 or 1.4435) X2CrNiMo18-14-3 High corrosion resistance in general

ﬂ All materials are silicone-free.

Materials of desktop housing

= Housing half-panels: sheet steel, electrolytically plated (powder-coated)
= Side sections: aluminum extruded section (powder-coated)

= Section ends: colored polyamide

= Feet: colored polyamide, fiber-glass reinforced

Field housing materials

= Housing (front frame, door, base frame, side parts): thermoplastic polycarbonate PC
= Front panel and wall mounting: chrome-nickel stainless steel 1.4301 V2A

16.9 Display and operating elements

Operating concept

Endress+Hauser

The device can be operated directly onsite, or via remote configuration with the PC via
interfaces and operating tools (Web server, configuration software).

Web server

A Web server is integrated into the device. The Web server offers the following range of
functions:

= FEasy configuration without additional installed software

= [nstantaneous value display and diagnostics information

= Display of current measured value curves via Web browser (remote control)

= [oading/saving of device configuration

= Device firmware update

= Printout of device configuration
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Integrated operating instructions

The device's simple control system enables you to perform commissioning for many
applications without the need for hardcopy operating instructions. The device has an
integrated help function and displays operating instructions directly on screen.

Local operation Display elements
Type
Wide-screen TFT color graphic display (optionally with touch control)

Size (diagonal screen measurement)
178 mm (7")

Resolution
Wide VGA 384,000 pixels (800 x 480 pixels)

Backlight
50,000 h half value time (= half brightness)

Number of colors

262,000 viewable colors, 256 colors used

Viewing angle

Max. viewing angle range: 50° in all directions from the display central axis

Screen display

= Users can choose between black or white for the background color

= Active channels can be assigned to up to 10 groups. To clearly identify these groups,
they can be assigned a name, such as "temp. boiler 1" or "daily averages"

= Scales linear or logarithmic

= Measured value history: quick retrieval of historic data with zoom function

= Preformatted display formats, such as horizontal or vertical curves, instrument display,
circular chart, process screen, bargraph or digital display.
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Measured value display and
operating elements
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19  Device front (left: version with navigator and front interfaces; right: version with stainless steel front and

touchscreen)

Item Operating function (display mode = display of measured values)

No. (Setup mode = operating in the Setup menu)

a Slot for SD card

b USB B socket "Function” e.g. to connect to PC or laptop

c USB A socket "Host" e.g. for USB memory stick, external keyboard, barcode reader or printer

d LED at SD slot. Yellow LED lit or flashing when the device writes to the SD card or reads it.
Do not remove the SD card if the LED is lit or flashing! Risk of data loss!

1 "Navigator": jog/shuttle dial for operating with additional press/hold function.
In display mode: turn the dial to switch between the various signal groups. Press the dial to display the
main menu.
In setup mode or in a selection menu: turn the dial anticlockwise to move the bar or the cursor
upwards or counterclockwise, changes the parameter. Turning clockwise moves the bar or cursor
down or clockwise, changes parameter. Press = select highlighted function, start parameter change
(ENTER key).

2 Functions of LED indicators (according to NAMUR NE44:)
= Green LED (top) lit: power supply OK
= Red LED (bottom) flashing: maintenance required, caused by external factor (e.g. cable open circuit

etc.), or a message/notification requiring acknowledgment is pending, calibration is running.

3 Variable "soft keys', keys 1 to 4 (from left to right)

4 Function indicator of the "soft keys"

5 In display mode: current group name, type of analysis;
In setup mode: name of the current operating item (dialog title)

6 In display mode: displays current date/time
In setup mode: --

7 In display mode: user ID (if function is active)

In setup mode: --
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Item
No.

Operating function (display mode = display of measured values)
(Setup mode = operating in the Setup menu)

In display mode: alternating display indicating the percentage space on the SD card or USB stick that
has already been used.

Status symbols are also displayed in alternation with the memory information (e.g. simulation mode,
data storage active, operation locked, batch active)

In setup mode: the current "direct access" operating code is displayed

In display mode: window for measured value display (e.g. curve display).
Display of current measured values and the status in the event of an error/alarm condition. In the case
of counters, the type of counter is displayed as a symbol.

@ If a measuring point has limit value status, the corresponding channel identifier is highlighted
in red (quick detection of limit value violations). During a limit value violation and device
operation, the acquisition of measured values continues uninterrupted.

In setup mode: display of operating menu

10

In display mode: alternating status display (e.g. set zoom range) of the analog or digital inputs in the
appropriate color of the channel.
In setup mode: different information is displayed here depending on the display type.

Languages

The following languages can be selected in the operating menu: German, English, Spanish,
French, Italian, Dutch, Swedish, Polish, Portuguese, Czech, Russian, Japanese, Chinese
(Traditional), Chinese (Simplified)

Remote operation

Device access via operating tools

Device configuration and measured value retrieval can also be done via interfaces. The
following operating tools are available for this purpose:

Operating tool Functions

Access via

'Field Data Manager | ® Export of saved data (measured values, analyses, event log) | RS232/RS485, USB,

(FDM)" analysis = Visualization and processing of saved data (measured Ethernet
software, SQL values, analyses, event log)
database support = Safe archiving of exported data in a SQL database
(included in the
delivery)
Web server = Display of current and historical data and measured value | Ethernet
(integrated into the curves via the web browser
device; access via = FEasy configuration without additional installed software
browser) = Remote access to device and diagnostic information
OPC server The following momentary values can be provided: RS232/RS485, USB,
(optional) = Analog channels Ethernet
= Digital channels
= Mathematics
= Totalizer
'FieldCare / = Device configuration USB, Ethernet
DeviceCare" = Loading and saving of device configurations (upload/
configuration download)
software (included | ® Documentation of the measuring point
in the delivery)

16.10 Certificates and approvals

CE mark

106

The measuring system meets the legal requirements of the applicable EC quidelines. These
are listed in the corresponding EC Declaration of Conformity together with the standards
applied. Endress+Hauser confirms successful testing of the device by affixing to it the CE

mark.
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Ex approval

Information about currently available Ex versions (ATEX, FM, CSA, etc.) can be supplied by
your E+H Sales Center on request. All explosion protection data are given in separate
documentation which is available upon request.

UL approval

UL recognized component (see www.ul.com/database, search for Keyword "E225237")

Electronic recording/
electronic signature

FDA 21 CFRPart 11

The device meets the requirements of the "Food and Drug Administration" for electronic
recording/electronic signature.

Certifications = HART® certification (HCF)
= PROFINET certification
= EtherNet/IP certification
Other standards and = [EC 60529:
guidelines Degree of protection provided by housing (IP code)

= [EC/EN 61010-1:
Safety requirements for electrical equipment for measurement, control and laboratory
use

= JEC/EN 61326 Series:
Electromagnetic compatibility (EMC requirements)

16.11 Ordering information

The hazardous area version (Ex version) is only available in conjunction with the
stainless steel front and touch control.

Ordering information

Detailed ordering information is available from the following sources:

= In the Product Configurator on the Endress+Hauser website: www.endress.com -> Click
"Corporate" -> Select your country -> Click "Products" -> Select the product using the
filters and search field -> Open product page -> The "Configure" button to the right of the
product image opens the Product Configurator.

= From your Endress+Hauser Sales Center: www.addresses.endress.com

ﬂ Product Configurator - the tool for individual product configuration

= Up-to-the-minute configuration data

= Depending on the device: Direct input of measuring point-specific information such
as measuring range or operating language

= Automatic verification of exclusion criteria

= Automatic creation of the order code and its breakdown in PDF or Excel output
format

= Ability to order directly in the Endress+Hauser Online Shop

Scope of delivery

Endress+Hauser

The scope of delivery of the device comprises:

= Device (with terminals, as per order)

= ) fastening clips

= Version with navigator and front interfaces: USB cable

= Sealing rubber towards control panel wall

= 'Industrial Grade" SD card, industry standard:
Version with navigator and front interfaces: card is located in the SD slot behind the flap
on the front of the housing (optional).
Version with stainless steel front and touchscreen: card is in the device and cannot be
replaced or retrofitted.
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= "Field Data Manager (FDM)" analysis software on DVD (Essential, Demo or Professional
version, depending on order)

= 'FieldCare Device Setup / DeviceCare" configuration software on DVD

= Delivery note

= Multilanguage Brief Operating Instructions, hard copy

= Ex Safety Instructions, hard copy (optional)
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17.1 Operating items in the "Expert" menu

The parameter groups for the Expert setup contain all the parameters of the operating
menus: System, Input and Output Setup, Communication, Application, Diagnostics as well
as other parameters that are reserved for experts only.

ﬂ For most settings, the "Setup" or "Expert" menu must be quit before the settings are
adopted. However settings such as the date/time are accepted immediately.

ﬂ Information on configuration using FieldCare/DeviceCare configuration software
= Offline configuration: Most of the parameters are available (depending on the
device configuration).
= Online configuration: Only parameters marked "Online configuration" are available.

Direct access

Navigation Expert - Direct access
Description Direct access to active operating items (rapid access). Entering the direct access code takes
you directly to the desired operating parameter. The direct access code is displayed in the
Setup menu on the top right of the display (e.g. 00000-000).
Text entry (e.g. 00000-000)
17.1.1 "System" submenu
Basic settings that are needed to operate the device (e.g. date, time, etc.).
Language
Navigation Expert - System - Language
Direct access code: 010000-000
Description Select unit operating language.
Options German, English, Spanish, French, Italian, Dutch, Polish, Portuguese, Russian, Swedish,
Czech, Japanese, Chinese (Simplified), Chinese (Traditional)
Factory setting English; or preset to customer's preferred language
Device tag
Navigation Expert - System - Device tag
Direct access code: 000031-000
Description Individual device tag.

Endress+Hauser
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User entry Text entry (max. 32 characters)
Factory setting Unit 1

Temp. unit

Navigation Expert - System - Temp. unit

Direct access code: 100001-000

Description Selection of temperature unit. All directly connected thermocouples or resistance
thermometers (RTD) are displayed in the preset engineering units.

Options °C,’F,K

Factory setting °C

Decimal separator

Navigation Expert - System - Decimal separator
Direct access code: 100003-000

Description Select in which form the decimal separator character is to be displayed.
Options Comma, point
Factory setting Comma

Fault switching

Navigation Expert - System - Fault switching
Direct access code: 100002-000

Description If the device detects a system error (e.g. hardware defect) or a fault (e.g. cable open
circuit), the selected output switches.

Options Not used, Relay x
All the available relays are displayed

Factory setting Relay 1

Keyboard layout
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Navigation

Description
Options

Factory setting

Expert - System - Keyboard layout
Direct access code: 1000207000

Please select the keyboard layout. Only relevant if external keyboard is used.
Germany, Switzerland, France, USA, USA International, UK, Italy

Germany

Swap mouse buttons

Navigation Expert - System - Swap mouse buttons
Direct access code: 100050/000
Description Swap function of left and right mouse button.
Options No, Yes
Factory setting No
Paper size
Navigation Expert - System - Paper size
Direct access code: 540004/000
Description Please select the paper size of your printer.
Options DIN A4, US Letter
Factory setting DIN A4

Lock operation

Navigation

Description

Options

Factory setting

Endress+Hauser

Expert - System - Lock operation
Direct access code: 100060/000

Local operation is locked in cases of inactivity once the set time has elapsed to prevent
inadvertent operation (e.g. when cleaning the device). The device is unlocked by pressing
the navigator or the OK operating key for 3 s. When using an external keyboard, the
device is unlocked with the key combination "Ctrl-Alt-Del".

Never, After 2 (5, 10, 15) minutes

After 5 minutes
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LED mode
Navigation Expert - System - LED mode
Direct access code: 100005/000
Description NAMUR NE 44: Green LED -> Power supply OK. Red LED -> Measuring signal failure. Red
LED flashing -> Maintenance required.
NAMUR NE 44+: As per NAMUR NE 44, with red LED in the event of a limit value
violation.
Options NAMUR NE 44, NAMUR NE 44+
Factory setting NAMUR NE 44
PRESET
Navigation Expert - System - PRESET
Direct access code: 000044-000
Description Caution: Resets all the parameters to the factory settings!
ﬂ Only visible/editable if the service code has been entered.
Options No, Factory reset, Customer setting

Clear memory

Navigation Expert - System - Clear memory
Direct access code: 059000-000

Description Delete internal memory.

Note: In the version with stainless steel front and touchscreen the internal SD card is
also cleared.

Options No, Yes

"Date/time setup" submenu

Navigation Expert - System - Date/time setup

Description Contains settings for date/time.
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Date format

Navigation

Description
Options

Factory setting

Expert - System - Date/time setup - Date format
Direct access code: 110000-000

Select in which format the date is to be set and displayed.
DD.MM.YYYY, MM/DD/YYYY, YYYY-MM-DD

DD.MM.YYYY

Time format

Navigation

Description
Options

Factory setting

Expert - System - Date/time setup - Time format
Direct access code: 110001-000

Select in which format the time is to be set and displayed.
24 hour, 12 hour AM/PM

24 hour

"Date/time" submenu
(Online configuration)

Navigation

Description

Expert - System - Date/time setup > Date/time

Contains parameters for setting the date/time.

UTC time zone
(Online configuration)

Navigation

Description

Expert - System - Date/time setup - Date/time - UTC time zone
Direct access code: 120000-000

Display of the current UTC time zone is on (UTC = universal time coordinated).

Current date/time
(Online configuration)

Navigation

Endress+Hauser

Expert - System - Date/time setup - Date/time - Current date/time
Direct access code: 120003-000
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Description

Displays the current date and the current time.

"Change date/time" submenu

(Online configuration)

Description

Navigation

Contains parameters for changing the date/time.

Expert - System - Date/time setup - Change date/time

UTC time zone
(Online configuration)

Navigation

Description

Options

Expert - System - Date/time setup - Date/time - Change date/time - UTC time
zone
Direct access code: 120010-000

Set your UTC time zone (UTC = universal time coordinated).

-12:00, -11:00: Samoa, -10:00: Hawaii, -09:30: Marquesas, -09:00: Alaska, -08:00: LA,
-07:00: Denver, -06:00: Chicago, -05:00: New York, -04:00: Caracas, -03:30: St.John’s,
-03:00: Brasilia, -02:00: Atlantic, -01:00: Azores, +00:00: London, +01:00: Berlin,
+02:00: Cairo, +03:00: Moscow, +03:30: Tehran, +04:00: Abu Dhabi, +04:30: Kabul,
+05:00: Islamabad, +05:30: New Delhi, +05:45: Kathmandu, +06:00: Dhaka, +06:30:
Pyinmana, +07:00: Bangkok, +08:00: Peking, +08:45, +09:00: Tokyo, +09:30: Adelaide,
+10:00: Canberra, +10:30: Lord-Howe, +11:00:Solom.Isl., +11:30: Norfolk, +12:00:
Auckland, +12:45: Chatham, +13:00, +14:00

Date/time
(Online configuration)

Navigation

Description

User entry

Expert - System - Date/time setup > Date/time - Change date/time - Date/time
Direct access code: 120013-000

Set the current date and time for the unit here.

Date/time in set format

"NT/ST changeover" submenu

Navigation Expert - System - Date/time setup > NT/ST changeover
Description Contains settings for normal time/summer time changeover.
NT/ST changeover
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Navigation Expert - System - Date/time setup - NT/ST changeover - NT/ST changeover
Direct access code: 110002-000
Description Function for summer/normal time changeover.
Automatic: Changeover according to applicable directives for the selected region;
Manual: Set changeover times in the next items;
Off: No time changeover.
Options Off, Manual, Automatic
Factory setting Automatic
NT/ST region
Navigation Expert - System - Date/time setup - NT/ST changeover > NT/ST region
Direct access code: 110003-000
Description Selects the regional settings for summer/normal time changeover.
Only visible if NT/ST changeover = automatic.
Options Europe, USA
Factory setting Europe

Begin summer time

Occurrence
Navigation Expert - System - Date/time setup - NT/ST changeover - Occurrence
Direct access code: 110005-000

Description Day, when in the spring a change from normal to summer time occurs.
Visible for NT/ST changeover = Automatic or Manual. Only editable if NT/ST changeover =
Manual.

Options 1st, 2nd, 3rd, 4th, Last

Factory setting Last

Day

Navigation Expert - System - Date/time setup > NT/ST changeover - Day

Endress+Hauser

Direct access code: 110006-000
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Description Day, when in the spring a change from normal to summer time occurs.
Visible for NT/ST changeover = Automatic or Manual. Only editable if NT/ST changeover =
Manual.
Options Sunday, Monday, Tuesday, Wednesday, Thursday, Friday, Saturday
Factory setting Sunday
Month
Navigation Expert - System - Date/time setup - NT/ST changeover - Month
Direct access code: 110007-000
Description Month, when in the spring a change from normal to summer time occurs.
Visible for NT/ST changeover = Automatic or Manual. Only editable if NT/ST changeover =
Manual.
Options January, February, March, April, May, June, July, August, September, October, November,
December
Factory setting March
Date
Navigation Expert - System - Date/time setup - NT/ST changeover - Date
Direct access code: 110008-000
Description Date next spring when a change from normal to summer time occurs.
Only visible if NT/ST changeover = Automatic or Manual. Cannot be edited.
Time
Navigation Expert - System -»>Date/time setup > NT/ST changeover - Time
Direct access code: 110009-000
Description Point of time when the time is moved forward by 1 hour on the day of the changeover
from normal time to summer time (in the set time format).
Visible for NT/ST changeover = Automatic or Manual. Only editable if NT/ST changeover =
Manual.
User entry Time in set time format
Factory setting 02:00
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End summer time

Occurrence
Navigation Expert - System - Date/time setup - NT/ST changeover - Occurrence
Direct access code: 110011-000
Description Day, when in the autumn a change from summer to normal time occurs.
Visible for NT/ST changeover = Automatic or Manual. Only editable if NT/ST changeover =
Manual.
Options 1st, 2nd, 3rd, 4th, Last
Factory setting Last
Day
Navigation Expert - System - Date/time setup - NT/ST changeover - Day
Direct access code: 110012-000
Description Day, when in the autumn a change from summer to normal time occurs.
Visible for NT/ST changeover = Automatic or Manual. Only editable if NT/ST changeover =
Manual.
Options Sunday, Monday, Tuesday, Wednesday, Thursday, Friday, Saturday
Factory setting Sunday
Month
Navigation Expert - System - Date/time setup - NT/ST changeover - Month
Direct access code: 110013-000
Description Month, when in the autumn a change from summer to normal time occurs.
Visible for NT/ST changeover = Automatic or Manual. Only editable if NT/ST changeover =
Manual.
Options January, February, March, April, May, June, July, August, September, October, November,
December
Factory setting October
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Date
Navigation Expert - System - Date/time setup » NT/ST changeover - Date
Direct access code: 110014-000
Description Date next autumn when summer time changes back to normal time.
Only visible if NT/ST changeover = Automatic or Manual. Cannot be edited.
Time
Navigation Expert - System —»>Date/time setup - NT/ST changeover - Time
Direct access code: 110015-000
Description Point of time when the time is moved back by 1 hour on the day of the changeover from
summer time to normal time (in the set time format).
Visible for NT/ST changeover = Automatic or Manual. Only editable if NT/ST changeover =
Manual.
User entry Time in set time format
Factory setting 02:00

"SNTP" submenu

Navigation Expert - System - Date/time setup - SNTP
Description Contains settings for time synchronization using the Simple Network Time Protocol
(SNTP).
SNTP
Navigation Expert - System - Date/time setup > SNTP
Direct access code: 110020-000
Description If switched on, time synchronization is carried out via SNTP once a day.
Note: Only possible via Ethernet.
Port 123 must be open in the firewall. The user/network administrator is responsible for
the accuracy of the time server.
Options No, Yes
Factory setting No
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SNTP server 1
Navigation Expert - System - Date/time setup - SNTP server - SNTP server 1
Direct access code: 110021-000
Description Please specify the address of the time server (or the IP address).
Note: The DNS server must be configured (see Communication/Ethernet).
Your administrator can provide the address where necessary.
User entry Text field
SNTP server 2
Navigation Expert - System - Date/time setup - SNTP Server - SNTP server 2
Direct access code: 110025-000
Description Shows the IP address of the time server if it was automatically allocated via DHCP. Non-

editable display text.

An attempt is always made to synchronize the time via SNTP server 1 first (provided
it is configured).

DHCP must be switched on (see Communication/Ethernet).

DHCP server: Option 42.

"Security" submenu

Navigation Expert - System - Security
Description Contains settings that protect the unit against unauthorized operation and configuration.
Protected by
Navigation Expert - System - Security - Protected by
Direct access code: 100006-000
Description Configure how the device should be protected.
Options Open access, access code, FDA 21 CFR Part 11, user roles
Factory setting Open access

Access code
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Navigation Expert - System - Security > Access code
Direct access code: 100000-000
Description Using this code, setup access can be protected from unauthorized persons. In order to
change any parameter the correct code must be entered. Factory setting: "0", i.e. changes
can be made at any time.
Hint: Make a note of the code and store in a safe place.
Only visible if "Protected by" = "Access code".
User entry 4-digit number
Factory setting 0
Set point code
Navigation Expert - System - Security - Set point code
Direct access code: 100030-000
Description If the unit is protected by an access code a set point code can also be defined. The user can
change the set points once the set point code is entered. All other operating positions
remain locked, however.
Only visible if an access code has been defined.
Factory default: "0" means that alarm set points can only be changed by entering the access
code.
ﬂ Alarm set point code and access code should not be identical!
User entry 4-digit number
Factory setting 0
IP address
Navigation Expert - System - Security - IP address
Direct access code: 190001-000
Description Enter the IP address or DNS name of the PC on which user administration is running.
Please contact your network administrator if necessary.
User entry Text
Factory setting 0.0.0.0
Port
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Navigation Expert - System - Security - Port
Direct access code: 190002-000

Description A connection to the host PC is established through this communication port.

ﬂ If your network is protected by a firewall, this port may have to be enabled.
Please contact your network administrator if this is the case.

User entry 5-digit number

Factory setting 8010

Lock hardware

Navigation Expert - System - Security > Lock hardware
Direct access code: 100099-000

Description Device functions/interfaces that are not used can be switched off for security reasons.

ﬂ Fieldbuses may also be affected in the case of Ethernet or the serial interface.
Please follow the operating instructions.

Options Ethernet (all ports/services), USB A socket front, USB A socket back, USB B socket front,
Serial interface, SD card

Factory setting No lock

"Authentication" submenu

Navigation Expert - System - Security > Authentication

Description Define the passwords for the various user roles to allow device access.
Visible only if "Protected by" = "User roles".

Operator

ID: operator

Password

Navigation Expert - System - Security > Authentication - Password
Direct access code: 470105/000

Description Enter a password for this user account.

Options Text entry max. 12 characters

Factory setting operator
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Administrator
ID: admin
Password
Navigation Expert - System - Security - Authentication - Password
Direct access code: 470102/000
Description Enter a password for this user account.
Options Text entry max. 12 characters
Factory setting admin
Service
ID: service
Password
Navigation Expert - System - Security - Authentication - Password
Direct access code: 470101/000
Description Enter a password for this user account.
Options Text entry max. 12 characters
Factory setting service

"External memory" submenu

Navigation Expert - System - External memory
Description Contains settings for the external data carrier, amongst other things which data are to be
stored in which format on the external data carrier.
Save as
Navigation Expert - System - External memory - Save as
Direct access code: 140000-000
Description "Protected format" All data are stored in a manipulation protected encrypted format. They
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can be interpreted only by the PC analysis software provided.
"Open format": data are stored in a CSV format, this can be opened by a number of different

programs (e.g. MS Excel) (Attention: no manipulation security).
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Options Protected format, Open format (*.csv)
ﬂ Note: For the device version with stainless steel front and touch operation, only the
selection "protected format" is possible!
Factory setting Protected format
SD card

Memory build-up

Navigation Expert - System - External memory - Memory build-up
Direct access code: 140001-000
Description "Stack memory": no more data can be stored once the data carrier is full.
'Ring memory": once the data carrier is full the oldest data are deleted so that new data can
be stored (First in first out (FIFO).
The "Ring memory" setting refers only to the automatic storage of measured values.
Manual save functions ("Operation -> SD card -> Update/Save measured values') are
not affected.
Options Stack memory, Ring memory (FIFO)
ﬂ "Ring memory" can be selected only if "Save as"is set to "protected format" (and not
"CSV").
Factory setting Stack memory
Warning at
Navigation Expert - System - External memory - Warning at
Direct access code: 140005-000
Description [ssues a warning before the data carrier is x% full.
A warning is indicated on the device and this is also stored in the event buffer.
A relay can also be switched.
ﬂ Only for external SD card (does not apply to USB stick)!
User entry 0 to 99%
Factory setting 90

Switches relay
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Navigation Expert - System - External memory - Switches relay
Direct access code: 140006-000
Description When the warning "'Data carrier full' is displayed a relay can also be switched on.
Options Not used, Relay x
All the available relays are displayed
Factory setting Not used
CSV settings
ﬂ Also configurable if "Protected format" is set.
Separator for CSV
Navigation Expert - System - External memory - Separator for CSV
Direct access code: 140002-000
Description Configure which separator is used by your application (e.g. in Excel = semicolon).
Options Comma, Semicolon
Factory setting Semicolon
Date/time
Navigation Expert - System - External memory - Date/time
Direct access code: 140003-000
Description Please select if the date and time should be stored in one column or separate columns
when data are saved in CSV format files.
Options One column, Separate columns
Factory setting Separate columns
Operating time
Navigation Expert - System - External memory - Operating time
Direct access code: 140004-000
Description Please select in which format operation times will be stored/displayed.
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Options

Factory setting

0 seconds, 0.0000 hours, 0.00000 days, 0000h00:00

0000h00:00

"Messages" submenu

Navigation

Description

Expert - System - Messages

Contains settings for displaying/acknowledging messages. Examples of messages include:
messages triggered by set-points; messages triggered by a digital input; error messages;
etc.

Acknowledging messages

Navigation

Description

Options

Factory setting

Expert - System - Messages > Acknowledging messages
Direct access code: 100040-000

The time the message is acknowledged can be saved in the events list.

ﬂ This setting cannot be altered if the user administration system is activated (FDA 21
CFR Part 11).

Do not save, Save

Do not save

Switches relay

Navigation

Description

Options

Factory setting

Expert - System - Messages > Switches relay
Direct access code: 100042-000

A relay can be switched as soon as a message that has to be confirmed is displayed (e.qg.
on/off message, device errors etc.).

The relay assumes the initial status as soon as all messages have been confirmed.

Not used, Relay x
All the available relays are displayed

Not used

"Screen saver" submenu

Navigation

Description
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Expert - System - Screensaver

To increase the life span of the LCDs the backlight can be switched off (= screen saver).
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Screen saver

Navigation Expert - System - Screen saver - Screen saver
Direct access code: 160000-000
Description ‘Switched off": LCD is always switched on.
“Switch on for x min.”: display goes dark after x minutes. All other functions remain in
operation. Press an operating key: Illumination is switched back on.
‘Switch daily": Enter time span.
Options Switched off, On after 10 min, On after 30 min, On after 60 min, Switched daily, Control
input
Factory setting Switched off
This setting has no effect if the screen saver is controlled by a digital input-> 157
ON daily from
Navigation Expert - System - Screen saver - ON daily from
Direct access code: 160001-000
Description Set time (hh:mm) as of when the screensaver should be switched on (e.g. shift end time).
The screen saver is switched off as soon as the device is operated via onsite
operation. After 1 min of inactivity it switches back on automatically.
Only visible if screen saver = switched daily
User entry Time (hh:mm)
Factory setting 20:00
OFF daily from
Navigation Expert - System - Screen saver > OFF daily from
Direct access code: 160002-000
Description Set time (hh:mm) as of when the screensaver should be switched off (e.g. shift start time).
Only visible if screen saver = switched daily.
User entry Time (hh:mm)
Factory setting 07:00

Alarm response
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Navigation

Description

Options

Factory setting

Expert - System - Screen saver - Alarm response
Direct access code: 160003-000

"Off on alarm": If limit value violations occur or status signal "Maintenance required (Mxxx)"
or "Check function (Cxxx)"is active, the screensaver will be automatically deactivated.
"Always on": If limit value violations occur or status signal "Maintenance required (Mxxx)"
or "Check function (Cxxx)"is active, the screensaver will not be deactivated.

ﬂ Active messages that require acknowledgment or an active status signal "Failure
(Fxxx)" or "Out of specification (Sxxx)" deactivate the screensaver always.

Off on alarm, Always on

Off on alarm

"Barcode reader" submenu

Navigation

Description

Expert - System - Barcode reader

Settings for barcode reader (only relevant if a USB barcode reader is connected to the
device).

ﬂ Notes on operating a barcode reader: it must behave like a HID keyboard; texts must
be terminated with a carriage return.

Character set

Navigation

Description
Options

Factory setting

Expert - System - Barcode reader - Character set
Direct access code: 10002 1-000

Please select the keyboard layout.
Germany, Switzerland, France, USA, USA International, UK, Italy

Germany

Save as event

Navigation

Description

Options
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Expert - System - Barcode reader - Save as event
Direct access code: 100022-000

The device can save texts read in using a barcode reader in the events list.

Texts are stored as events if one of the following conditions is NOT met:
s A command sequence was read in

s The dialog where batch information is input is active

= The dialog for testing the barcode reader is active

= The "Save text" function is executed

No, Yes
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Factory setting No

Timeout sequences

Navigation Expert - System - Barcode reader > Timeout sequences
Direct access code: 100023-000

Description Specify the number of seconds after which a command sequence is canceled if the
necessary data are not read in.

User entry Time in seconds (10-180)

Factory setting 30

"Device options" submenu

Navigation Expert - System - Device options

Description Hardware and software options of the device.

Activation code
(Online configuration)

Navigation Expert - System - Device options - Activation code
Direct access code: 000057-000

Description Here, you can enter a code to enable the device options.
Options that can be upgraded can be found under "Spare parts" > 77.
Note: When an activation code is entered, the device is restarted in order to enable the
new option.

ﬂ = The activation code entered is not displayed, i.e. this parameter is always empty
following a restart.
= Pay attention to case-sensitivity.

User entry Text

Slot 1
(Online configuration)

Navigation Expert - System - Device options - Slot 1
Direct access code: 990000-000
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Description Shows hardware or software options.
Cannot be edited.
The assignment can be specified in the PC operating software for offline
configuration.
Options Not assigned, Universal inputs, HART
Slot 2
(Online configuration)
Navigation Expert - System - Device options - Slot 2
Direct access code: 990001-000
Description Shows hardware or software options.
Cannot be edited.
The assignment can be specified in the PC operating software for offline
configuration.
Options Not assigned, Universal inputs, HART
Slot 3
(Online configuration)
Navigation Expert - System - Device options - Slot 3
Direct access code: 990002-000
Description Shows hardware or software options.
Cannot be edited.
The assignment can be specified in the PC operating software for offline
configuration.
Options Not assigned, Universal inputs, HART
Slot 4
(Online configuration)
Navigation Expert - System - Device options - Slot 4
Direct access code: 990003-000
Description Shows hardware or software options.
Cannot be edited.
The assignment can be specified in the PC operating software for offline
configuration.
Options Not assigned, Universal inputs, HART
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Slot 5
(Online configuration)

Navigation Expert - System - Device options - Slot 5
Direct access code: 990004-000
Description Shows hardware or software options.
Cannot be edited.
The assignment can be specified in the PC operating software for offline
configuration.
Options Not assigned, Universal inputs, Digital inputs, HART
Communication

(Online configuration)

Navigation Expert - System - Device options - Communication
Direct access code: 990006-000
Description Shows hardware or software options.
Cannot be edited.
Options USB + Ethernet, USB + Ethernet + RS232/485
Fieldbus

(Online configuration)

Navigation Expert - System - Device options - Fieldbus
Direct access code: 990005-000
Description Shows hardware or software options.
Cannot be edited.
Options Not available, Modbus Slave, Profibus DP, EtherNet/IP, PROFINET
Modbus Master

(Online configuration)

Navigation
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Expert - System - Device options - Modbus Master
Direct access code: 990008-000
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Description Shows hardware or software options.
Cannot be edited.
ﬂ Detailed descriptions of this device option can be found in the associated
documentation.
Options No, Yes
Application

(Online configuration)

Navigation

Description

Options

Expert - System - Device options - Application
Direct access code: 990007-000

Shows hardware or software options.
Cannot be edited.

Standard, Mathematics, Tele-Alarm, Tele-Alarm + wastewater, Batch, Tele-Alarm + batch,
Energy, Energy + Tele-Alarm

Front of housing
(Online configuration)

Navigation

Description

Options

Expert - System - Device options - Front of housing
Direct access code: 990009-000

Shows hardware or software options.
Cannot be edited.

With interfaces, stainless steel without interfaces

17.1.2 "Inputs" submenu

Settings for analog and digital inputs.

"Universal inputs" submenu

Navigation Expert - System - Inputs - Universal inputs

Description Settings for the connected measuring points.

Add input

Navigation Expert - System - Inputs - Universal inputs > Add input
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Direct access code: 2220007000
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Description Addition of an input that must be switched on and configured according to the input
signal.

Options No, universal input x

Factory setting No

Delete input

Navigation Expert - System - Inputs - Universal inputs - Delete input

Direct access code: 2220017000

Description Delete an input configuration.
Options No, universal input x
Factory setting No

"Universal input x" submenu

Navigation Expert - System - Inputs - Universal inputs—> Universal input x

Description View or change settings for the selected channel.

ﬂ x = place holder for selected universal input.

Signal
Navigation Expert - Inputs - Universal inputs - Universal input x - Signal
Direct access code: 220000-0xx
Examples: Universal input 1: 220000-000; Universal input 12: 220000-011
Description Select the type of signal connected (current, voltage, etc.). The channel is switched off if no
signal type is selected (factory default).
Options Switched off, Current, Voltage, Resistance thermometer (RTD), Thermocouple, Pulse
counter, Frequency input, Profibus DP (option), Modbus Slave (option), Modbus Master
(option), HART (option), EtherNet/IP (option), PROFINET (option)
Factory setting Switched off
Range
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Navigation Expert - Inputs - Universal inputs - Universal input x - Range
Direct access code: 220001-0xx
Examples: Universal input 1: 220001-000; Universal input 12: 220001-011
Description Select the input range or which resistance thermometer/thermocouple is connected. The
respective terminal layout can be found in the Operating Instructions or on the rear of the
unit.
Only visible if signal # switched off.
Options Switched off
Current: 4-20 mA, 0-20 mA, 0-5 mA, 0-20 mA squared, 4-20 mA squared, +20 mA
Voltage: 0-1V,0-10V,0-5V, 1-5V, 150 mV, £1V, +10V, £30 V, 0-1 V squared, 0-10
V squared, 1-5 V squared
Resistance thermometer: Pt100 (IEC), Pt100 (JIS), Pt100 (GOST), Pt500 (IEC), Pt500 (JIS),
Pt1000 (IEC), Pt1000 (JIS), Pt46 (GOST), Pt50 (GOST), Cu50 (GOST, a=4260), Cu50
(GOST, a=4280), Cu53 (GOST, a=4280), Cul00 (GOST, a=4280)
Thermocouple: Type A (W5Re-W20Re), type B (Pt30Rh-Pt6Rh), type C (W5Re-W26Re),
type D (W3Re-W25Re), type J (Fe-CuNi), type K (NiCr-Ni), type L (Fe-CuNi), type L (NiCr-
Culi, GOST), type N (NiCrSi-NiSi), type R (Pt13Rh-Pt), type S (Pt10Rh-Pt), type T (Cu-
CuNNi)
Pulse counter
Frequency input
Profibus DP (option)
Modbus (option)
Modbus Master (option)
HART (option)
EtherNet/IP (option)
PROFINET (option)
Factory setting Switched off
Value
Navigation Expert - Inputs - Universal inputs - Universal input x - Value
Direct access code: 220023-0xx
Examples: Universal input 1: 220023-000; Universal input 12: 220023-011
Description Specify the value, which was read out digitally via HART, that should be recorded/
processed.
Only visible if signal = HART.
Options Switched off, Value x
All the available values are displayed.
Factory setting Switched off

Measured value type
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Navigation Expert - Inputs - Universal inputs - Universal input x - Measured value type
Direct access code: 220022-0xx
Examples: Universal input 1: 220022-000; Universal input 12: 220022-011
Description Type of measured value received.
Only visible if signal = HART or Modbus Master.
Options Instantaneous value, Counter
Factory setting Instantaneous value
Connection
Navigation Expert - Inputs - Universal inputs - Universal input x - Connection
Direct access code: 220002-0xx
Examples: Universal input 1: 220002-000; Universal input 12: 220002-011
Description Specify whether RTDs are connected as 2-, 3- or 4-wire systems.
Only visible if signal = resistance thermometer.
Options 2-wire, 3-wire, 4-wire
Factory setting 4-wire

Transmission protocol

Navigation Expert - Inputs - Universal inputs - Universal input x - Transmission protocol
Direct access code: 220049-0xx
Examples: Universal input 1: 220049-000; Universal input 12: 220049-011
Description Modbus TCP: Addressing Modbus TCP slaves.
Modbus TCP with slave address: Addressing gateways which use a table to link the address
to the right slave.
Modbus RTU via TCP: Transmission of the pure Modbus RTU protocol with CRC sum. Used
in signal converters for Ethernet -> RS485.
Only visible if signal = Modbus Master.
Options Modbus TCP, Modbus TCP with slave address, Modbus RTU over TCP
Factory setting Modbus TCP
IP address
Navigation Expert - Inputs - Universal inputs - Universal input x - [P address
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Direct access code: 220041-0xx
Examples: Universal input 1: 220041-000; Universal input 12: 220041-011
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Description Address of the Modbus Slave
Only visible if signal = Modbus Master.
User entry [P address
Factory setting 0.0.0.0
Port
Navigation Expert - Inputs - Universal inputs - Universal input x - Port
Direct access code: 220048-0xx
Examples: Universal input 1: 220048-000; Universal input 12: 220048-011
Description Modbus slave port
Only visible if signal = Modbus Master.
User entry Number (max. 5 digits)
Factory setting 502

Slave address

Navigation

Description

User entry

Factory setting

Expert - Inputs - Universal inputs - Universal input x - Slave address
Direct access code: 220040-0xx
Examples: Universal input 1: 220040-000; Universal input 12: 220040-011

Address of the Modbus Slave
Only visible if signal = Modbus Master.

Number (1 to 255)

1

Readout function

Navigation

Description

Options

Factory setting
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Expert - Inputs - Universal inputs - Universal input x - Readout function
Direct access code: 220042-0xx
Examples: Universal input 1: 220042-000; Universal input 12: 220042-011

Modbus function with which the registers are to be read out.
Only visible if signal = Modbus Master.

Read Input Register (3xxxxx), Read Holding Register (4xxxxx)

Read Input Register (3xxxxx)
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Register address

Navigation Expert - Inputs - Universal inputs - Universal input x - Register address
Direct access code: 220043-0xx
Examples: Universal input 1: 220043-000; Universal input 12: 220043-011
Description Register address 1-65535
Only visible if signal = Modbus Master.
User entry Number (1 to 65535)
Factory setting 1
Data type
Navigation Expert - Inputs - Universal inputs - Universal input x - Data type
Direct access code: 220044-0xx
Examples: Universal input 1: 220044-000; Universal input 12: 220044-011
Description Describes the data type of the value received and its sequence of bytes.
Only visible if signal = Modbus Master.
Options INT16, UINT16, INT32_B, INT32_L, UINT32_B, UINT32_L, FLOAT_B, FLOAT _L,
DOUBLE_B, DOUBLE_L
Factory setting FLOAT_B

Channel ident.

Navigation Expert - Inputs - Universal inputs - Universal input x - Channel ident.
Direct access code: 220003-0xx
Examples: Universal input 1: 220003-000; Universal input 12: 220003-011
Description Name of the measuring point connected to this input.
Only visible if signal # switched off.
User entry Text (16 characters)
Factory setting Channel x
Plot type
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Navigation Expert - Inputs - Universal inputs - Universal input x - Plot type
Direct access code: 220016-0xx
Examples: Universal input 1: 220016-000; Universal input 12: 220016-011
Description The analog inputs are scanned in a 100ms cycle. Depending on the memory cycle, the
selected data are determined, saved, and displayed based on the scanned values.
Options Instantaneous value, Average, Minimum value, Maximum value, Minimum + Maximum,
Counter, Current value + Counter
Factory setting Average
Time base
Navigation Expert - Inputs - Universal inputs - Universal input x - Time base
Direct access code: 220025-0xx
Examples: Universal input 1: 220025-000; Universal input 12: 220025-011
Description A current value can be determined from the counter reading with the aid of the time base
e.g. input liters, time base = second - current value = liters/second.
Only visible if signal = "Pulse counter" and plot type = "Current value + counter".
Options Second (s), Minute (min), Hour (h), Day (d)
Factory setting Second (s)

Engineering unit

Navigation

Description

User entry

Expert - Inputs - Universal inputs - Universal input x - Engineering unit
Direct access code: 220004-0xx
Examples: Universal input 1: 220004-000; Universal input 12: 220004-011

Specify the technical (physical) unit for the measuring point connected to this input.
Only visible if signal # switched off.

Text (6 characters)

Unit/dimension counter

Navigation

Description
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Expert - Inputs - Universal inputs - Universal input x - Unit/dimension counter
Direct access code: 220024-00x
Examples: Universal input 1: 220024-000; Universal input 12: 220024-011

Technical units of the count input, e.g. gal, cf.
Only visible if signal = "Pulse counter" and plot type = "Current value + counter".
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User entry

Text (max. 6 characters)

Pulse counter

Navigation

Description

Options

Factory setting

Expert - Inputs - Universal inputs - Universal input x - Pulse counter
Direct access code: 220017-0xx
Examples: Universal input 1: 220017-000; Universal input 12: 220017-011

Please check if the pulse counter used is a fast or slow (up to a max. 25 Hz) counter. For
example if the number of state changes from a relay are to be monitored then you must
set up "up to 25Hz".

Only visible if signal = pulse counter.

Up to 13kHz, Up to 25Hz

Up to 13kHz

Pulse value

Navigation

Description

User entry

Factory setting

Expert - Inputs - Universal inputs - Universal input x - Pulse value
Direct access code: 220010-0xx
Examples: Universal input 1: 220010-000; Universal input 12: 220010-011

Factor, that when multiplied by the input signal results in the required physical value.
Example: 1 pulse equals 5 m3-> enter "5".
Only visible if signal = pulse counter.

Number, max. 8 digits

1

Calc. factor

Navigation

Description

User entry

Factory setting
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Expert - Inputs - Universal inputs - Universal input x - Calc. factor
Direct access code: 220045-0xx
Examples: Universal input 1: 220045-000; Universal input 12: 220045-011

Factor for converting the counter (e.g. the transmitter returns m3/100 -> desired unit is
m? --> enter 0.01 as the factor)

Only visible if signal = Modbus Master.

Number (max. 15 digits)

1.0
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Decimal point

Navigation

Description

Options

Factory setting

Expert - Inputs - Universal inputs - Universal input x - Decimal point
Direct access code: 220005-0xx
Examples: Universal input 1: 220005-000; Universal input 12: 220005-011

Number of places after decimal point for the display.
Only visible if signal # switched off.

None, One (X.Y), Two (X.YY), Three (X.YYY), Four (X.YYYY), Five (X.YYYYY)

One (X.Y)

Start value range

Navigation

Description

User entry

Factory setting

Expert - Inputs - Universal inputs - Universal input x - Start value range
Direct access code: 220046-0xx
Examples: Universal input 1: 220046-000; Universal input 12: 220046-011

Scaling of the Modbus value

Here, enter the lower-range value for the scale which corresponds to the start of the
measuring range.

Only visible if signal = Modbus Master.

Number (max. 8 digits)

0

End value range

Navigation

Description

User entry

Factory setting

Expert - Inputs - Universal inputs - Universal input x - End value range
Direct access code: 220047-0xx
Examples: Universal input 1: 220047-000; Universal input 12: 220047-011

Scaling of the Modbus value

Here, enter the upper-range value for the scale which corresponds to the end of the
measuring range.

Only visible if signal = Modbus Master.

Number (max. 8 digits)

100

Lower frequency
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Navigation Expert - Inputs - Universal inputs - Universal input x - Lower frequency
Direct access code: 220018-0xx
Examples: Universal input 1: 220018-000; Universal input 12: 220018-011

Description Configure the lower frequency that corresponds to the start of the measuring range.
Only visible if signal = frequency input.

User entry 0to 12500 (Hz)
Factory setting 5.0 (Hz)
Range start
Navigation Expert - Inputs - Universal inputs - Universal input x - Range start

Direct access code: 220006-0xx
Examples: Universal input 1: 220006-000; Universal input 12: 220006-011

Description Transmitters convert the physical measured variable to standardized signals. Enter the
start of the measuring range here.

ﬂ = The start and end of the measuring range may not be identical.
= The start of the measuring range can also be larger than the end (e.g. for deep
wells).
= The parameter can be defined independently of the number of decimal places
configured for the measured value as these are only taken into consideration for

the display.
User entry Number (max. 8 digits)
Factory setting 0 (Depends on the input signal selected)
Upper frequency
Navigation Expert - Inputs - Universal inputs - Universal input x - Upper frequency
Direct access code: 220019-0xx
Examples: Universal input 1: 220019-000; Universal input 12: 220019-011
Description Configure the upper frequency that corresponds to the end of the measuring range.
Only visible if signal = frequency input.
User entry 0 to 12500 (Hz)
Factory setting 1000.0 (Hz)

Meas. range end
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Navigation Expert - Inputs - Universal inputs - Universal input x > Meas. range end
Direct access code: 220007-0xx
Examples: Universal input 1: 220007-000; Universal input 12: 220007-011
Description Transmitters convert the physical measured variable to standardized signals. Enter the end
of the measuring range here.
ﬂ = The start and end of the measuring range may not be identical.
= The end of the measuring range can also be smaller than the start (e.g. for deep
wells).
= The parameter can be defined independently of the number of decimal places
configured for the measured value as these are only taken into consideration for
the display.
User entry Number (max. 8 digits)
Factory setting 100 (Depends on the input signal selected)
Zoom start
Navigation Expert - Inputs - Universal inputs - Universal input x - Zoom start
Direct access code: 220011-0xx
Examples: Universal input 1: 220011-000; Universal input 12: 220011-011
Description If the whole value range is not used, you can configure the lower value of the required
section here. Zooming does not affect the save function.
ﬂ = The zoom can also be set outside the measuring range. The only restriction is that
the start and end of the zoom may not be identical.
= [f the signal or the range is changed, the zoom is corrected if it no longer fits the
measuring range.
= The zoom start can also be larger than the zoom end. The device will automatically
rotate the values on the display.
User entry Number (max. 8 digits)
Factory setting 0 (Depends on the input signal selected)
Zoom end
Navigation Expert - Inputs - Universal inputs - Universal input x - Zoom end
Direct access code: 220012-0xx
Examples: Universal input 1: 220012-000; Universal input 12: 220012-011
Description Like "Zoom start". However, enter the upper value of the required range here.
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ﬂ = The zoom can also be set outside the measuring range. The only restriction is that
the start and end of the zoom may not be identical.
= [f the signal or the range is changed, the zoom is corrected if it no longer fits the
measuring range.
= The zoom end can also be smaller than the zoom start. The device will
automatically rotate the values on the display.
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User entry Number (max. 8 digits)
Factory setting 100 (Depends on the input signal selected)
Damping
Navigation Expert - Inputs - Universal inputs - Universal input x - Damping
Direct access code: 220008-0xx
Examples: Universal input 1: 220008-000; Universal input 12: 220008-011
Description The more unwanted interference there is on the measurement signal the higher the value
that should be entered here. Result: Fast changes will be damped/suppressed.
Only visible if signal = current, voltage, resistance thermometer or thermocouple.
User entry 0t0999.9s
Factory setting Current, voltage: 0.0 s

Resistance thermometer, thermocouple: 0.2 s

Comparison point

Navigation

Description

Options

Factory setting

Expert - Inputs - Universal inputs - Universal input x - Comparison point
Direct access code: 220013-0xx
Examples: Universal input 1: 220013-000; Universal input 12: 220013-011

Internal: Compensation of the voltage error by measuring the terminal temperature.
External: Compensation of the voltage error by using an external controlled comparison
measurement point.

Only visible if signal = thermocouple.

Internal, External

Internal

Comparison temp.

Navigation

Description

User entry

Factory setting
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Expert - Inputs - Universal inputs - Universal input x - Comparison temp.
Direct access code: 220014-0xx
Examples: Universal input 1: 220014-000; Universal input 12: 220014-011

Settings for the external comparison temperature (only when connecting thermocouples).
Only visible if comparison point = external.

0t0 9999999 (Depends on the temperature unit selected)

0 (Depends on the temperature unit selected)
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Totalizer
(Online configuration)

Navigation

Description

User entry

Factory setting

Expert - Inputs - Universal inputs - Universal input x - Totalizer
Direct access code: 220015-0xx
Examples: Universal input 1: 220015-000; Universal input 12: 220015-011

Initial setting for the totalizer. Useful when continuing measurements recorded to date
with an (electro)-mechanical counter.
Only visible if signal = pulse counter or counter for Modbus Master

Number (max. 15 digits)

0

"Linearization" submenu

Navigation Expert - Inputs - Universal inputs - Universal input x - Linearization
Description Contains settings for linearization.
ﬂ Only current and voltage inputs can be linearized.
Linearization
Navigation Expert - Inputs - Universal inputs - Universal input x - Linearization >
Linearization
Direct access code: 230000-0xx
Examples: Universal input 1: 230000-000; Universal input 12: 230000-011
Description Specify whether this analog input should be linearized.
Options No, Yes
Factory setting No

Number of Points

Navigation
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Expert - Inputs - Universal inputs - Universal input x - Linearization - Number
of points
Direct access code: 230001-0xx
Examples: Universal input 1: 230001-000; Universal input 12: 230001-011

143



Appendix Memograph M, RSG45

Description Specify how many support points your linearization table has.

ﬂ Note: The first and last point always has to correspond to the start and end of the
measuring range respectively.

User entry 2 to 32

Factory setting 2

Dim. linearized value

Navigation Expert - Inputs - Universal inputs - Universal input x - Linearization - Dim.
linearized value
Direct access code: 230002-0xx
Examples: Universal input 1: 230002-000; Universal input 12: 230002-011

Description Unit/dimension for the linearized value.

User entry Text (max. 6 characters)

Zoom start

Navigation Expert - Inputs - Universal inputs - Universal input x - Linearization > Zoom
start

Direct access code: 230003-0xx
Examples: Universal input 1: 230003-000; Universal input 12: 230003-011

Description If the total transmitter range is not used, you can enter the lower value of the required
section here (higher resolution).
Example: Transmitter 0-14 pH, required section: 5-9 pH. Set "5" here. Zooming does not
affect the save function.

User entry 0 t0 9999999

Factory setting 0

Zoom end

Navigation Expert - Inputs - Universal inputs - Universal input x - Linearization - Zoom
end

Direct access code: 230004-0xx
Examples: Universal input 1: 230004-000; Universal input 12: 230004-011

Description Like "Zoom start". However, enter the upper value of the required range here.
Example: Transmitter 0-14 pH, required section: 5-9 pH. Input here: "9".

User entry 0 to0 9999999

Factory setting 100
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Points
Navigation Expert - Inputs - Universal inputs - Universal input x - Linearization - Points
Description Enter the support points of the linearization table here.
Note: The first and last point always has to correspond to the start and end of the
measuring range respectively. The support points can only be viewed in the PC software
here. To change the support points use the "Edit table" switch.
Sort table
Navigation Expert - Inputs - Universal inputs - Universal input x - Linearization - Points >
Sort table
Direct access code: 230020-0xx
Examples: Universal input 1: 230020-000; Universal input 12: 230020-011
Description You can sort the linearization table here.
Options No, Yes
Factory setting No
Check table
Navigation Expert - Inputs - Universal inputs - Universal input x - Linearization - Points >
Check table
Direct access code: 230008-0xx
Examples: Universal input 1: 230008-000; Universal input 12: 230008-011
Description Here you can check whether the linearization table has been entered correctly.
Options No, Yes
Factory setting No

x-value (1-32)

Navigation

Description

User entry

Endress+Hauser

Expert - Inputs - Universal inputs - Universal input x - Linearization - Points >
x-value (1-32)
Direct access code, x-value 1: 230100-0xx
Direct access code, x-value 2: 230102-0xx
Examples: Universal input 1, x-value 1: 230100-000; Universal input 12, x-value 1:
230100-011

x-value for the linearization (value from the device input). e.g. 10 cm corresponds to 20
liters --> enter 10.

0t0 9999999
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Factory setting

y-value (1-32)

Navigation

Description

User entry

Factory setting

Expert - Inputs - Universal inputs - Universal input x - Linearization - Support
points - y-value (1-32)
Direct access code, y-value 1: 230101-0xx
Direct access code, y-value 2: 230103-0xx
Examples: Universal input 1, y-value 1: 230101-000; Universal input 12, y-value 1:
230101-011

Enter the y-value that the measured x-value corresponds to e.g. 10 cm corresponds to 20
liters --> enter 20.

0t0 9999999

"Meas. val. corrct" submenu

Navigation Expert - Inputs - Universal inputs - Universal input x > Meas. val. corrct
Description Determining the correction values to balance measurement tolerances.
Proceed as follows:
= Measure the current value at the lower measurement range.
= Measure the current value at the upper measurement range.
= Enter the lower and upper target and actual value.
Offset
Navigation Expert - Inputs - Universal inputs - Universal input x > Meas. val. corrct-> Offset
Direct access code: 220050-0xx
Examples: Universal input 1: 220050-000; Universal input 12: 220050-011
Description This offset is only effective on the analog input signal (no maths/bus channels).
Only visible if signal = resistance thermometer or thermocouple.
User entry Number (max. 8 digits)
Factory setting 0
Correction RPT
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Navigation Expert - Inputs - Universal inputs - Universal input x - Meas. val. corrct >
Correction RPT
Direct access code: 220057-0xx
Examples: Universal input 1: 220057-000; Universal input 12: 220057-011
Description Rear panel temperature correction value for this analog input (only required for
thermocouples).
ﬂ Only visible/editable if the service code has been entered.
User entry Number (max. 8 digits)
Factory setting -0.1
Range start
Target value
Navigation Expert - Inputs - Universal inputs - Universal input x - Meas. val. corrct - Target
value
Direct access code: 220052-0xx
Examples: Universal input 1: 220052-000; Universal input 12: 220052-011
Description Enter the lower set point here (e.g. measuring range 0°C to 100°C: 0°C).
Only visible if signal = current or voltage.
User entry Number (max. 8 digits)
Factory setting 0
Actual value
Navigation Expert - Inputs - Universal inputs - Universal input x - Meas. val. corrct > Actual
value
Direct access code: 220053-0xx
Examples: Universal input 1: 220053-000; Universal input 12: 220053-011
Description Enter the lower value actually measured here (e.g. measuring range 0°C to 100°C:
measured value 0.5°C).
Only visible if signal = current or voltage.
User entry Number (max. 8 digits)
Factory setting 0
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Meas. range end

Target value
Navigation Expert - Inputs - Universal inputs - Universal input x - Meas. val. corrct > Target
value
Direct access code: 220055-0xx
Examples: Universal input 1: 220055-000; Universal input 12: 220055-011
Description Enter the upper set point here (e.g. measuring range 0°C to 100°C: 100°C).
Only visible if signal = current or voltage.
User entry Number (max. 8 digits)
Factory setting 100
Actual value
Navigation Expert - Inputs - Universal inputs - Universal input x - Meas. val. corrct > Actual
value
Direct access code: 220056-0xx
Examples: Universal input 1: 220056-000; Universal input 12: 220056-011
Description Enter the upper value actually measured here (e.g. measuring range 0°C to 100°C:
measured value 100.5°C).
Only visible if signal = current or voltage.
User entry Number (max. 8 digits)
Factory setting 100

"Totalization" submenu

Navigation Expert - Inputs - Universal inputs - Universal input x - Totalization
Description Set up only required for totalization of flow or power consumption.
Totalization

Navigation Expert - Inputs - Universal inputs - Universal input x - Totalization -
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Totalization
Direct access code: 220030-0xx
Examples: Universal input 1: 220030-000; Universal input 12: 220030-011
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Description
Options

Factory setting

By totalizing the analog signal (e.g. flow rate in m3/h) quantities (in m?) can be calculated.
No, Yes

No

Totalization base

Navigation Expert - Inputs - Universal inputs - Universal input x - Totalization ->
Totalization base
Direct access code: 22003 1-0xx
Examples: Universal input 1: 220031-000; Universal input 12: 220031-011
Description Select the required time base. Example: ml/s -> time base seconds (s); m3/h -> time base
hours (h).
Only visible if totalization = yes.
Options Second (s), Minute (min), Hour (h), Day (d)
Factory setting Second (s)
Unit
Navigation Expert - Inputs - Universal inputs - Universal input x - Totalization - Unit
Direct access code: 220032-0xx
Examples: Universal input 1: 220032-000; Universal input 12: 220032-011
Description Enter the unit for the calculated quantity (e.g. 'm*).
Only visible if totalization = yes.
User entry Text (max. 6 characters)

Low flow cut off

Navigation

Description

Endress+Hauser

Expert - Inputs - Universal inputs - Universal input x - Totalization - Low flow
cut off
Direct access code: 220033-0xx
Examples: Universal input 1: 220033-000; Universal input 12: 220033-011

If the volume flow recorded is below the set value, these quantities are not added to the
counter.

If the input is scaled from O to y, or if the pulse input is used, all values that are smaller
than the set value are not recorded.

If the input is scaled from -x to +y, all values around the zero point (e.g. also negative
values) are not recorded.

Only visible if totalization = yes.
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User entry

Factory setting

Number (max. 8 digits)

0

Calc. factor

Navigation Expert - Inputs - Universal inputs - Universal input x - Totalization - Calc.
factor
Direct access code: 220034-0xx
Examples: Universal input 1: 220034-000; Universal input 12: 220034-011
Description Factor for calculating the integrated value (e.g. the transmitter delivers 1/s -> totalization
base = second -> engineering unit required is m? -> enter factor 0.001)
Only visible if totalization = yes.
User entry Number (max. 8 digits)
Factory setting 1.0
Totalizer

(Online configuration)

Navigation

Description

User entry

Factory setting

Expert - Inputs - Universal inputs - Universal input x - Totalization - Totalizer
Direct access code: 220035-0xx
Examples: Universal input 1: 220035-000; Universal input 12: 220035-011

Initial setting for the totalizer. Useful when continuing measurements recorded to date
with an (electro)-mechanical counter.
Only visible if totalization = yes.

Number (max. 15 digits)

0

"Fault mode" submenu

ﬂ In the event of an error the alarm relay is switched if so configured - 110

Navigation Expert - Inputs - Universal inputs - Universal input x - Fault mode

Description Contains settings that define how this channel is to react under fault conditions (e.g. cable
open circuit, over range).

NAMUR NE 43
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Navigation

Description

Options

Factory setting

Expert - Inputs - Universal inputs - Universal input x - Fault mode > NAMUR
NE 43
Direct access code: 220060-0xx
Examples: Universal input 1: 220060-000; Universal input 12: 220060-011

Activate/deactivate the 4-20mA loop monitoring as per NAMUR recommendation NE 43.
The following error ranges apply when NAMUR NE43 is switched on:

< 3.8 mA: under range

> 20.5 mA: over range

< 3.6 mA or > 21.0 mA: sensor error

< 2 mA: cable open circuit

Only visible if signal = "Current" and range ="4-20 mA" or "4-20 mA squared".

Off, On

On

Cable open circ.

Navigation

Description

Options

Factory setting

Expert - Inputs - Universal inputs - Universal input x - Fault mode - Cable open
circ.
Direct access code: 220060-0xx
Examples: Universal input 1: 220060-000; Universal input 12: 220060-011

Cable open circuit detection
Only visible if signal = "Voltage" and range ="1-5 V" or "1-5 V squared".

Off, On

On

Lower error value

Navigation

Description

User entry

Factory setting

Expert - Inputs - Universal inputs - Universal input x - Fault mode - Lower error
value
Direct access code: 220065-0xx
Examples: Universal input 1: 220065-000; Universal input 12: 220065-011

When NE43 is switched off, defines the value that must be undershot for the device to
output an error.

Only visible if signal = "Current’, range = "4-20 mA", and NAMUR NE 43 ="Off".
Number (max. 8 digits); O to 4 mA

3.9mA

Upper error value
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Navigation Expert - Inputs - Universal inputs - Universal input x - Fault mode - Upper error
value
Direct access code: 220066-0xx
Examples: Universal input 1: 220066-000; Universal input 12: 220066-011
Description When NE43 is switched off, defines the value that must be exceeded for the device to
output an error.
Only visible if signal = "Current’, range = "4-20 mA", and NAMUR NE 43 ="Off".
User entry Number (max. 8 digits); 20 to 22mA
Factory setting 20.8mA
Time delay
Navigation Expert - Inputs - Universal inputs - Universal input x - Fault mode - Time delay
Direct access code: 220064-0xx
Examples: Universal input 1: 220064-000; Universal input 12: 220064-011
Description The device only reacts (e.g. Relay switch) when this condition, open circuit/under range/
over range, has been operational for the preset time.
Only visible if NAMUR NE 43 = on.
User entry 0to99s
Factory setting Os
On error
Navigation Expert - Inputs - Universal inputs - Universal input x - Fault mode - On error
Direct access code: 220061-0xx
Examples: Universal input 1: 220061-000; Universal input 12: 220061-011
Description Configure what value the device should continue working with (for calculations) if the
measured value is not valid (e.g. cable open circuit).
In the event of an error value, all the dependent calculations are flagged accordingly
as "error value". Counters are not flagged, however!
Options Invalid calculation, Error value
Factory setting Invalid calculation
Error value
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Navigation Expert - Inputs - Universal inputs - Universal input x - Fault mode - Error value
Direct access code: 220062-0xx
Examples: Universal input 1: 220062-000; Universal input 12: 220062-011
Description The device continues calculating with this value in the event of an error.
Only visible if On error = Error value.
User entry Number (max. 8 digits)
Factory setting 0
Save event
Navigation Expert - Inputs - Universal inputs - Universal input x - Fault mode - Save event
Direct access code: 220063-0xx
Examples: Universal input 1: 220063-000; Universal input 12: 220063-011
Description Stores a message in the event log when a fault occurs.
Options No, Yes
Factory setting No
Copy settings
Navigation Expert - Inputs - Universal inputs - Universal input x - - Copy settings
Direct access code: 220200-0xx
Examples: Universal input 1: 220200-000; Universal input 12: 220200-011
Description Copies settings from actual channel to selected channel.
Options Switched off, Universal input x
Users can choose from all the available universal inputs.
Factory setting Switched off

Submenu "Digital inputs -> Digital input x"

Navigation Expert - Inputs - Digital inputs - Digital input x

Description Setting up only required if the digital inputs (e.g. events) are to be used.
ﬂ x = place holder for selected digital input.

Add input
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Navigation Expert - System - Digital inputs > Add input
Direct access code: 252000/000
Description Addition of a digital input that must be configured according to the function.
Options No, Digital input x
Factory setting No
Delete input
Navigation Expert - System - Digital inputs - Delete input
Direct access code: 2520017000
Description Delete an input configuration.
Options No, Digital input x
Factory setting No
Function
Navigation Expert - Inputs - Digital inputs - Digital input x > Function
Direct access code: 250000-00x
Examples: Digital input 1: 250000-000; Digital input 6: 250000-005
Description Select the required function: Digital inputs are High active; this means the described effect
is achieved by a high input.
Low =-3 to +5V
High =+12 to +30V.
Options Switched off, control input, on/off event, pulse counter, operational time, event+operation
time, quantity from time, Profibus DP (option), Modbus slave (option), EtherNet/IP
(option), PROFINET (option)
Factory setting Switched off
Function
Navigation Expert - Inputs - Digital inputs - Digital input x - Function
Direct access code: 250014-00x
Examples: Digital input 1: 250014-000; Digital input 6: 250014-005
Description Specifies how the data from the fieldbus is interpreted/processed.
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Visible only if function = Profibus DP, Modbus slave, EtherNet/IP, PROFINET
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Options Switched off, Control input, On/off event, Pulse counter, Operational time, Event
+operation time, Quantity from time

Factory setting Switched off

Channel ident.

Navigation Expert - Inputs - Digital inputs - Digital input x > Channel ident.
Direct access code: 250001-00x
Examples: Digital input 1: 250001-000; Digital input 6: 250001-005

Description Measurement point name (e.g. "Pump") or description of the function of this input (e.q.
'Fault message").
Only visible if function # switched off.

User entry Text (max. 16 characters)

Factory setting Digital x

Engineering unit

Navigation Expert - Inputs - Digital inputs - Digital input x - Engineering unit
Direct access code: 250002-00x
Examples: Digital input 1: 250002-000; Digital input 6: 250002-005

Description Technical units of the count input, e.qg. gal, cf.
Only visible if function = pulse counter or quantity from time.

User entry Text (max. 6 characters)
Decimal point
Navigation Expert - Inputs - Digital inputs - Digital input x - Decimal point

Direct access code: 250004-00x
Examples: Digital input 1: 250004-000; Digital input 6: 250004-005

Description Number of places after decimal point for the display.
Only visible if function = pulse counter or quantity from time.

Options None, One (X.Y), Two (X.YY), Three (X.YYY), Four (X.YYYY), Five (X.YYYYY)

Factory setting One (X.Y)
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Input factor in

Navigation Expert - Inputs - Digital inputs - Digital input x - Input factor in
Direct access code: 250019-00x
Examples: Digital input 1: 250019-000; Digital input 6: 250019-005

Description Defines if the set up factor is respective to 1 second or 1 hour.
Only visible if function = quantity from time.

Options Seconds, hours

Factory setting Seconds

Pulse value

Navigation Expert - Inputs - Digital inputs - Digital input x - Pulse value
Direct access code: 250005-00x
Examples: Digital input 1: 250005-000; Digital input 6: 250005-005

Description Factor, that when multiplied by the input signal results in the required physical value.
Examples:
1 pulse equals 5 m? -> enter "5".
Only visible if function = pulse counter.

User entry Number (max. 8 digits)

Factory setting 1

1 second=/1 hour= (depends on the setting in "Input factor in")

Navigation Expert - Inputs - Digital inputs - Digital input x > 1 second=/1 hour=
Direct access code: 250005-00x
Examples: Digital input 1: 250005-000; Digital input 6: 250005-005

Description Factor, that when multiplied by the operating time results in the required physical value.
Examples:
1 second equals 81 -> enter "8".
Only visible if function = quantity from time.

User entry Number (max. 8 digits)
Factory setting 1
Time delay
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Navigation Expert - Inputs - Digital inputs - Digital input x - Time delay
Direct access code: 250017-00x
Examples: Digital input 1: 250017-000; Digital input 6: 250017-005
Description The high signal must be active for at least the preset time before the device changes the
channel from low to high.
The change from high to low is always immediate.
Only visible if function = control input, on/off event, event+operation time.
User entry 0t0 99999 s
Factory setting 0
Action
Navigation Expert - Inputs - Digital inputs - Digital input x > Action
Direct access code: 250003-00x
Examples: Digital input 1: 250003-000; Digital input 6: 250003-005
Description Set up the function of the control input.
Only visible if function = control input.

Action Description

Start/stop recording The device only saves data as long as a high signal is present.

Screensaver on Switches backlight/display off, low = off, high = on.

Lock setup The user can only change the setup if a low signal is present.

Time synchronization If a high signal is applied, the device rounds the system time up or down (only for
low-high change) to the nearest minute: 0 to 29 - Round down; 30 to 59 >
round up.

Change group When switching low->high the display switches to the next active group.

Set point monitoring The entire set point monitoring function of the device can be switched on (for

on/off 'high") or switched off (for "low").

Individual LV on/off The monitoring of a selected limit value can be switched on (high) or off (low).

Block keyboard/navigator | The device can only be operated if a low signal is present. Otherwise all key
activation and navigator actions are discarded.

Start/stop analysis 1-4 Starts/ends one of the max. 4 external analyses (the analysis runs only as long as
the signal is high). Measured value acquisition for the graphic display continues.
Batches are also started/ended with this function.

Note: This function is not available in the case of batch and control input via a
maths channel.

Reset batch number x Resets the automatically generated batch number (1..x) to O (in the event of a

(option) LowHigh change).

Batch x limit values on/off | Switches the limits of batch x on/off.

(option) The limits relating to the batch are determined based on the group settings (via the
channels assigned to the batch).

If a channel is assigned to several batches, the limits for this channel are not
disabled.
Options Switched off, Start/stop recording, Screen saver on, Lock setup, Time synchronization,
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Change group, Set point monitoring on/off, Individual LV on/off, Block keyboard/
navigator, Start/stop analysis x, Reset batch no. x, Batch x limits on/off
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Factory setting Switched off
Group
Navigation Expert - Inputs - Digital inputs - Digital input x > Group
Direct access code: 250015-00x
Examples: Digital input 1: 250015-000; Digital input 6: 250015-005
Description Select which group should be displayed in the event of a Low->High flank change.
Alternatively the next active group can be displayed.
Only visible if function = control input and action = change group.
Options Change automatically, Group x
Factory setting Change automatically
Set point
Navigation Expert - Inputs - Digital inputs - Digital input x - Set point
Direct access code: 250016-00x
Examples: Digital input 1: 250016-000; Digital input 6: 250016-005
Description Select the set point which should be switched on or off by means of this control input.
Only visible if function = control input and action = individual LV on/off.
Options Switched off, Universal input xx, Digital input xx, Math xx, Set point xx, Relay xx
Factory setting Change automatically

Switches relay

Navigation

Description

Options

Factory setting

158

Expert - Inputs - Digital inputs - Digital input x > Switches relay
Direct access code: 250006-00x
Examples: Digital input 1: 250006-000; Digital input 6: 250006-005

Switches the respective relay when the digital input is low or high. Please take note of the
connection hints in the Operating Instructions!

Only visible if function = control input, on/off event, event+operation time.

Not used, Relay x
All the available relays are displayed

Not used
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Description 'H'

Navigation

Description

User entry

Factory setting

Expert - Inputs - Digital inputs - Digital input x - Description 'H
Direct access code: 250007-00x
Examples: Digital input 1: 250007-000; Digital input 6: 250007-005

Condition description when the digital input is active. This text is both shown in the
display and saved to memory.
Only visible if function = control input, on/off event, event+operation time.

Text (max. 6 characters)

On

Description L'

Navigation Expert - Inputs - Digital inputs - Digital input x - Description '
Direct access code: 250008-00x
Examples: Digital input 1: 250008-000; Digital input 6: 250008-005
Description Condition description when the digital input is not active. This text is both shown in the
display and saved to memory.
Only visible if function = control input, on/off event, event+operation time.
User entry Text (max. 6 characters)
Factory setting Off
Save event
Navigation Expert - Inputs - Digital inputs - Digital input x > Save event
Direct access code: 250009-00x
Examples: Digital input 1: 250009-000; Digital input 6: 250009-005
Description Determines whether the condition change from low to high or high to low is stored in the
event log.
ﬂ Requires higher memory capacity.
Only visible if function = control input, on/off event, event+operation time.
Options No, Yes
Factory setting Yes
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Event message

Navigation

Description

Options

Factory setting

Expert - Inputs - Digital inputs - Digital input x > Event message
Direct access code: 250018-00x
Examples: Digital input 1: 250018-000; Digital input 6: 250018-005

'Do not acknowledge": No message is shown if the digital input switches.
"Acknowledge": A message window is shown on the screen which has to be acknowledged

by operating a push button.
Only visible if function = control input, on/off event, event+operation time.

Do not acknowledge, Acknowledge

Do not acknowledge

Event text L->H

Navigation

Description

User entry

Expert - Inputs - Digital inputs - Digital input x > Event text L->H
Direct access code: 250010-00x
Examples: Digital input 1: 250010-000; Digital input 6: 250010-005

Description of condition change from low to high. Event text is stored (e.g. Start filling).

ﬂ If no event text is set, the device generates an automatic event text (factory setting),
e.qg. digital 1 L->H.

Only visible if function = control input, on/off event, event+operation time.

Text (max. 22 characters)

Event text H->L

Navigation

Description

User entry

Expert - Inputs - Digital inputs - Digital input x > Event text H->L
Direct access code: 250011-00x
Examples: Digital input 1: 250011-000; Digital input 6: 250011-005

Description of condition change from high to low. Event text is stored (e.g. Stop filling).

If no event text is set, the device generates an automatic event text (factory setting),
e.g. digital 1 H->L.

Only visible if function = control input, on/off event, event+operation time.

Text (max. 22 characters)

Record duration
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Navigation Expert - Inputs - Digital inputs - Digital input x > Record duration
Direct access code: 250012-00x
Examples: Digital input 1: 250012-000; Digital input 6: 250012-005
Description The duration between "On" and "Off" can be recorded. The duration is appended to the "Off"
event text (<hhhh>h<mm>:<ss>).
Power failure times do not affect the duration. If the digital channel was "on" before the
power failure and is still "on" after the power failure, the duration continues.
Only visible if function = control input, on/off event, event+operation time.
Options No, Yes
Factory setting No
Totalizer

(Online configuration)

Navigation Expert - Inputs - Digital inputs - Digital input x - Totalizer
Direct access code: 250013-00x
Examples: Digital input 1: 250013-000; Digital input 6: 250013-005
Description Initial setting for the totalizer. Useful when continuing measurements recorded to date
with an (electro)-mechanical counter.
Only visible if function = pulse counter, operational time, event+operation time or quantity
from time.
User entry Number (max. 15 digits)
Factory setting 0
Copy settings
Navigation Expert - Inputs - Digital inputs - Digital input x - Copy settings
Direct access code: 250200-00x
Examples: Digital input 1: 250200-000; Digital input 6: 250200-005
Description Copies settings from actual channel to selected channel.
Options No, Digital input x
Users can choose from all the available digital inputs.
Factory setting No
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17.1.3 "Outputs" submenu

Setting up only required if outputs (e.g. relays) are to be used.

"Universal output x" submenu

Navigation Expert - Outputs - Universal output x

Description Settings for the universal output selected (current or pulse output).
Signal

Navigation Expert - Outputs - Universal output x - Signal

Direct access code: 340000-00x
Examples: Universal output 1: 340000-000; Universal output 2: 340000-001

Description Select the output signal for this channel.
Options Switched off, 4-20 mA, 0-20 mA, Pulse output
Factory setting Switched off

Reference channel

Navigation Expert - Outputs - Universal output x - Reference channel
Direct access code: 340001-00x
Examples: Universal output 1: 340001-000; Universal output 2: 340001-001

Description Select the input to which the analog output refers.

Options Switched off, Universal input x, Digital input x, Maths x, Set point x, Relay x
All active inputs are available for selection.

Factory setting Switched off
Start value
Navigation Expert - Outputs - Universal output x - Start value

Direct access code: 340003-00x
Examples: Universal output 1: 340003-000; Universal output 2: 340003-001

Description Configure what value corresponds to 0/4 mA.
Visible only if signal = 4-20 mA or 0-20 mA.

User entry Number (max. 8 characters)
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Factory setting

Full scale value

Navigation Expert - Outputs - Universal output x - Full scale value
Direct access code: 340004-00x
Examples: Universal output 1: 340004-000; Universal output 2: 340004-001
Description Configure what value corresponds to 20 mA.
Visible only if signal = 4-20 mA or 0-20 mA.
User entry Number (max. 8 characters)
Factory setting 100
Damping/filter
Navigation Expert - Outputs - Universal output x > Damping/filter
Direct access code: 340005-00x
Examples: Universal output 1: 340005-000; Universal output 2: 340005-001
Description Time constant of the first order low pass for the output signal. This is used to prevent
strong fluctuations of the output signal.
Visible only if signal = 4-20 mA or 0-20 mA.
User entry 0t0999.9s
Factory setting 0.0s

Pulse value

Navigation

Description

User entry

Factory setting
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Expert - Outputs - Universal output x > Pulse value

Direct access code: 340006-00x

Examples: Universal output 1: 340006-000; Universal output 2: 340006-001
The pulse value specifies what quantity an output pulse corresponds to (e.g. 1 pulse =5
liters).
Only visible if signal = pulse output.
Number (min. 0.000001; max. 8 characters)

1
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Pulse width
Navigation Expert - Outputs - Universal output x > Pulse width
Direct access code: 340007-00x
Examples: Universal output 1: 340007-000; Universal output 2: 340007-001
Description The pulse width limits the maximum possible output frequency of the pulse output. Define
a fixed or dynamic pulse width.
Only visible if signal = pulse output.
Options User-defined, dynamic (max. 1000ms)
Factory setting User-defined
Pulse width
Navigation Expert - Outputs - Universal output x > Pulse width
Direct access code: 340008-00x
Examples: Universal output 1: 340008-000; Universal output 2: 340008-001
Description You can set the pulse width in the range of 0.5 to 1000 ms here.
Only visible if signal = pulse output.
Value 0.5 to 1000 ms
Factory setting 100 ms

"Meas. val. corrct" submenu

Navigation

Description

Expert - Outputs - Universal output x > Measured value correction

Here, you can correct the output current value (necessary only if the device that carries out
the further processing cannot compensate for any measurement section tolerances).
Proceed as follows:

1. On the connected device, read out the displayed value in both the upper and lower
measuring range.

2. Enter the lower and upper target and actual value.

Visible only if signal = 4-20 mA or 0-20 mA.

Lower correction value

Target value
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Navigation Expert - Outputs - Universal output x - Measured value correction > Lower
correction value - Target value
Direct access code: 340021-00x
Examples: Universal output 1: 34002 1-000; Universal output 2: 340021-001
Description Enter the lower set point here.
Visible only if signal = 4-20 mA or 0-20 mA.
User entry Number (max. 8 characters)
Factory setting 0
Actual value
Navigation Expert - Outputs - Universal output x > Measured value correction > Lower
correction value - Actual value
Direct access code: 340022-00x
Examples: Universal output 1: 340022-000; Universal output 2: 340022-001
Description Here, enter the lower actual value which is displayed at the connected device.
Visible only if signal = 4-20 mA or 0-20 mA.
User entry Number (max. 8 characters)
Factory setting 0

Upper correction value

Target value
Navigation Expert - Outputs - Universal output x - Measured value correction > Upper
correction value - Target value
Direct access code: 340024-00x
Examples: Universal output 1: 340024-000; Universal output 2: 340024-001
Description Enter the upper set point here.
Visible only if signal = 4-20 mA or 0-20 mA.
User entry Number (max. 8 characters)
Factory setting 100
Actual value
Navigation Expert - Outputs - Universal output x - Measured value correction > Upper
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correction value - Actual value
Direct access code: 340025-00x
Examples: Universal output 1: 340025-000; Universal output 2: 340025-001
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Description Here, enter the upper actual value which is displayed at the connected device.
Visible only if signal = 4-20 mA or 0-20 mA.
User entry Number (max. 8 characters)
Factory setting 100

"Fault mode" submenu

Navigation Expert - Outputs - Universal output x - Fault mode
Description Configure how the analog output should behave in the event of an error (e.g. if the input
channel has a cable open circuit).
Visible only if signal = 4-20 mA or 0-20 mA.
NAMUR NE 43
Navigation Expert - Outputs - Universal output x - Fault mode > NAMURNE 43
Direct access code: 340015-00x
Examples: Universal output 1: 340015-000; Universal output 2: 340015-001
Description Activate/deactivate the 4-20 mA loop output as per NAMUR recommendation NE 43. The
following error ranges apply when NAMUR NE43 is switched on:
<3.8 mA: underrange
>20.5 mA: overrange
< 3.6 mA or > 21.0 mA: Cable open circuit
Visible only if signal = 4-20 mA or 0-20 mA.
Options Off, On
Factory setting On
On error
Navigation Expert - Outputs - Universal output x > Fault mode - On error
Direct access code: 340016-00x
Examples: Universal output 1: 340016-000; Universal output 2: 340016-001
Description What value should the output assume in the event of an error (e.g. cable open circuit or
calculated value invalid)?
Visible only if signal = 4-20 mA or 0-20 mA.
Options Invalid calculation, Error value
Factory setting Invalid calculation
Error value
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Navigation

Description

User entry

Factory setting

Expert - Outputs - Universal output x > Fault mode - Error value

Direct access code: 340017-00x

Examples: Universal output 1: 340017-000; Universal output 2: 340017-001

This value is output in the event of an error. Note: Must be between 0 and 22 mA.

Visible only if signal = 4-20 mA or 0-20 mA.
0to 22 mA

0 mA

"Relay x" submenu

Navigation Expert - Outputs - Relay x
Description Contains setup for the selected relay.
ﬂ x = place holder for selected relay.
Operating mode
Navigation Expert - Outputs - Relay x - Operating mode
Direct access code: 330000-00x
Examples: Relay 1:330000-000; Relay 6: 330000-005
Description Relay function:
NC contact: The relay is closed in its quiescent state (maximum safety).
NO contact: The relay is open in its quiescent state.
Options Closing, Opening
Factory setting Closing
Identifier
Navigation Expert - Outputs > Relay x > Identifier
Direct access code: 330001-00x
Examples: Relay 1:330001-000; Relay 6: 330001-005
Description Presettable relay identifier.
User entry Text (max. 16 characters)
Factory setting Relay x

Remote controlled
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Navigation

Description

Options

Factory setting

Expert - Outputs - Relay x > Remote controlled
Direct access code: 330002-00x
Examples: Relay 1:330002-000; Relay 6: 330002-005

Configure whether the relay may be controlled remotely (e.g. PC or SMS).
Only visible with the option "Tele-Alarm".

No, Yes

No

17.1.4 "Communication" submenu

Set-up required if you are using the USB, RS232, RS485 or Ethernet interface of the unit

(PC operation, serial data read-out, modem operation, etc.).

ﬂ The various interfaces can be operated in parallel.

Timeout

Navigation

Description

User entry

Factory setting

Expert - Communication - Timeout
Direct access code: 150200-000

Timeout is modifiable between 1 and 99 seconds. O seconds means that the functionality

is inactivated.

0to 99s

Os

Switches

Navigation

Description

Options

Factory setting

Expert - Communication - Switches
Direct access code: 150201-000

After the given timeout the dedicated relay/OC is active while no readout of actual

measured values are in process.

Not used, Relay x

All the available relays are displayed

Not used

Timeout fieldbus
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Navigation

Description

User entry

Factory setting

Expert - Communication - Timeout fieldbus
Direct access code: 150210-000

Time within which measured values must be received via fieldbus (otherwise an error will
be set). Not relevant if only measured values are read out.

1to 99s

10s

"Ethernet" submenu

Navigation Expert - Communication - Ethernet
Description Contains the set-up required if you are using the Ethernet interface of the unit.
MAC-address

(Online configuration)

Navigation Expert > Communication - Ethernet > MAC-address
Direct access code: 150000-000
Description Displays the MAC address.
DHCP
Navigation Expert - Communication - Ethernet - DHCP
Direct access code: 150002-000
Description The device can get its Ethernet settings through DHCP.
Caution: The settings determined are not displayed until after setup acceptance!
ﬂ Note: The unit always gets the same IP address if the leasing time is set long enough
on the DHCP server. The PC software needs the IP address determined to establish a
connection!
Options No, Yes
Factory setting Yes
IP address
Navigation Expert - Communication - Ethernet - IP address
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Description

User entry

Factory setting

Please enter the IP address (given from your network administrator). Please talk to your
network administrator about this.
Only editable if DHCP = no.

IP address

000.000.000.000

Subnet mask

Navigation Expert > Communication - Ethernet - Subnet mask
Direct access code: 150004-000
Description Please enter the subnet mask (given from your network administrator).
Only editable if DHCP = no.
User entry [P address
Factory setting 255.255.255.000
Gateway
Navigation Expert > Communication - Ethernet > Gateway
Direct access code: 150005-000
Description Please enter the Gateway (given from your network administrator).
Only editable if DHCP = no.
User entry [P address
Factory setting 000.000.000.000

Domain Name System (DNS)

Navigation

Description

User entry

Factory setting

170

Expert > Communication - Ethernet - Domain Name System (DNS)
Direct access code: 150009-000

Please enter the [P-address of the DNS server (you can get this from your network
administrator).

Is needed if you wish to send e-mails and want to use the e-mail server name instead of
the IP address (e.g. smtp.example.org).

Only editable if DHCP = no.

IP address

000.000.000.000

Endress+Hauser



Memograph M, RSG45

Appendix

Disable port
Navigation Expert - Communication - Ethernet - Disable port
Direct access code: 150020-000
Description You can disable unused ports for security reasons.
CDI is the protocol that the configuration software or reporting software uses to
communicate with the device.
All other ports (e.g. SNTP, SMTP, Web server) are automatically disabled if the
function is switched off.
Options CDI, OPC, Modbus Slave, HART IP
Factory setting ---- (no port disabled)
Port
Navigation Expert - Communication > Ethernet - Port
Direct access code: 150001-000
Description The system communicates with the PC software through this communication port.
If your network is protected by a firewall, this port may have to be enabled. Please
contact your network administrator if this is the case.
User entry Number (max. 5 digits)
Factory setting 8000
OPC port
Navigation Expert - Communication > Ethernet - OPC port
Direct access code: 150010-000
Description Values van be read via OPC server using this communication port.
If your network is protected by a firewall, this port may have to be enabled. Please
contact your network administrator if this is the case.
User entry Number (max. 5 digits)
Factory setting 8002
HART IP port
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Navigation Expert > Communication > Ethernet > HART IP port
Direct access code: 150030-000

Description Connected HART devices can be accessed via this communication port using the
communication device type manager (DTM).
Only visible if a HART card is present.

ﬂ Note: If your network is protected by a firewall, this port will have to be enabled.
Please contact your network administrator if this is the case.

The "RSG45 HART CommDTM" is required in order to access connected HART devices via
the RSG45. This establishes the connection between an FDT Frame application and a
HART device. The DTM for the connected device must also be installed in the FDT Frame
application. The "RSG45 HART CommDTM'" is available from www.endress.com/rsg45.
Further information > B 37

User entry Number (max. 5 digits)

Factory setting 5094

Web server

Navigation Expert - Communication - Ethernet > Web server

Direct access code: 470000-000

Description Switch the Web server functionality on/off. The instantaneous values can only be
displayed using an Internet browser when the web browser is activated.

ﬂ A connection to the Web server can only be established via the Ethernet interface.

Options No (Web server is off), Yes (Web server is active)

Factory setting Yes

"Configuration Web server" submenu

Navigation Expert - Communication - Ethernet - Configuration Web server

Description Configure the Web server or specify which functionality should be possible via Web server.
Only visible if Web server = yes.

ﬂ Instantaneous value display is always possible once the Web server is switched on.

Port

Navigation Expert - Communication - Ethernet > Configuration Web server - Port
Direct access code: 470003-000
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Description The Web server communicates through this communication port.
ﬂ If your network is protected by a firewall, this port may have to be enabled.
Please contact your network administrator if this is the case.
User entry Number (max. 5 digits)
Factory setting 80
Setup
Navigation Expert - Communication - Ethernet - Configuration Web server - Setup
Direct access code: 470001-000
Description The device can be configured via Web server.
For security reasons it is advisable to switch off configuration via the Web server after
commissioning.
With regard to IT security please contact your network administrator if necessary.
Options No, Yes
Factory setting Yes

Firmware update

Navigation

Description
Options

Factory setting

Expert > Communication - Ethernet > Configuration Web server - Firmware
update
Direct access code: 470002-000

Firmware can be updated via Web server.
No, Yes

No

Remote control

Navigation

Description
Options

Factory setting
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Expert - Communication > Ethernet - Configuration Web server - Remote
control
Direct access code: 470004-000

Remote control of the device is possible via Web server.
No, Yes

No
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WebDAV server

Navigation Expert - Communication - Ethernet - Configuration Web server > WebDAV
server
Direct access code: 470006-000

Description The SD card can be read via a WebDAV Client.

Options No, Yes

Factory setting No

Batch (option)

Navigation

Description

Options

Factory setting

Expert - Communication - Ethernet - Configuration Web server - Batch
Direct access code: 470007-000

Batches can be controlled via the Web server.

ﬂ Detailed descriptions of this device option can be found in the associated
documentation.

No, Yes

No

Control relays (option)

Navigation

Description

Options

Factory setting

Expert - Communication - Ethernet > Configuration Web server - Control relays
Direct access code: 470008-000

Relays can be remote-controlled via the Web server.

ﬂ Detailed descriptions of this device option can be found in the associated
documentation.

No, Yes

No

"Authentication" submenu

Navigation
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Description Set the passwords for the various users with which the device can be accessed via Web
server.
Only relevant if the device is not protected by user administration.
Operator Admin Service
Measured value display Yes Yes Yes
Display instrument health status Yes Yes Yes
Configuration No Yes Yes
Configuration incl. service parameter No No Yes
Update firmware No Yes Yes
WebDAV Yes Yes Yes
ﬂ Note: The following passwords should be changed during commissioning.
Operator
ID
Navigation Expert - Communication - Ethernet - Configuration Web server > Authentication
> 1D
Direct access code: 470104-000
Description ID required in order to access the device. Pay attention to case-sensitivity.
Cannot be edited.
Factory setting operator
Password
Navigation Expert - Communication - Ethernet - Configuration Web server > Authentication
- Password
Direct access code: 470105-000
Description Enter a password for this user account.
Pay attention to case-sensitivity.
User entry Text (max. 12 characters)
Factory setting operator
Administrator
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ID
Navigation Expert - Communication - Ethernet > Configuration Web server - Authentication
> 1D
Direct access code: 470101-000
Description ID required in order to access the device. Pay attention to case-sensitivity.
Cannot be edited.
Factory setting admin
Password
Navigation Expert - Communication - Ethernet > Configuration Web server - Authentication
- Password
Direct access code: 470102-000
Description Enter a password for this user account.
Pay attention to case-sensitivity.
User entry Text (max. 12 characters)
Factory setting admin
Service
ID
Navigation Expert » Communication - Ethernet - Configuration Web server - Authentication
> 1D
Direct access code: 470107-000
Description ID required in order to access the device. Pay attention to case-sensitivity.
Cannot be edited.
Factory setting service
Password
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Navigation

Description

User entry

Factory setting

Expert - Communication - Ethernet - Configuration Web server - Authentication
- Password
Direct access code: 470108-000

Enter a password for this user account.
Pay attention to case-sensitivity.

Text (max. 12 characters)

service

"Timeouts" submenu

Navigation

Description

Expert - Communication - Ethernet - Configuration Web server - Timeouts

Timeouts for the Web server. Settings should only be modified if slow network connections
are causing transmission problems.

ﬂ The settings are only adopted if the browser has been restarted or a new tab opened.
Caution: Settings should only be changed by experts.

Connection quality

Navigation Expert - Communication > Ethernet - Configuration Web server - Timeouts >
Connection quality
Direct access code: 470200-000
Description Configuration of typical timeout values for the Web server connection.
ﬂ The default values can be changed if necessary.
Options Please select, Local network (LAN/WLAN), Wireless/mobile (fast connect.), Wireless/
mobile (slow connect)
Factory setting Please select
Get timeout
Navigation Expert - Communication - Ethernet - Configuration Web server - Timeouts -
Get timeout
Direct access code: 470201-000
Description Maximum time to load a new page before the browser ends the connection.
User entry 5t0999s
Factory setting 25
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Set timeout

Navigation Expert - Communication - Ethernet - Configuration Web server - Timeouts -
Set timeout
Direct access code: 470202-000

Description Maximum time to write a value or execute an action before the browser ends the

connection.
User entry 5t0999s
Factory setting 5

Put timeout

Navigation

Description

User entry

Factory setting

Expert - Communication - Ethernet - Configuration Web server - Timeouts -
Put timeout
Direct access code: 470203-000

Maximum time to transmit files to or from the device before the browser ends the
connection.

5t09999 s

240

Ping interval

Navigation

Description

User entry

Factory setting

Expert - Communication - Ethernet - Configuration Web server - Timeouts >
Ping interval
Direct access code: 470204-000

Interval in which the browser checks device reachability.

ﬂ The check is switched off if Os is set. This is for diagnostic purposes only and should
not be set!

0to 999 s

10

Ping timeout
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Navigation Expert - Communication - Ethernet - Configuration Web server - Timeouts -
Ping timeout
Direct access code: 470205-000

Description Time in which the device must respond before the browser ends the connection.

User entry 5t0999s

Factory setting 15

Ping retry

Navigation Expert - Communication - Ethernet - Configuration Web server - Timeouts -
Ping retry
Direct access code: 470206-000

Description Number of retries if the device does not respond.

User entry Oto5

Factory setting 0

Poll timeout

Navigation

Description
User entry

Factory setting

Expert - Communication > Ethernet - Configuration Web server - Timeouts >
Poll timeout
Direct access code: 470207-000

Maximum permitted time to refresh the website.

5t0999s

"HART" submenu

Navigation Expert - Communication »> HART

Description Specify the values that should be read out via HART.
Master type

Navigation Expert > Communication - HART - Master type
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Description

Options

Factory setting

Select the HART master type - usually "Primary". Select "Secondary" if another device (e.g. a
PLC) is already operating as the primary master.

Primary, Secondary

Primary

Attempts on error

Navigation

Description

User entry

Factory setting

Expert - Communication - HART - Attempts on error
Direct access code: 550011-000

Number of attempts to establish HART communication before a communication error is
issued.

0to 99

Failure mode

Navigation Expert > Communication » HART - Fault mode
Direct access code: 550013-000
Description If HART communication is disrupted, the primary process variable (PV) can be calculated if
a valid current is present.
ﬂ This function is not possible in Multidrop mode.
Start/end of measuring range must be correctly configured.
Options PV rendered invalid, calculate PV based on current
Factory setting PV rendered invalid
Add value
Navigation Expert - Communication » HART - Add value
Direct access code: 550300-000
Description A value read from a connected HART device is added.
Options No, Yes
Factory setting No
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Delete value

Navigation

Description
Options

Factory setting

Expert - Communication - HART - Delete value
Direct access code: 550301-000

Deletes a process value from the list.
No, value x

No

"Value x" submenu

Navigation Expert - Communication - HART - Value x
Description Specify the value that should be read out via HART.
Note: This value must then be assigned to a channel for universal inputs.
Connection
Navigation Expert - Communication - HART - Value x - Connection
Direct access code: 550000-0xx
Description Select the physical channel to which the HART device is connected and from which you
wish to query the value.
Options Switched off, Channel x
Factory setting Switched off
Unit address
Navigation Expert - Communication - HART - Value x - Device address
Direct access code: 550001-0xx
Description Enter the device address of the HART device.
Note: The entered device address must match the address set in the HART device
(polling address; HART address).
User entry 0to 62
Factory setting 0
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Process variable
Navigation Expert - Communication - HART - Value x - Process variable
Direct access code: 550002-0xx
Description Select the process variable that should be requested.
Options Primary process variable (PV), Secondary process variable (SV), Third process variable
(TV), Fourth process variable (QV)
Factory setting Primary process variable (PV)

Channel ident.

Navigation

Description
User entry

Factory setting

Expert - Communication - HART - Value x - Channel ident.
Direct access code: 550003-0xx

Designation of the measuring point connected to this input.
Text (max. 16 characters)

Value x

"Serial interface" submenu

Navigation Expert - Communication - Serial interface
Description Contains the set-up required if you are using the RS232 or RS485 unit interface.
Type
Navigation Expert - Communication > Serial interface > Type
Direct access code: 150100-000

Description Configure how the serial interface is used. Pay attention to the connections.
Options RS232, RS485, Debug (only for service purposes)
Factory setting RS232

Protocol

Navigation Expert » Communication > Serial interface - Protocol
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Direct access code: 150105-000
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Description Define the serial interface protocol.
Note: The device automatically disables incompatible settings.
Options PC software, Printer, Modbus Slave (only if type = RS485), Modbus Master (only if type =
RS485)
Factory setting PC software
Baud rate
Navigation Expert - Communication - Serial interface - Baud rate
Direct access code: 150101-000
Description Transmission speed ("‘Baud rate") - must be the same as the settings for the PC software.
Options 9600, 19200, 38400, 57600, 115200
Factory setting 19200
Parity
Navigation Expert - Communication - Serial interface - Parity
Direct access code: 150103-000
Description Parity
Only visible if protocol # PC software.
Options None, Even, Odd
Factory setting None
Stop bits
Navigation Expert - Communication - Serial interface - Stop bits
Direct access code: 150104-000
Description Stop bits
Only visible if protocol # PC software.
Options 1,2
Factory setting 1
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Unit address
Navigation Expert > Communication - Serial interface - Unit address
Direct access code: 150102-000
Description Every unit operating using RS232/RS485 must have an individual address (00-30).
Only visible if type = RS485.
User entry 0to 30
Factory setting 0

"Modbus Slave" submenu (option)

Navigation Expert - Communication - Modbus Slave
Description Configure the Modbus settings for the device.
ﬂ Detailed descriptions of this device option can be found in the associated
documentation.
Modbus
Navigation Expert - Communication - Modbus Slave > Modbus
Direct access code: 480000-000
Description Specify the physical interface you wish to use.
Options Not used, RS485, Ethernet
Factory setting Not used

Unit address

Navigation

Description

User entry

Factory setting

184

Expert - Communication - Modbus Slave - Unit address
Direct access code: 480001-000

Enter the device address where it should be possible to reach this device in the bus.
Only visible if Modbus = RS485.

1to 247
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Port
Navigation Expert > Communication - Modbus Slave - Port
Direct access code: 480004-000
Description Port via which the Modbus protocol can be activated.
Only visible if Modbus = Ethernet.
User entry Number (max. 5 digits)
Factory setting 502

"Serial interface" submenu

Navigation Expert - Communication - Modbus Slave - Serial interface
Description Contains settings for the serial interface.
Only visible if Modbus = RS485.
Baud rate
Navigation Expert - Communication - Modbus Slave - Serial interface > Baud rate
Direct access code: 150101-000
Description Transmission speed ("‘Baud rate") - must be the same as the settings for the PC software.
Only visible if Modbus = RS485.
Options 9600, 19200, 38400, 57600, 115200
Factory setting 19200
Parity
Navigation Expert - Communication - Modbus Slave - Serial interface - Parity
Direct access code: 150103-000
Description Parity
Only visible if Modbus = RS5485.
Options None, Even, Odd
Factory setting None

Endress+Hauser
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Stop bits
Navigation Expert - Communication - Modbus Slave - Serial interface - Stop bits
Direct access code: 150104-000
Description Parity
Only visible if Modbus = RS485 and parity = none.
Options 1,2
Factory setting 1

"Modbus Master" submenu

Navigation Expert - Communication > Modbus Master
Description Configure the Modbus settings for the device.
ﬂ Detailed descriptions of this device option can be found in the associated
documentation.
Modbus
Navigation Expert - Communication - Modbus Master - Modbus
Direct access code: 480050-000
Description Specify the physical interface you wish to use.
Options Not used, RS485, Ethernet
Factory setting Not used
Scan cycle
Navigation Expert - Communication - Modbus Master - Scan cycle
Direct access code: 480053-000
Description Cycle time for scanning the end devices.
Only visible if Modbus = RS485.
Options Off, 1s,25s,55s,10s, 305, 1 min, 2 min, 5 min, 10 min
Factory setting 1s
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Response timeout

Navigation

Description

Options

Factory setting

Expert - Communication - Modbus Master - Response timeout
Direct access code: 480054-000

Time within which the system must receive a response from the end device.
Only visible if Modbus = RS5485.

Off, 1s,25s,5s,10s, 30s, 1 min, 2 min, 5 min, 10 min

1s

Register per command

Navigation

Description
User entry

Factory setting

Expert - Communication - Modbus Master - Register per command
Direct access code: 480055-000

Maximum number of registers that can be read out per command.
3to 125

20

Connection attempts

Navigation

Description

User entry

Factory setting

Expert - Communication » Modbus Master - Connection attempts
Direct access code: 480056-000

Number of repeated connection attempts until a slave signals a timeout.
Only visible if Modbus = RS485.

1to 10

Command distribution

Navigation

Endress+Hauser

Expert - Communication - Modbus Master » Command distribution
Direct access code: 480057-000
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Description

Options

Factory setting

Distributed over the scan cycle: The commands are uniformly distributed over the scan
cycle.

At the start of the scan cycle: The commands are sent at the start of the scan cycle with a
pause between commands. A new scan commences when the scan cycle ends.
Continuously: The commands are sent continuously with only a pause between commands.
The scan cycle is not taken into account.

Only visible if Modbus = RS485.

Distributed over the scan cycle, At the start of the scan cycle, Continuously

Distributed over the scan cycle

Pause between commands

Navigation

Description

User entry

Factory setting

Expert - Communication - Modbus Master - Pause between commands
Direct access code: 480058-000

Time system waits between a response and a new command to be sent.
Only visible if Modbus = RS485.

5to 600,000 ms

10 ms

"Serial interface" submenu

Navigation Expert - Communication > Modbus Master - Serial interface
Description Contains the settings required if you are using the RS485 interface of the device.
Baud rate
Navigation Expert - Communication > Modbus Master > Serial interface > Baud rate
Direct access code: 150101-000
Description Transmission speed ("Baud rate") - must be the same as the settings for the PC software.
Only visible if Modbus = RS485.
Options 9600, 19200, 38400, 57600, 115200
Factory setting 19200
Parity
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Navigation Expert - Communication - Modbus Master - Serial interface - Parity
Direct access code: 150103-000
Description Parity
Only visible if Modbus = RS5485.
Options None, Even, Odd
Factory setting None
Stop bits
Navigation Expert » Communication - Modbus Master - Serial interface - Stop bits
Direct access code: 150104-000
Description Parity
Only visible if Modbus = RS485 and parity = none.
Options 1,2
Factory setting 1

"Profibus DP" submenu (option)

Navigation

Description

Expert - Communication - Profibus DP

Configure the Profibus DP settings for the device.

ﬂ Detailed descriptions of this device option can be found in the associated
documentation.

Slave address

Navigation Expert - Communication - Profibus DP - Slave address
Direct access code: 480100-000
Description Enter the device address where it should be possible to reach this device in the bus.
User entry 1to 125
Factory setting 1
Show status
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Navigation

Description

Options

Factory setting

Expert » Communication - Profibus DP - Show status
Direct access code: 480101-000

The status is shown on the display in addition to the measured value. Status changes are

saved in the event log.

No, Yes

No

"Slot x" submenu

Navigation

Description

Expert - Communication - Profibus DP - Slot x

Slot assignment of the channels.

Settings only required if you wish to connect the device to a PLC via Profibus DP.

Master In/Out

Navigation

Description

Options

Factory setting

Expert - Communication - Profibus DP - Slot x - Master In/Out
Direct access code: 480110-0xx
Examples: Slot 1: 480110-000; Slot 16: 480110-015

Selection of the modules that can be selected in the PLC.
AI/AQ: Transmission of a floating point number + status.
DI/DO: Transmission of digital statuses.

Al/DI: To the PLC.

AO/DO: From the PLC.

Not used, 1 AI-PA: 5 Byte, 2 AI-PA: 10 Byte, 3 AI-PA: 15 Byte, 4 AI-PA: 10 Word, 8 DI: 2
Byte, 1 AO-PA: 5 Byte, 2 AO-PA: 10 Byte, 3 AO-PA: 15 Byte, 4 AO-PA: 10 Word, 8 DO: 2

Byte

Not used

Byte x...y

Navigation

Description

Options

190

Expert - Communication - Profibus DP - Slot x > Byte x...y
Direct access code, byte 0..4: 480111-0xx
Direct access code, byte 5..9: 480113-0xx
Direct access code, byte 10..14: 480115-0xx
Direct access code, byte 15..19: 480117-0xx
Examples: Slot 1, Byte 0..4: 480111-000; Slot 16: 480111-015

Please select the value that should be used within the module from this address offset.

Switched off, Universal input x, Digital input x, Maths x, Set point x, Relay x

Note: All active inputs are available for selection.
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Factory setting Switched off
-->
Navigation Expert - Communication - Profibus DP - Slot x - -->
Direct access code, byte 0..4 -->: 480112-0xx
Direct access code, byte 5..9 -->: 480114-0xx
Direct access code, byte 10..14 -->: 480116-0xx
Direct access code, byte 15..19 -->: 480118-0xx
Examples: Slot 1, Byte 0..4 -->: 480112-000; Slot 16 -->: 480112-015
Description Data type of the value to be transmitted.
Note: [tem only visible if a digital input with the function Operational time, Event
+operation time or Quantity from time has been selected under "Byte x..y".
Options Not used, Instantaneous value, State, Totalizer, Total operational time
Factory setting Not used
Bit 0.0-0.7
Navigation Expert - Communication - Profibus DP - Slot x - Bit 0.0-0.7
Direct access code, bit 0.0: 480111-0xx
Direct access code, bit 0.1: 480113-0xx
Direct access code, bit 0.2: 480115-0xx
Direct access code, bit 0.3: 480117-0xx
Direct access code, bit 0.4: 480119-0xx
Direct access code, bit 0.5: 480120-0xx
Direct access code, bit 0.6: 48012 1-0xx
Direct access code, bit 0.7: 480122-0xx
Examples: Slot 1, Bit 0.0: 480111-000; Slot 16: 480111-015
Description Please select the value that should be used within the module from this address offset.
Options Switched off, Universal input x, Digital input x, Maths x, Set point x, Relay x
All active inputs are available for selection.
Factory setting Switched off

17.1.5 "Application" submenu

Configure various application-specific settings (e.g. group settings, limit values, etc.).

Submenu "Maths - Maths x"

(Online configuration)

Navigation
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Description Configuration of the mathematics channels.
ﬂ x = place holder for selected mathematics channel.
Function
Navigation Expert - Application > Maths > Maths x - Function
Direct access code: 400000-000
Examples: Maths 1: 400000-000; Maths 4: 400000-003
Description Switch the mathematics channel on or off.
Options Switched off, Formula editor
Included with energy package (option): Energy calculation, mass calculation, density
calculation, calculation of heat quantity, DP flow mass calculation
Factory setting Switched off

Channel ident.

Navigation Expert - Application » Maths - Maths x > Channel ident.
Direct access code: 400001-000
Examples: Maths 1: 400001-000; Maths 4: 400001-003
Description Measurement point name (e.g. "Pump") or description of the function of this input (e.g.
"Fault message").
User entry Text (max. 16 characters)
Factory setting Maths x
Formula
Navigation Expert - Application - Maths - Maths x > Formula
Direct access code: 400002-000
Examples: Maths 1: 400002-000; Maths 4: 400002-003
Description Enter the desired calculation formula.
The formula can be any combination of arithmetic calculations and logical operations.
Analog, digital or already active mathematics channels can be used.
Description of formula editor > B 203
Only visible if Function = Formula Editor.
User entry Formula
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Application
Navigation Expert - Application > Maths - Maths x > Application
Direct access code: 400100-0xx
Examples: Maths 1: 400100-000; Maths 4: 400100-003
Description Please select application.
Only visible with energy package (option) and selected energy function.
Options Water heat quantity, Water heat difference, Steam heat quantity, Steam heat difference,
Water/glycol heat difference, Water DP flow, Steam DP flow, Liquids DP flow, Gas DP flow
Factory setting Water heat quantity or Water DP flow (depends on selected function)
Device type
Navigation Expert - Application - Maths - Maths x - Device type
Direct access code: 400122-0xx
Examples: Maths 1: 400122-000; Maths 4: 400122-003
Description Configure the transmitter type used.
Only visible with energy package (option) and Function = Mass calculation DP flow.
Options Orifice (corner), Orifice (D/D2), Orifice (flange), Nozzle (ISA1932), Nozzle (1. radius),
Venturi nozzle, Venturi tbe, cast, Venturi tbe, bear., Venturi tbe, steel, V-cone, Pitot tube,
Gilflo
Factory setting Orifice (corner)
Flow
Navigation Expert > Application > Maths - Maths x - Flow
Direct access code: 400101-0xx
Examples: Maths 1: 400101-000; Maths 4: 400101-003
Description Please select a flow input.
Visible only with energy package (option) and function = energy or mass calculation.
Options Switched off, Universal input x, Maths x
All active inputs are available for selection.
Factory setting Switched off

Engineering unit

Endress+Hauser
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Navigation

Description

Options

Factory setting

Expert - Application - Maths - Maths x > Engineering unit
Direct access code: 400102-0xx
Examples: Maths 1: 400102-000; Maths 4: 400102-003

Please select the unit you would like to use for scaling the selected flow input.
Only visible with energy package (option) and selected flow input.

m3/h, I/h, ft2/m, ft3/h, gpm, gal/h, kg/h, t/h, ton/h, Ib/h

m3/h

Flow installation point

Navigation Expert - Application > Maths > Maths x - Flow installation point
Direct access code: 400103-0xx
Examples: Maths 1: 400103-000; Maths 4: 400103-003
Description Please specify where the flow sensor is installed. This is important so that the correct
temperature is used for density calculation.
Only visible with energy package (option) and active flow input.
Options Steam, Water, Warm, Cold (depending on the selected application)
Factory setting Steam or warm (depends on selected application)
Pressure
Navigation Expert - Application » Maths > Maths x - Pressure
Direct access code: 400104-0xx
Examples: Maths 1: 400104-000; Maths 4: 400104-003
Description Please select a pressure input. If you select "deactivated" the temperature input is used to
calculate the saturated steam conditions.
Only visible with energy package (option) and selected steam application.
Options Switched off, Universal input x, Maths x
All active inputs are available for selection.
Factory setting Switched off

Engineering unit

Navigation
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Expert - Application - Maths > Maths x > Engineering unit
Direct access code: 400105-0xx
Examples: Maths 1: 400105-000; Maths 4: 400105-003
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Description

Options

Factory setting

Please select the unit used for scaling the selected pressure input.
Only visible with energy package (option) and selected steam application.
Only visible with energy packet (option) and active pressure input.

bar (a), psi (a), MPa (a), inH20 (a), bar (g), psi (g), MPa (g), inH20 (g)

bar (a)

Temperature (water/steam/warm)

Navigation

Description

Options

Factory setting

Expert > Application > Maths - Maths x > Temperature (water/steam/warm)
Direct access code: 400106-0xx
Examples: Maths 1: 400106-000; Maths 4: 400106-003

Please select the temperature input used to measure the warm side (or steam line). In
steam applications, if you select "deactivated" the pressure is used to calculate the saturated
steam conditions.

Only visible with energy package (option) and selected energy function.

Switched off, Universal input x, Maths x
All active inputs are available for selection.

Switched off

Temperature (steam/cold)

Navigation

Description

Options

Factory setting

Expert > Application > Maths - Maths x > Temperature (steam/cold)
Direct access code: 400107-0xx
Examples: Maths 1: 400107-000; Maths 4: 400107-003

Please select the temperature input used to measure the cold side (or condensate line).
Only visible with energy package (option) and selected heat difference measurement.

Switched off, Universal input x, Maths x
All active inputs are available for selection.

Switched off

Engineering unit

Navigation

Description
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Expert - Application - Maths - Maths x - Engineering unit
Direct access code: 400108-0xx
Examples: Maths 1: 400108-000; Maths 4: 400108-003

Please select the unit used for scaling the selected temperature sensors.
Only visible with energy package (option) and selected energy function.
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Options °C,°F, K
Factory setting °C
Medium
Navigation Expert - Application » Maths - Maths x > Medium
Direct access code: 400110-0xx
Examples: Maths 1: 400110-000; Maths 4: 400110-003
Description Select a cooling medium. If the medium used is not in list, select ethylene glycol or
propylene glycol.
Only visible with energy package (option) and application = Water/Glycol heat difference.
Options Ethylene-glycol, Antifrogen N, Glykosol N, Propylene-glycol
Factory setting Ethylene-glycol

Water/Glycol concentrat.

Navigation

Description

User entry

Factory setting

Expert - Application - Maths - Maths x - Water/Glycol concentrat.
Direct access code: 400109-0xx
Examples: Maths 1: 400109-000; Maths 4: 400109-003

Concentration of the water/glycol mixture in vol % (0-60 %).
Only visible with energy package (option) and application = Water/Glycol heat difference.

0 to 60 %

20 %

The result is

Navigation
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Expert - Application - Maths - Maths x - The result is
Direct access code: 400003-000
Examples: Maths 1: 400003-000; Maths 4: 400003-003
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Description Configure which data type the calculation returns. This setting affects how the channel
saves and is displayed.
If you add 2 analog channels, for example, the result is a "current value".
If you logically link 2 channels, for example, (digital 1 AND digital 2), the result is a "state"
(on/off).
Instantaneous value: If, for example, 2 analog channels are added (AI(1;1)+AI(1;2)), the
result is an instantaneous value.
State: The state/status of an individual analog input can be output as the result. A relay
can also be actuated as a result.
Counter: If, for example, 2 counters from digital inputs are added (DI(3;1)+DI(3;5)), the
result is a counter.
Operating time from status: The status (logical "1" or "0") of one or more digital inputs that
are connected by addition can be analyzed. If the result of the calculation is not equal to O,
the counter for the operating time starts. The time is increased by 0.1 s every 100 ms.
Operating time from total: If several digital inputs that are configured as "operational time"
are added together, the result is the total of all the individual operating times.
Control input: The function corresponds to a digital input that has been configured as a
control input.

Options Instantaneous value, State, Counter, Operating time from status, Operating time from
total, Control input, Efficiency

Factory setting Instantaneous value

Plot type

Navigation Expert - Application > Maths - Maths x - Plot type

Direct access code: 400015-000
Examples: Maths 1: 400015-000; Maths 4: 400015-003

Description The mathematics channels are recalculated every 100 ms.
Depending on the save cycle, the selected data are determined/saved from the calculated
values.

Options Instantaneous value, Average, Minimum value, Maximum value, Minimum + Maximum,
Counter, Current value + Counter

Factory setting Average

Engineering unit

Navigation

Description

User entry
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Expert > Application - Maths - Maths x - Engineering unit
Direct access code: 400004-000
Examples: Maths 1: 400004-000; Maths 4: 400004-003

Unit of the calculated value.
Only visible if the result is = instantaneous value, counter or efficiency

Text (max. 6 characters)
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Engineering unit

Navigation

Description

Options

Factory setting

Expert - Application - Maths - Maths x > Engineering unit
Direct access code: 400111-000
Examples: Maths 1: 400111-000; Maths 4: 400111-003

Unit of the calculated value.
Only visible with energy package (option) and selected energy function.

kW, MW, GJ/h, kBtu/m, kBtu/h, MBtu/h, ther/m, ther/h, ton, RT, kg/h, t/h, lbs/h, ton/h,
kg/m?, Ib/ft3, kKJ/kg, Btu/lb

(Depends on the selected function)

Decimal point

Navigation

Description

Options

Factory setting

Expert - Application - Maths - Maths x - Decimal point
Direct access code: 400005-000
Examples: Maths 1: 400005-000; Maths 4: 400005-003

Number of places after decimal point for the display.

Only visible if function = formula editor, energy calculation, mass calculation, density
calculation, calculation of heat quantity and the result is = instantaneous value, counter or
efficiency.

None, One (X.Y), Two (X.YY), Three (X.YYY), Four (X.YYYY), Five (X.YYYYY)

One (X.Y)

Action

Navigation

Description

198

Expert > Application - Maths > Maths x - Action
Direct access code: 400006-000
Examples: Maths 1: 400006-000; Maths 4: 400006-003

Set up the function of the control input.
Only visible if the result is = control input.

Action Description

Start/stop recording The device only saves data as long as a high signal is present.

Screensaver on Switches backlight/display off, low = off, high = on.

Lock setup The user can only change the setup if a low signal is present.

Time synchronization If a high signal is applied, the device rounds the system time up or down (only for
low-high change) to the nearest minute: 0 to 29 - Round down; 30 to 59 -
round up.

Change group When switching low->high the display switches to the next active group.
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Action

Description

Set point monitoring
on/off

The entire set point monitoring function of the device can be switched on (for
'high") or switched off (for "low").

Individual LV on/off

The monitoring of a selected limit value can be switched on (high) or off (low).

Block keyboard/navigator

The device can only be operated if a low signal is present. Otherwise all key
activation and navigator actions are discarded.

Start/stop analysis 1-4

Starts/ends one of the max. 4 external analyses (the analysis runs only as long as
the signal is high). Measured value acquisition for the graphic display continues.
Batches are also started/ended with this function.

Note: This function is not available in the case of batch and control input via a
maths channel.

(option)

Reset batch number x

Resets the automatically generated batch number (1..x) to O (in the event of a
LowHigh change).

(option)

Batch x limit values on/off

Switches the limits of batch x on/off.

The limits relating to the batch are determined based on the group settings (via the
channels assigned to the batch).

If a channel is assigned to several batches, the limits for this channel are not
disabled.

Options Switched off, Start/stop recording, Screen saver on, Lock setup, Time synchronization,
Change group, Set point monitoring on/off, Individual LV on/off, Block keyboard/
navigator, Start/stop analysis x, Reset batch no. x, Batch x limits on/off

Factory setting Switched off

Set point
Navigation Expert - Application - Maths - Maths x - Set point
Direct access code: 400019-000
Examples: Maths 1: 400019-000; Maths 4: 400019-003

Description Select the set point which should be switched on or off by means of this control input.
Only visible if Action = Individual LV on/off.

Options Switched off, Set point x

Factory setting Switched off

Switches relay

Navigation

Description

Options
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Expert > Application » Maths - Maths x - Switches relay
Direct access code: 400007-000
Examples: Maths 1: 400007-000; Maths 4: 400007-003

Switches the respective relay when the digital input is low or high.
Only visible if the result is = control input or state.

Not used, Relay x

All the available relays are displayed
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Factory setting

Not used

Description 'H'

Navigation

Description

User entry

Factory setting

Expert - Application > Maths > Maths x - Description 'H
Direct access code: 400008-00x
Examples: Maths 1: 400008-000; Maths 4: 400008-003

Condition description when the digital input is active. This text is both shown in the
display and saved to memory.
Only visible if the result is = control input or state.

Text (max. 6 characters)

On

Description 'l

Navigation Expert - Application » Maths > Maths x - Description L
Direct access code: 400009-00x
Examples: Maths 1: 400009-000; Maths 4: 400009-003
Description Condition description when the digital input is not active. This text is both shown in the
display and saved to memory.
Only visible if the result is = control input or state.
User entry Text (max. 6 characters)
Factory setting Off
Save event
Navigation Expert - Application > Maths - Maths x > Save event
Direct access code: 400010-00x
Examples: Maths 1: 400010-000; Maths 4: 400010-003
Description Determines whether the condition change from low to high or high to low is stored in the
event log.
ﬂ Requires higher memory capacity.
Only visible if the result is = control input or state.
Options No, Yes
Factory setting Yes
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Event message

Navigation

Description

Options

Factory setting

Expert - Application » Maths > Maths x > Event message
Direct access code: 400018-00x
Examples: Maths 1: 400018-000; Maths 4: 400018-003

'Do not acknowledge": No message is shown if the state of the mathematics channel
changes.

"Acknowledge": A message window is shown on the screen which has to be acknowledged
by operating a push button.

Only visible if the result is = control input or state.

Do not acknowledge, Acknowledge

Do not acknowledge

Event text L->H

Navigation

Description

User entry

Expert - Application - Maths > Maths x - Event text L->H
Direct access code: 400011-00x
Examples: Maths 1: 400011-000; Maths 4: 400011-003

Description of condition change from low to high. Event text is stored (e.g. Start filling).
Only visible if the result is = control input or state.

Text (max. 22 characters)

Event text H->L

Navigation

Description

User entry

Expert - Application - Maths > Maths x - Event text H->L
Direct access code: 400012-00x
Examples: Maths 1: 400012-000; Maths 4: 400012-003

Description of condition change from high to low. Event text is stored (e.g. Stop filling).
Only visible if the result is = control input or state.

Text (max. 22 characters)

Record duration

Navigation
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Expert - Application > Maths > Maths x - Record duration
Direct access code: 400013-00x
Examples: Maths 1: 400013-000; Maths 4: 400013-003
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Description The duration between "On" and "Off" can be recorded. The duration is appended to the "Off"
event text (<hhhh>h<mm>:<ss>).
Power failure times do not affect the duration. If the digital channel was "on" before the
power failure and is still "on" after the power failure, the duration continues.
Only visible if the result is = control input or state.
Options No, Yes
Factory setting No
Zoom start
Navigation Expert - Application » Maths - Maths x - Zoom start
Direct access code: 400016-00x
Examples: Maths 1: 400016-000; Maths 4: 400016-003
Description If the whole value range is not used, you can configure the lower value of the required
section here. Zooming does not affect the save function.
Only visible if the result is = instantaneous value.
User entry Number (max. 8 digits)
Factory setting 0
Zoom end
Navigation Expert - Application - Maths > Maths x > Zoom end
Direct access code: 400017-00x
Examples: Maths 1: 400017-000; Maths 4: 400017-003
Description Like "Zoom start". However, enter the upper value of the required range here.
Only visible if the result is = instantaneous value.
User entry Number (max. 8 digits)
Factory setting 100
Totalizer

(Online configuration)

Navigation

202

Expert - Application > Maths > Maths x - Totalizer
Direct access code: 400014-00x
Examples: Maths 1: 400014-000; Maths 4: 400014-003
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Description

User entry

Factory setting

Initial setting for the totalizer. Useful when continuing measurements recorded to date
with an (electro)-mechanical counter.

Only visible if the result is = counter, operating time from status or operating time from
total.

Number (max. 15 digits)

0

Formula editor
Enter the desired calculation formula.
The formula can be any combination of arithmetic calculations and logical operations.

Analog, digital or already active mathematics channels can be used.

Formula editor

Navigation

Description

Endress+Hauser

Expert - Application - Maths - Maths x > Formula
Direct access code: 400002-000

ﬂ x = place holder for selected mathematics channel

ﬂ A text field with the formula currently used appears. If the field is empty a formula
has not yet been defined for the mathematics channel.

Individual channels can be mathematically linked and calculated with functions. The
mathematics channels calculated in this way are treated as "real' channels, regardless of
whether they are connected conventionally or via fieldbus. Enter the desired calculation
formula.

The formula can be any combination of arithmetic calculations and logical operations.
Analog and digital channels can be used, as can mathematics channels that are already
active.

A formula with up to 200 characters can be created using this editor. If the formula is
finished, click OK to close the editor and accept the formula entered. The common entry
and arithmetic operators and inputs are described in detail in the following sections.

Inputs
Inputs are described in the formula using the following syntax:

Input type (signal type;channel number)

Type of input | Description

Al Analog inputs

DI Digital inputs

MI Mathematics inputs

Signal type Description

1 Instantaneous value (measured value)
2 State

3 Counter/operational time

203




Appendix

Memograph M, RSG45

204

Signal type

Description

5

Validity:

The validity of an analog or maths channel is returned.
The relayed value of the function is O in the event of:

= QOpen circuit

= Invalid measured value

= Sensor error

= Input signal too high/low

= Error value

The relayed value of the function is 1 in the event of:
Measured value OK, even if the limit value is breached

Delta count

7..10

Analysis 1..4

11

Totalizer

12

Duration

Not all signal types are available for each input type. These depend on the respective
device options.

Channel number:

Analog channel 1 = 1, analog channel 2 = 2, digital channel 1 =1, ...

Examples:
DI(2;4) State of digital channel 4
AI(1;1) Instantaneous value of analog channel 1

Status of a limit value:
LMT (type, limit number)

Type Description
1 'Instantaneous value": Currently set limit value
2 "State": The function returns the status of a limit value
The result is 1 if the limit value is violated.
The result is O if
= The limit value is not violated
® The limit value is not switched on
= Limits monitoring is switched off (e.g. per control input)
Examples:
LMT (1;1) Instantaneous value of limit value 1
LMT (2;3) State of limit value 3

Priority of operators / functions

The formula is processed based on universally applicable mathematics rules:
= Parentheses first

= Exponents before multiplication or division

= Multiplication or division before addition or subtraction
= Calculate from left to right
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Operators

Arithmetic operators:

Operator | Function

+ Addition

- Subtraction / negative sign

* Multiplication

/ Division

% Modulo (remainder of division x/y), see function "mod"
" x highy

Relational operators:

Operator | Function

> Greater than

>= Greater than or equal to
< Less than

<= Less than or equal to

= Equal to

<> Not equal to

Logical operators:

Functi | Syntax Description Example
on
| Value 1 | | Logical "or" (see also function "or") DI(2;1) | | DI(2;2)
Value 2
&& Value 1 && Logical "and" (see also function "and") DI(2;1) && DI(2;2)
Value 2
Functions
Standard functions:
Functi | Syntax Description Example
on
In the |In(number) Returns the natural logarithm of a number. Natural In(86) = 4.454347

logarithms are based on a constant e
(2.71828182845904). For values < 0 the result is
undefined. The device continues with 0

log log(number) Calculates the logarithm of the argument for base 10. For | log(10) = 1
values < O the result is undefined. The device continues
with 0.

exp exp(number) Exponentiates the base e with the number specified as the | exp(2.00) =
argument. The constant e is the basis for the natural 7.389056

logarithm and has the value 2.71828182845904.

abs abs(number) Returns the absolute value of a number. The absolute value |abs(-1.23)=1.23
of a number is the number without its sign.

pi pi() Returns the value of the number PI
(3.14159265358979323846264)

sqrt sqrt(number) sqrt calculates the positive square root of the argument sqrt(4) =2
"Number". In the case of negative values the result is
undefined. The device continues with 0.
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Functi | Syntax Description Example
on
mod mod (number; Returns the remainder of a division. The result has the mod(5;2) =1
divisor) same sign as the divisor. If the divisor has the value 0, the
result is undefined. The device continues with 0.
rnd rnd(number; Rounds a number to a certain number of decimal places. rnd(2.15;1) = 2.2

number_digits)

‘Number" is the number to which you wish to round up/
down.

(
rnd(2.149;1) =2.1
rnd(-1.475;2) =-1.48
rnd(-

(

(

(

'Number_digits" indicates to how many decimal places you 1.473;2) =-1.47
wish to round the number up/down. rnd(21.5;-1) = 20
@ Notes: rnd(5.5;-2) = 10
= [f"Number_digits"is greater than O (zero), the md(5.5-3) =0
number is rounded to the specified number of
decimal places.
= [f'Number_digits"is equal to 0, the number is
rounded to the next whole number.
= [f'Number_digits"is less than O, the part of the
number to the left of the decimal separator is
rounded.
Trigonometric functions:
Functi | Syntax Description Example
on
rad rad(number) Conversion of degrees to radian rad(270) = 4.712389
Degre | Degrees Conversion of radian to degrees Degrees(pi()) = 180
es (number)

The following functions expect an angle in the radian as the arqument. If the angle lies in
the degree, it must be converted to the radian by multiplying it with pi()/180.
Alternatively the function "rad" can be used:

Functi | Syntax Description Example

on

sin sin(number) Returns the sine of a number sin(pi()) -> sine of pi
radian
sin(30*pi()/180) ->
sine of 30 degrees
(0.5)

cos cos(number) Conversion of radian to degrees Degrees(pi()) = 180

tan tan(number) Returns the tangent of the argument tan(0.785) = 0.99920
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With the following functions the returned angle is specified in radian with a value
between -pi/2 and +pi/2. If the result is to be expressed in degrees, the respective result
must be multiplied by 180/pi() or the "Degrees" function used:

Functi | Syntax Description Example
on
asin asin(number) Returns the arc sine or inverse sine of a number (inverse arcsin(-0.5) = -
function). The arc sine expects a real argument in the range | 0.5236
from -1 to +1. In the case of values outside of this range the | arcsin(-0.5)*180/
device continues with O. pi() =-30°
acos acos(number) Returns the arc cosine or inverse cosine of a number arccos(-0.5) =
(inverse function). Arc cosine expects a real argument in 2.094395
the range from -1 to +1. In the case of values outside of this
range the device continues with 0.
atan atan(number) Returns the arc tangent or inverse tangent of a number atan(1) = 0.785398
(inverse function).
Logical functions:
Functi | Syntax Description Example
on
if if (check; "Check" is any value or expression; the result can be TRUE or | if(x>10;1;0)
then_value; FALSE. This argument can use any comparative calculation | If value x is greater
otherwise_value | operator. Then_value"is the value returned if "Check" is than 10 the function
) TRUE. "Otherwise_value"is the value returned if "Check" is returns 1, otherwise O
FALSE.
or or(truel;true2) | Returns TRUE if an argument is TRUE. Returns FALSE if all | or(2>1;3>2) = true
arguments are FALSE. or(2<1;3>2) = true
Note: See also operator"| |" or(2<1;3<2) = false
and and(truel;true2 | Returns TRUE if both arguments are TRUE. If one of the and(2>1;3>2) = true
) arguments is FALSE, this function returns the value FALSE | and(2<1;3<2) = false
Note: See also operator "&&"
not not(truth value) | Inverts the value of an argument. NOT can be used if a value | not(false) = true
does not match a certain other value.

The XX in the following functions stands for one of the inputs described under > B 203.
Range functions can only ever be executed with one input type.

Range functions:
Functi | Syntax Description Example
on
sumX | sumXX(Type;Fro | Totals the values for the specified input signal range. sumXX (1;2;5) = Sum
X m;To) "Type": Signal type (see > B 203)) of all instantaneous
"From": Channel number from which the values should be values from channel 2
totaled (1 = channel 1) to5
"To": Channel number to which the values should be totaled
(1 = channel 1)
avgXX | avgXX(Type;Fro | Calculates the average for the specified input signal range. | avgXX(1;1;6)
m;To)
minXX | minXX(Type;Fro | Returns the lowest value for the specified input signal minXX(1;1;6)
m;To) range.
maxX | maxXX(Type;Fro | Returns the highest value for the specified input signal maxXX (1;1;6)
X m;To) range.
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Date/time functions:

Functi | Syntax
on

Description

Example

dow dow()

Returns the current day of the week as a number between 1
and 7.

Sunday = 1
Monday = 2
Tuesday = 3
Wednesday = 4
Thursday = 5
Friday = 6
Saturday = 7

time | time()

Returns the current time in seconds.

00:00=0s
12:00 =43,200s
23:59:59 = 86,399 s

Decimal separator

Both the decimal point and the decimal comma can be used in the formula editor.
Thousand separators are not supported.

Check whether formula is valid or malfunctions

A formula is invalid if:

= The channels used are not switched on or are in the wrong operating mode (is not
verified during formula entry as the channel could be switched on subsequently)

= [t contains invalid characters/formulas/functions/operators

= Syntax errors (e.g. wrong number of parameters) occur in the formulas

= There are incorrect parentheses in the formula (number of open parentheses unequal to
number of closed parentheses)

= Division is by zero

= A channel refers to itself (infinite recursion)

Invalid formulas are deactivated when the setup is accepted or the device is started.

Undetectable errors: wherever possible, errors in the formula are reported immediately
during input. However, given the possible complexity of the formula entered (e.g. nested
formulas) it is not possible to detect every error.

"DP flow" submenu (option "Energy package")

Navigation

Description

Expert - Application > Maths > Maths x > DP flow

Configuration of a flow measurement following the differential pressure process.
Only visible if function = mass calculation DP flow.

Differential pressure

Navigation

Description

Options

208

Expert - Application » Maths - Maths x > DP flow - Differential pressure
Direct access code: 400115-00x
Examples: Maths 1: 400115-000; Maths 4: 400115-003

Please select differential pressure input.

Switched off, Universal input x, Digital input x, Maths x
All active inputs are available for selection.
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Factory setting Switched off

DP unit

Navigation Expert - Application - Maths > Maths x > DP flow - DP unit
Direct access code: 400116-00x
Examples: Maths 1: 400116-000; Maths 4: 400116-003

Description Unit of the differential pressure.

Options mbar, inH20

Factory setting mbar

Diameter unit

Navigation Expert - Application » Maths > Maths x > DP flow - Diameter unit
Direct access code: 400118-00x
Examples: Maths 1: 400118-000; Maths 4: 400118-003

Description Unit of the internal diameter of the pipe.

Options mm, Inch

Factory setting mm

Dat20°C

Navigation Expert > Application > Maths > Maths x - DP flow - D at 20 °C
Direct access code: 400119-00x
Examples: Maths 1: 400119-000; Maths 4: 400119-003

Description Internal pipe diameter (D) under design conditions at 20 °C/68 °F.

User entry Number (max. 8 characters)

Factory setting 100 (mm or inches)

dat20°C
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Navigation Expert > Application > Maths > Maths x - DP flow - d at 20 °C
Direct access code: 400120-00x
Examples: Maths 1: 400120-000; Maths 4: 400120-003
Description Internal pipe diameter of the throttle (d) under design conditions at 20 °C/68 °F.
User entry Number (max. 8 characters)
Factory setting 70 (mm or inches)
K-factor
Navigation Expert - Application - Maths - Maths x - DP flow - K-factor
Direct access code: 40012 1-00x
Examples: Maths 1: 400121-000; Maths 4: 400121-003
Description Set the K-factor (blockage factor) for the pitot tube (see nameplate on the probe).
Only visible if Device type= Pitot tube.
User entry Number (max. 8 characters)
Factory setting 0.6

Pipe material

Navigation Expert > Application »> Maths > Maths x - DP flow - Pipe material
Direct access code: 400127-00x
Examples: Maths 1: 400127-000; Maths 4: 400127-003
Description Material of the pipe.
Options Carbon steel, Stainless steel, 1.5415/A182F1, 1.7335/A182F12, 1.7380/A182F22,
1.4922, 1.4401/316, 1.4404/316L, 1.4571/316Ti
Factory setting C-steel
Density
Navigation Expert - Application > Maths > Maths x > DP flow - Density
Direct access code: 400123-00x
Examples: Maths 1: 400123-000; Maths 4: 400123-003
Description Please select density input or mathematics channel, in which the density is calculated.
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Only visible if application = Liquids DP flow or Gas DP flow.

Endress+Hauser



Memograph M, RSG45

Appendix

Options Switched off, Universal input x, Digital input x, Maths x
All active inputs are available for selection.
Factory setting Switched off
Density unit
Navigation Expert - Application > Maths - Maths x - DP flow - Density unit
Direct access code: 400124-00x
Examples: Maths 1: 400124-000; Maths 4: 400124-003
Description Please select the density unit.
Only visible if application = Liquids DP flow or Gas DP flow.
Options kg/m?, b/ft?
Factory setting kg/m?
Design density
Navigation Expert - Application » Maths > Maths x > DP flow - Design density
Direct access code: 400125-00x
Examples: Maths 1: 400125-000; Maths 4: 400125-003
Description Density under design conditions (at design pressure/temperature).
Only visible if design = V-cone or Gilflo.
User entry Number (max. 8 characters)
Factory setting 1000 (kg/m? or Ib/ft3)

Isentropic exponent

Navigation

Description

User entry

Factory setting
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Expert - Application - Maths - Maths x - DP flow - Isentropic exponent
Direct access code: 400128-00x
Examples: Maths 1: 400128-000; Maths 4: 400128-003

Input of the kappa isentropic exponent. (Required in order to calculate the expansion
number).
Only visible if application = gas DP flow.

Number (max. 8 characters)

1.2
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"Viscosity" submenu

Navigation

Description

Expert - Application > Maths > Maths x > DP flow - Viscosity

Input of the viscosity at two support points. (Needed to calculate the Reynolds number and
flow coefficient).
Only visible if application = Liquids DP flow or Gas DP flow.

Support point 1

Temperature
Navigation Expert > Application > Maths > Maths x > DP flow - Viscosity - Temperature
Direct access code: 400130-00x
Examples: Maths 1: 400130-000; Maths 4: 400130-003
Description Temperature
User entry Number (max. 8 characters)
Factory setting 0
Viscosity
Navigation Expert - Application > Maths - Maths x > DP flow - Viscosity - Viscosity
Direct access code: 400131-00x
Examples: Maths 1: 400131-000; Maths 4: 400131-003
Description Viscosity at the specified temperature.
User entry Number (max. 8 characters)
Factory setting lcp
Support point 2
Temperature

212
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Navigation Expert - Application - Maths - Maths x - DP flow - Viscosity - Temperature
Direct access code: 400135-00x
Examples: Maths 1: 400135-000; Maths 4: 400135-003

Description Temperature

User entry Number (max. 8 characters)

Factory setting 100

Viscosity

Navigation Expert - Application - Maths > Maths x - DP flow - Viscosity - Viscosity
Direct access code: 400136-00x
Examples: Maths 1: 400136-000; Maths 4: 400136-003

Description Viscosity at the specified temperature.

User entry Number (max. 8 characters)

Factory setting 0.3 ¢cp

"Totalization" submenu

Navigation Expert - Application - Maths > Maths x - Totalization
Description Settings only needed if the calculated value - e.g. for quantity calculation - should be
integrated. Analysis time frames, see "Signal analysis".
Totalization
Navigation Expert - Application - Maths - Maths x - Totalization - Totalization
Direct access code: 400050-00x
Examples: Maths 1: 400050-000; Maths 4: 400050-003
Description By totalizing the analog signal (e.g. flow rate in m3/h) quantities (in m?) can be calculated.
Options No, Yes
Factory setting No

Totalization base
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Navigation Expert > Application » Maths > Maths x - Totalization - Totalization base
Direct access code: 400051-00x
Examples: Maths 1: 400051-000; Maths 4: 400051-003
Description Select the required time base. Example: ml/s -> time base seconds (s); m3/h -> time base
hours (h).
Only visible if totalization = yes.
Options Second (s), Minute (min), Hour (h), Day (d)
Factory setting Second (s)
Unit
Navigation Expert - Application > Maths - Maths x - Totalization - Unit
Direct access code: 400052-00x
Examples: Maths 1: 400052-000; Maths 4: 400052-003
Description Enter the unit for the calculated quantity (e.g. "'m*).
Only visible if totalization = yes.
User entry Text (max. 6 characters)

Total. eng. unit (option "Energy package")

Navigation

Description

Options

Expert - Application » Maths > Maths x - Totalization - Total. eng. unit.
Direct access code: 400112-00x
Examples: Maths 1: 400112-000; Maths 4: 400112-003

Select the unit of the quantity determined by means of totalization here.
Only visible if function = energy or mass calculation and totalization = yes.

kWh, MWh, M]J, GJ, kBtu, MBtu, tonh, therm, kg, t, lbs, ton

Low flow cut off

Navigation

214

Expert - Application - Maths > Maths x - Totalization - Low flow cut off
Direct access code: 400053-00x
Examples: Maths 1: 400053-000; Maths 4: 400053-003
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Description

User entry

Factory setting

If the volume flow recorded is below the set value, these quantities are not added to the
counter.

If the input is scaled from O to y, or if the pulse input is used, all values that are smaller
than the set value are not recorded.

If the input is scaled from -x to +y, all values around the zero point (e.g. also negative
values) are not recorded.

Only visible if totalization = yes.

Number (max. 8 digits)

0

Calc. factor

Navigation Expert - Application - Maths - Maths x - Totalization - Calc. factor
Direct access code: 400054-00x
Examples: Maths 1: 400054-000; Maths 4: 400054-003
Description Factor for calculating the integrated value (e.g. the transmitter delivers /s -> totalization
base = second -> engineering unit required is m? -> enter factor 0.001)
Only visible if totalization = yes.
User entry Number (max. 8 digits)
Factory setting 1.0
Totalizer

(Online configuration)

Navigation

Description

User entry

Factory setting

Expert - Application - Maths > Maths x - Totalization - Totalizer
Direct access code: 400055-00x
Examples: Maths 1: 400055-000; Maths 4: 400055-003

Initial setting for the totalizer. Useful when continuing measurements recorded to date
with an (electro)-mechanical counter.
Only visible if totalization = yes.

Number (max. 15 digits)

0

"Linearization" submenu

Navigation

Description
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Expert - Application > Maths > Maths x - Linearization

Linearization settings.
Only visible if Function = Formula Editor.
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Linearization
Navigation Expert - Application > Maths - Maths x - Linearization - Linearization
Direct access code: 400301-00x
Examples: Maths 1: 400301-000; Maths 4: 400301-003
Description Specify whether this input should be linearized.
Options No, Yes
Factory setting No

Number of Points

Navigation

Description

User entry

Factory setting

Expert - Application » Maths > Maths x - Linearization - Number of Points
Direct access code: 400302-00x
Examples: Maths 1: 400302-000; Maths 4: 400302-003

Specify how many support points your linearization table has.
Note: The first and last point always has to correspond to the start and end of the

measuring range respectively.

2to32

Dim. linearized value

Navigation Expert - Application - Maths > Maths x - Linearization - Dim. linearized value
Direct access code: 400303-00x
Examples: Maths 1: 400303-000; Maths 4: 400303-003
Description Unit/dimension for the linearized value.
Note: The first and last point always has to correspond to the start and end of the
measuring range respectively.
User entry Text (max. 6 characters)
Zoom start
Navigation Expert - Application » Maths - Maths x - Linearization - Zoom start
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Direct access code: 400304-00x
Examples: Maths 1: 400304-000; Maths 4: 400304-003
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Description If the total transmitter range is not used, you can enter the lower value of the required
section here (higher resolution).
Example: Transmitter 0-14 pH, required section: 5-9 pH. Set "5" here. Zooming does not
affect the save function.

User entry Number (max. 8 characters)

Factory setting 0

Zoom end

Navigation Expert - Application » Maths - Maths x - Linearization - Zoom end

Direct access code: 400305-00x
Examples: Maths 1: 400305-000; Maths 4: 400305-003

Description Like "Zoom start". However, enter the upper value of the required range here.
Example: Transmitter 0-14 pH, required section: 5-9 pH. Input here:"9".

User entry Number (max. 8 characters)

Factory setting 100

"Points" submenu

Navigation Expert - Application - Maths - Maths x - Linearization - Points

Description Enter the support points of the linearization table here.
Note: The first and last point always has to correspond to the start and end of the
measuring range respectively. The support points can only be viewed in the PC software
here. To change the support points use the "Edit table" switch.

Check table

Navigation Expert - Application » Maths - Maths x - Linearization - Points - Check table
Direct access code: 400306-00x
Examples: Maths 1: 400306-000; Maths 4: 400306-003

Description Here you can check whether the linearization table has been entered correctly.

Options No, Yes

Factory setting No

Sort table
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Navigation Expert - Application » Maths > Maths x - Linearization - Points - Sort table
Direct access code: 400307-00x
Examples: Maths 1: 400307-000; Maths 4: 400307-003
Description You can sort the linearization table here.
Options No, Yes
Factory setting No

x-value (1-32)

Navigation

Description

User entry

Factory setting

Expert - Application - Maths > Maths x - Linearization - Points - x-value
(1-32)
Direct access code, x-value 1: 400310-00x
Direct access code, x-value 2: 400312-00x
Examples: Maths 1, x-value 1: 400310-000; Maths 4: 400310-003

x-value for the linearization (value from the device input). e.g. 10 cm corresponds to 20
liters --> enter 10.

Number (max. 8 characters)

0

y-value (1-32)

Navigation

Description

User entry

Factory setting

Expert - Application > Maths > Maths x - Linearization - Points - y-value
(1-32)
Direct access code, y-value 1: 400311-00x
Direct access code, y-value 2: 400313-00x
Examples: Maths 1, y-value 1: 400311-000; Maths 4: 400311-003

Enter the y-value that the measured x-value corresponds to e.g. 10 cm corresponds to 20
liters --> enter 20.

Number (max. 8 characters)

0

"Fault mode" submenu

Navigation

Description

218

Expert - Application > Maths > Maths x - Fault mode

Contains settings that specify how this channel is to behave in the event of an error (e.g. if
an input channel has a cable open circuit or there is division by 0).
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Wet steam alarm

Navigation Expert - Application - Maths - Maths x - Fault mode > Wet steam alarm
Direct access code: 400113-00x
Examples: Maths 1: 400113-000; Maths 4: 400113-003
Description Condensation of steam! Process temperature = saturated steam temperature = condensate
temperature.
Only visible if application = steam heat quantity or steam heat difference.
Options Counter stop, Saturated steam calculation
Factory setting Counter stop
On error
Navigation Expert - Application > Maths > Maths x> Fault mode - On error
Direct access code: 400060-00x
Examples: Maths 1: 400060-000; Maths 4: 400060-003
Description Configure what value the device should continue working with (for calculations) if the
measured value is not valid (e.g. cable open circuit).
Options Invalid calculation, Error value
Factory setting Invalid calculation
Error value
Navigation Expert - Application - Maths > Maths x-> Fault mode - Error value
Direct access code: 400061-00x
Examples: Maths 1: 400061-000; Maths 4: 400061-003
Description The device continues calculating with this value in the event of an error.
Only visible if On error = Error value.
User entry Number (max. 8 digits)
Factory setting 0
Copy settings
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Navigation Expert - Application - Maths > Maths x - Copy settings

Direct access code: 400200-00x

Examples: Maths 1: 400200-000; Maths 4: 400200-003
Description Copies settings from actual channel to selected channel.
Options No, In maths. channel x

Users can choose from all the available maths channels.

Factory setting No

"Signal analysis" submenu

Navigation Expert - Application - Signal analysis
Description Contains settings for signal analysis (saving).
Analysis x
Navigation Expert - Application - Signal analysis - Analysis x
Direct access code: 44000x-000
Examples: Analysis 1: 440000-000; Analysis 4: 440003-000
Description For the set time frame, determines the minimum, maximum and average value or
quantities and operating times.
If the "Externally controlled" option is to be used, a digital input or a maths channel
must be set to "Function = Control input" and "Action = Start/stop analysis x".
Options Switched off, Externally controlled, 1min, 2Zmin, 3min, 4min, 5min, 10min, 15min, 30min,
1h, 2h, 3h, 4h, 6h, 8h, 12h
Daily analysis, Weekly analysis, Monthly analysis, Annual analysis
Factory setting Switched off

Synchron. time

Navigation

Description

User entry

Factory setting
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Expert - Application - Signal analysis - Synchron. time
Direct access code: 440004-000

Time for completing the signal analysis.
If, for example, 07:00 is set up then the daily analysis will run from 07:00 on the current
day until 07:00 on the following day.

Time

00:00
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Week starting on

Navigation

Description

Options

Factory setting

Expert - Application - Signal analysis > Week starting on
Direct access code: 440005-000

Configure what day the weekly analysis should start.
Only visible if at least one analysis = weekly analysis.

Sunday, Monday, Tuesday, Wednesday, Thursday, Friday, Saturday

Monday

Alarm statistics (option "Tele-Alarm")

Navigation

Description

Options

Factory setting

Expert - Application - Signal analysis - Alarm statistics
Direct access code: 440006-000

The following data can be determined via the signal analysis cycles (e.g. daily analysis):
= How often was the set point violated
= How long was the set point violated

No, Yes

No

Group days (option "Tele-Alarm")

Navigation

Description

Options

Factory setting

Expert - Application - Signal analysis - Group days
Direct access code: 440008-000

Set how often the weekly- monthly- or yearly analysis are to be calculated.

'No": each individual alarm is counted.

"Yes": The number of days within the analysis cycle in which at least one limit value
violation took place (e.g. required for the number of overflows in a storm overflow tank).

No, Yes

No

Reset to zero
(Online configuration)

Navigation
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Expert - Application - Signal analysis - Reset to zero
Direct access code: 440007-000
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Description

Options

Factory setting

Reset analysis.
Note: should only be executed after the device has taken over the setup.

Please select, Analysis x, Totalizer, All

Please select

Reset channel
(Online configuration)

Navigation

Description

Options

Factory setting

Expert - Application - Signal analysis - Reset channel
Direct access code: 440010-000

Reset analysis of a single channel.
Note: should only be executed after the device has taken over the setup.

Please select, Universal input x, Digital input x, Maths x, Set point x, Relay x
All active inputs are available for selection.

Please select

"Autom. printout" submenu

Navigation

Description

Expert - Application - Signal analysis > Autom. printout

Specify whether an automatic print-out should follow at the end of an evaluation.

The printout is only made if a USB printer is connected to the device or a network
printer is available.

For supported printers please refer to the Operating Instructions.

If the Batch option is selected, the printout is configured in the Batch mode/Print
menu.

Analysis x

Navigation

Description

Options
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Expert - Application - Signal analysis - Autom. printout - Analysis x
Direct access code, analysis 1: 440020-000
Direct access code, analysis 2: 440021-000
Direct access code, analysis 3: 440022-000
Direct access code, analysis 4: 440023-000

Specify whether an automatic print-out should follow at the end of an evaluation.

The print-out is only made if a USB printer is connected to the device!

For supported printers please refer to the Operating Instructions.

If the Batch option is selected, the printout is configured in the Batch mode/Print
menu.

No, Yes
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Factory setting

No

"Limits" submenu

Navigation Expert - Application - Limits
Description Limit values can monitor the measured values. A relay, for example, can be switched if a
limit value is violated.
Add limit value
Navigation Expert - Application - Limits > Add limit value
Direct access code: 450300-000
Description Adding a new limit value.
Options No, Yes
Factory setting No

Delete limit value

Navigation

Description
Options

Factory setting

Expert - Application - Limits - Delete limit value
Direct access code: 450301-000

Deleting a limit value from the list.
No, limit value x

No

Change set points

Navigation

Description

Options

Factory setting
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Expert - Application - Limits - Change set points
Direct access code: 450100-000

Specify where the limit values can be changed. If you select "Outside of setup also", you can
change limit values in the "Operation” menu as well as in "Setup". This allows you to adjust
your limit values to the process even if setup is locked.

Note: This function can/should be protected by the limit value code.

Only in setup, Outside of setup also

Only in setup
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"Set point x" submenu

Navigation Expert - Application - Limits - Limit x
Description View or change the setup for the selected alarm set point.
ﬂ x = place holder for selected limit value
Channel/value
Navigation Expert - Application - Limits - Limit x - Channel/value
Direct access code: 450000-0xx
Examples: Set point 1: 450000-000; Set point 30: 450000-029
Description Select which input/calculated value the limit value refers to.
Options Switched off, Universal input x, Digital input x, Maths x, Set point x
Factory setting Switched off
Type
Navigation Expert - Application - Limits - Limit x - Type
Direct access code: 450001-0xx
Examples: Set point 1: 450001-000; Set point 30: 450001-029
Description Type of limit value (depends on the input variable).
Options Switched off, Upper set point, Lower set point, Analysis x, Gradient dy/dt, Analysis x
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frequency, Analysis x duration, Inband, Outband
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Description of the individual set point types

Set point type/function Description

Hysteresis For every set point, the switch point can be controlled via a hysteresis.
The hysteresis is set as an absolute value (positive values only) in the unit of the respective channel (e.g. upper
set point = 100 m, hysteresis = 1 m: Set point on = 100 m, set point off = 99 m).

Upper set point The limit value is active if the value exceeds the configured value. The limit value is switched off if the limit

value, including hysteresis, is undershot.

Measured value
A

VRN

Setpoint
/ \ Hysteresis
Threshold
“off” 7 N

Setpoint “on”
Setpoint “off”

A0010187-EN

Lower set point

The limit is active if the value drops below the configured value. The limit value is switched off if the limit value,
including hysteresis, is exceeded.

Measured value
A

Threshold \ /
“off” \ /

Setpoint

Hysteresis

>t

Setpoint “on”
Setpoint “off”

A0010186-EN
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Set point type/function Description

Gradient dy/dt The "Gradient" operating mode is used to monitor the temporal change of the input signal. The alarm is
triggered if the measured value reaches or exceeds the preset value.

If a positive value has been set, the limit value is monitored on increasing gradients. In the case of negative
values the decreasing gradient is monitored.

The alarm is canceled when the gradient drops below the preset value. A hysteresis is not possible in the

Gradient operating mode. The alarm can be suppressed for the set time delay (unit: seconds s) in order to
decrease the sensitivity.

Measured value
A

T, = Time for gradient
evaluation (Time

M, .
base in seconds)

= Set point
MO—m

> t
Tm\

<“—> T, )
Setpoint “on”
Setpoint“off”
A0010188-EN
Inband The limit value is violated as soon as the measured value to be checked exceeds or drops below a preset

maximum or minimum respectively. The hysteresis must be monitored on the inside of the band. For the limit
value to no longer be violated, the value must lie within the hysteresis range.

Measured value
A

Setpoint /J/\\

Hysteresis

Hysteresis

Setpoint / \ / >t

Setpoint
active
Setpoint
not active

A0010192-EN
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Set point type/function

Description

Outband

The limit value is violated as soon as the measured value to be checked lies within a preset band between
minimum and maximum. The hysteresis must be monitored on the outside of the band. For the limit value to
no longer be violated, the value must lie outside of the hysteresis range.

Measured value
A

l/\ Hysteresis
/ \

Setpoint / \

Setpoint /] N\ Hysteresis
/ N >t
S N\

Setpoint
active
Setpoint
not active

A0010189-EN

Special case: Hysteresis and delay
for one limit value

In the special case that hysteresis and limit value delay are activated, one limit value is switched according to
the following principle. If hysteresis and limit value delay are activated, the delay becomes active when a limit
value is exceeded and measures the time from which the value is exceeded. If the measured value falls below
the limit value, the delay is reset. This also occurs if the measured value falls below the limit value, but
continues to be higher than the set hysteresis value. When the limit value is exceeded again, the time delay
once more becomes active and starts measuring from 0.

Measured

value ]?iléy Delay

>

etpoint Jd J/— \
ilysieresr k\ / \
\ N~

Delay time
is reset N
>t
Setpoint
active
Setpoint
not active

A0010193-EN

Factory setting Switched off
Identifier
Navigation Expert - Application - Limits - Limit x - Identifier
Direct access code: 450015-0xx
Examples: Set point 1: 450015-000; Set point 30: 450015-029
Description Name of the set point for identification purposes.
User entry Text (max. 16 characters)
Factory setting Limit x
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Set point
Navigation Expert - Application - Limits - Limit x - Set point

Direct access code: 450003-0xx

Examples: Set point 1: 450003-000; Set point 30: 450003-029
Description Limit value in the set process unit, e.g. in °C, m?/h.
User entry Number (max. 10 digits)
Factory setting 0
Set point 2
Navigation Expert - Application - Limits - Limit x - Limit 2

Direct access code: 450017-0xx

Examples: Set point 1: 450017-000; Set point 30: 450017-029
Description Enter the upper limit value for the band.

Only visible if type = inband or outband.

User entry Number (max. 8 digits)
Factory setting 0

Time span dt

Navigation

Description

User entry

Factory setting

Expert - Application - Limits - Limit x - Time span dt
Direct access code: 450014-0xx
Examples: Set point 1: 450014-000; Set point 30: 450014-029

Time span within which the signal must change by the specified value before it is
recognized as a set point.

Note: max. 60 seconds.

Only visible if type = gradient dy/dt.

0to60s

60s

Hysteresis (abs.)

228

Endress+Hauser



Memograph M, RSG45

Appendix

Navigation Expert - Application - Limits - Limit x - Hysteresis (abs.)
Direct access code: 450004-0xx
Examples: Set point 1: 450004-000; Set point 30: 450004-029
Description The alarm condition is only canceled when the signal has changed into the normal
operation range by the preset value.
User entry Number (max. 8 digits)
Factory setting 0
Time delay
Navigation Expert - Application - Limits - Limit x - Time delay
Direct access code: 450005-0xx
Examples: Set point 1: 450005-000; Set point 30: 450005-029
Description In order to be interpreted as an alarm the signal must exceed or undercut the preset value
by at least the time set up.
User entry 01t0 99999 s
Factory setting Os
Switches
Navigation Expert - Application - Limits - Limit x - Switches
Direct access code: 450006-0xx
Examples: Set point 1: 450006-000; Set point 30: 450006-029
Description Switches the appropriate output in the limit value state.
Options Not used, Relay x
Factory setting Not used
LV messages
Navigation Expert - Application - Limits - Limit x > LV messages
Direct access code: 450007-0xx
Examples: Set point 1: 450007-000; Set point 30: 450007-029
Description 'Do not acknowledge": Alarm condition is signaled by highlighting the tag name in red (no
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message is output).
"Acknowledge": In the event of an alarm, a message is also displayed. This message then
has to be acknowledged.
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Options Do not acknowledge, Acknowledge
Factory setting Do not acknowledge
Save event
Navigation Expert - Application - Limits - Limit x - Save event
Direct access code: 450008-0xx
Examples: Set point 1: 450008-000; Set point 30: 450008-029
Description Stores a message in the event log on limit value violation.
Options No, Yes
Factory setting Yes
Event text LV on
Navigation Expert - Application - Limits - Limit x - Event text LV on
Direct access code: 450009-0xx
Examples: Set point 1: 450009-000; Set point 30: 450009-029
Description This text (including date and time) is shown on the display and/or stored in the event log.
Only available if "LV messages" is set to "Acknowledge" or "Save message" is set to "Yes".
If no text is entered, the device generates its own text (e.g. Analog 1 > 100%).
User entry Text (max. 22 characters)
Event text LV off
Navigation Expert - Application - Limits - Limit x - Event text LV off
Direct access code: 450010-0xx
Examples: Set point 1: 450010-000; Set point 30: 450010-029
Description The same as "Event text LV on", but on return from alarm to normal condition.
User entry Text (max. 22 characters)

Record duration of LV on
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Navigation

Description

Options

Factory setting

Expert - Application - Limits - Limit x - Record duration of LV on
Direct access code: 450011-0xx
Examples: Set point 1: 450011-000; Set point 30: 450011-029

The duration of a set point violation can be recorded. The duration is appended to the
"limit value off" event text (format: <hhhh>h<mm>:<ss>).

Power failure times do not affect the duration. If the set point was violated before the
power failure and is still violated after the power failure, the duration continues.

No, Yes

No

Reset relay

Navigation Expert - Application - Limits - Limit x - Reset relay
Direct access code: 450016-0xx
Examples: Set point 1: 450016-000; Set point 30: 450016-029
Description If LV no longer violated: the relay is switched as long as the set point is violated.
After acknowledging message: even if the set point is no longer violated, the relay remains
switched until the message has been acknowledged. If the set point is still violated when
the message is acknowledged, the relay stays switched until the set point is no longer
violated.
Up to message acknowledgment: the relay remains active until the message is
acknowledged or the set point is no longer active.
Options If LV no longer violated, After acknowledging message, Up to message acknowledgment
Factory setting If LV no longer violated
Save cycle
Navigation Expert - Application - Limits - Limit x - Save cycle
Direct access code: 450012-0xx
Examples: Set point 1: 450012-000; Set point 30: 450012-029
Description Normal: Save in normal store cycle.
Alarm cycle: Fast storage during an alarm violation, e.g. every second. Attention: Requires
higher memory capacity.
ﬂ = The save cycle is set under signal groups .> B 233
= In the event of an alarm violation, all the groups are saved in the alarm cycle.
Options Normal, Alarm cycle
Factory setting Normal
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Draw help line

Navigation Expert - Application - Limits - Limit x > Draw help line
Direct access code: 450013-0xx
Examples: Set point 1: 450013-000; Set point 30: 450013-029
Description The user can configure whether this set point should be displayed in the graphic as a help
line (in the color of the channel).
Note: 4 lines can be shown per channel in a single group.
Options No, Yes
Factory setting No
Copy settings
Navigation Expert - Application - Limits - Limit x - Copy settings
Direct access code: 450200-0xx
Examples: Set point 1: 450200-000; Set point 30: 450200-029
Description Copies settings from actual channel to selected channel.
Options No, in limit x (all the limits are displayed)
Factory setting No

"Batch mode" submenu (option)

Navigation

Description

Expert - Application - Batch mode

Contains settings for the batch mode.

ﬂ Detailed descriptions of this device option can be found in the associated
documentation.

"Signal groups" submenu

Navigation

Description

232

Expert - Application - Signal groups

Group the analog, digital and/or mathematics channels such that you can call up
important information at the press of a button during operation (e.g. temperatures, signals
in plant unit 1).

ﬂ = Maximum 8 channels per group!
= High speed storage (100ms) is only available in group 1.
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"Group x" submenu

Navigation Expert - Application - Signal groups - Group x
Description ﬂ x = place holder for selected group.
Various general settings for measured value display of the device.
Identifier
Navigation Expert - Application - Signal groups - Group x - Identifier
Direct access code: 460000-0xx
Examples: Group 1: 460000-000; Group 4: 460000-003
Description Enter a name for these groups.
User entry Text (max. 20 characters)
Factory setting Group x
Save cycle
Navigation Expert - Application - Signal groups - Group x - Save cycle
Direct access code: 460001-0xx
Examples: Group 1: 460001-000; Group 4: 460001-003
Description Configure the save cycle with which this group should be saved in normal conditions (see
also set point/save cycle).
The save cycle is independent of the measured value display (see Operating
Instructions).
Options Off, 100ms (only for group 1), 1s, 2s, 3s, 4s, 5s, 10s, 15s, 20s, 30s, 1min, 2min, 3min,
4min, 5min, 10min, 15min, 30min, 1h
Factory setting 1min
Alarm cycle
Navigation Expert - Application - Signal groups - Group x - Alarm cycle
Direct access code: 460002-0xx
Examples: Group 1: 460002-000; Group 4: 460002-003
Description Configure the save cycle with which this group should be saved in an alarm condition (set
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point violation).
Attention: Requires higher memory capacity.
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Options Off, 100ms (only for group 1), 1s, 2s, 3s, 4s, 5s, 10s, 15s, 20s, 30s, 1min, 2min, 3min,
4min, 5min, 10min, 15min, 30min, 1h
Factory setting 1min
Display blue
Navigation Expert - Application - Signal groups - Group x - Display blue
Direct access code: 460003-00x
Examples: Group 1: 460003-000; Group 4: 460003-003
Description Choose which input/calculate variable should be displayed in this group.
Options Switched off, Universal input x, Digital input x, Maths x
Factory setting Switched off
Display
Navigation Expert - Application - Signal groups - Group x - Display
Direct access code: 460004-00x
Examples: Group 1: 460004-000; Group 4: 460004-003
Description Please select which data from the selected channel should be displayed.
If the "Everything" option is selected, the device switches cyclically between the
various values of the channel (instantaneous value, analysis 1 etc.)
Options Instantaneous value/state, Analysis x, Totalizer, Everything
Factory setting Instantaneous value/state
Display black
Navigation Expert - Application - Signal groups - Group x - Display black
Direct access code: 460005-00x
Examples: Group 1: 460005-000; Group 4: 460005-003
Description Choose which input/calculate variable should be displayed in this group.
Options Switched off, Universal input x, Digital input x, Maths x
Factory setting Switched off
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Display
Navigation Expert - Application - Signal groups - Group x - Display
Direct access code: 460006-0xx
Examples: Group 1: 460006-000; Group 4: 460006-003
Description Please select which data from the selected channel should be displayed.
Options Instantaneous value/state, Analysis x, Totalizer, Everything
Factory setting Instantaneous value/state
Display red
Navigation Expert - Application - Signal groups - Group x - Display red
Direct access code: 460007-00x
Examples: Group 1: 460007-000; Group 4: 460007-003
Description Choose which input/calculate variable should be displayed in this group.
Options Switched off, Universal input x, Digital input x, Maths x
Factory setting Switched off
Display
Navigation Expert - Application - Signal groups - Group x - Display
Direct access code: 460008-0xx
Examples: Group 1: 460008-000; Group 4: 460008-003
Description Please select which data from the selected channel should be displayed.
Options Instantaneous value/state, Analysis x, Totalizer, Everything
Factory setting Instantaneous value/state
Display green
Navigation Expert - Application - Signal groups - Group x - Display green
Direct access code: 460009-00x
Examples: Group 1: 460009-000; Group 4: 460009-003
Description Choose which input/calculate variable should be displayed in this group.
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Options Switched off, Universal input %, Digital input x, Maths x
Factory setting Switched off
Display
Navigation Expert - Application - Signal groups - Group x - Display
Direct access code: 460010-0xx
Examples: Group 1: 460010-000; Group 4: 460010-003
Description Please select which data from the selected channel should be displayed.
Options Instantaneous value/state, Analysis x, Totalizer, Everything
Factory setting Instantaneous value/state
Display violet
Navigation Expert - Application - Signal groups - Group x - Display violet
Direct access code: 460011-00x
Examples: Group 1: 460011-000; Group 4: 460011-003
Description Choose which input/calculated variable should be displayed in this group.
Options Switched off, Universal input x, Digital input x, Maths x
Factory setting Switched off
Display
Navigation Expert - Application - Signal groups - Group x - Display
Direct access code: 460012-0xx
Examples: Group 1: 460012-000; Group 4: 460012-003
Description Please select which data from the selected channel should be displayed.
Options Instantaneous value/state, Analysis x, Totalizer, Everything
Factory setting Instantaneous value/state
Display orange
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Navigation Expert - Application - Signal groups - Group x - Display orange
Direct access code: 460013-00x
Examples: Group 1: 460013-000; Group 4: 460013-003
Description Choose which input/calculate variable should be displayed in this group.
Options Switched off, Universal input x, Digital input x, Maths x
Factory setting Switched off
Display
Navigation Expert - Application - Signal groups - Group x - Display
Direct access code: 460014-0xx
Examples: Group 1: 460014-000; Group 4: 460014-003
Description Please select which data from the selected channel should be displayed.
Options Instantaneous value/state, Analysis x, Totalizer, Everything
Factory setting Instantaneous value/state
Display cyan
Navigation Expert - Application - Signal groups - Group x - Display cyan
Direct access code: 460015-00x
Examples: Group 1: 460015-000; Group 4: 460015-003
Description Choose which input/calculate variable should be displayed in this group.
Options Switched off, Universal input x, Digital input x, Maths x
Factory setting Switched off
Display
Navigation Expert - Application - Signal groups - Group x - Display
Direct access code: 460016-0xx
Examples: Group 1: 460016-000; Group 4: 460016-003
Description Please select which data from the selected channel should be displayed.
Options Instantaneous value/state, Analysis x, Totalizer, Everything
Factory setting Instantaneous value/state
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Display brown
Navigation Expert - Application - Signal groups - Group x - Display brown
Direct access code: 460017-00x
Examples: Group 1: 460017-000; Group 4: 460017-003
Description Choose which input/calculate variable should be displayed in this group.
Options Switched off, Universal input x, Digital input x, Maths x
Factory setting Switched off
Display
Navigation Expert - Application - Signal groups - Group x - Display
Direct access code: 460018-0xx
Examples: Group 1: 460018-000; Group 4: 460018-003
Description Please select which data from the selected channel should be displayed.
Options Instantaneous value/state, Analysis x, Totalizer, Everything
Factory setting Instantaneous value/state

Grid divisions

Navigation Expert - Application - Signal groups - Group x - Grid divisions
Direct access code: 460019-0xx
Examples: Group 1: 460019-000; Group 4: 460019-003
Description Indicates the number of lines ("amplitude grid") that should be displayed. Example: display
of 0 to 100%: select 10 divisions, display O to 14pH: select 14 divisions.
Options Logarithmic, 1, 2, 3, 4, 5,6, 7,8,9, 10, 11, 12, 13, 14, 15, 16, 17, 18, 19, 20
Factory setting 10
Min. decade
Navigation Expert - Application - Signal groups - Group x > Min. decade
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Direct access code: 460020-0xx
Examples: Group 1: 460020-000; Group 4: 460020-003
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Description
Options

Factory setting

Set the decade from which the display should be split.
1, 10, 100, 1000, 10000, 100000, 1000000, 10000000

1

Max. decade

Navigation Expert - Application - Signal groups - Group x - Max. decade
Direct access code: 46002 1-0xx
Examples: Group 1: 460021-000; Group 4: 460021-003

Description Set the decade up to which the display should be split.

Options 1, 10, 100, 1000, 10000, 100000, 1000000, 10000000

Factory setting 10000

Curve display

Navigation Expert - Application - Signal groups - Group x - Curve display
Direct access code: 460022-0xx
Examples: Group 1: 460022-000; Group 4: 460022-003

Description The instantaneous values are displayed as standard for the measured value curves.

Alternatively, this current value display can also be disabled which means that more data
can be shown on the display as a result.

Options No instantaneous values, With instantaneous values

Factory setting With instantaneous values

Curve display

Navigation Expert - Application - Signal groups - Group x - Curve display
Direct access code: 46002 3-0xx
Examples: Group 1: 460023-000; Group 4: 460023-003

Description Configure the background color for the curve display.

Options White background, Black background

Factory setting White background
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Zoom
Navigation Expert - Application - Signal groups - Group x - Zoom
Direct access code: 460028-0xx
Examples: Group 1: 460028-000; Group 4: 460028-003
Description Defines the zoom that is shown in "Curves" or "Waterfall" display mode. This setting does
not affect other display modes (e.g. Curves in range, Bar graph etc.).
Options Do not display, Scroll display, Display blue, Display black, Display red, Display green,
Display violet, Display orange, Display cyan, Display brown
Factory setting Do not display
Bargraph
Navigation Expert - Application - Signal groups - Group x - Bargraph
Direct access code: 460024-0xx
Examples: Group 1: 460024-000; Group 4: 460024-003
Description Configure the direction in which the bar graphs should be drawn.
Options Vertical (bottom->top), Vertical (top->bottom), Horizontal (left->right), Horizontal (right-
>left), Centered/vertical, Centered/horizontal
Factory setting Vertical (bottom->top)

Batch assignment (option)

Navigation

Description

Options

Factory setting

Expert - Application - Signal groups - Group x - Batch assignment
Direct access code: 460025-0xx
Examples: Group 1: 460025-000; Group 4: 460025-003

Configure what batch this group belongs to.

ﬂ = Channels can be assigned to multiple batches/groups.
= Only relevant for batch printout.

Do not assign any batch, Assign all batches, Batch x

Assign all batches

Save group (Batch option)
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Navigation

Description
Options

Factory setting

Expert - Application - Signal groups - Group x - Save group
Direct access code: 46002 6-0xx
Examples: Group 1: 460026-000; Group 4: 460026-003

The group will always be saved or only when the allocated batch is active.
Only when batch is active, Always

Always

"Circular chart" submenu

Navigation

Description

Expert - Application - Signal groups - Group x - Circular chart

Contains settings for the circular chart.

1 revolution =

Navigation

Description

Options

Factory setting

Expert - Application - Signal groups - Group x - Circular chart - 1 revolution =
Direct access code: 460027-0xx
Examples: Group 1: 460027-000; Group 4: 460027-003

Configure how long it takes for the circular chart to be written to once completely (one
complete revolution).
Note: The device only ever shows 1/4 of the circular chart.

1 hour, x hours, 1 day, x days

1 hour

"E-mail" submenu

Navigation Expert - Application > E-mail

ﬂ With Tele-Alarm option under

Expert > Application > Tele-Alarm - General - E-mail setup
Description Contains settings required if alarms are to be transmitted by e-mail.
ﬂ Test the e-mail settings under Diagnostics - Simulation - E-mail.

SMTP host
Navigation Expert - Application > E-mail > SMTP host

Direct access code: 510062-000
Description Enter your SMTP host here. If necessary, contact your network administrator or e-mail
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provider.
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User entry

Text (max. 40 characters)

Server requires SSL

Navigation Expert - Application > E-mail - Server requires SSL
Direct access code: 510061-000
Description Specify whether the e-mail server requires a secure connection (SSL).
STARTTLS: Runs on the same TCP port as unencrypted SMTP (port 25 or 587).
SMTPS: Completely encrypted with own TCP port (465).
If necessary, contact your network administrator or e-mail provider.
Options No, Yes (SMTPS), Yes (STARTTLS)
Factory setting No
Port
Navigation Expert - Application - E-mail - Port
Direct access code: 510063-000
Description Enter your SMTP port here. If necessary, contact your network administrator or e-mail
provider.
User entry Number (max. 4 digits)
Factory setting 25
Sender
Navigation Expert - Application - E-mail - Sender
Direct access code: 510064-000
Description Enter the e-mail address of the device here (this text appears as the sender of the e-mail).
If necessary, contact your network administrator or e-mail provider.
ﬂ If a valid e-mail address is not configured this might cause e-mail transmission
problems, depending on the particular provider.
User entry Text (max. 60 characters)
User name
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Navigation Expert - Application > E-mail - User name
Direct access code: 510066-000

Description Configure the user name of the e-mail account here. If necessary, contact your network
administrator or e-mail provider.

User entry Text (max. 60 characters)
Password
Navigation Expert - Application > E-Mail - Password

Direct access code: 510067-000

Description Enter the password for authentication here. If necessary, contact your network
administrator or e-mail provider.

User entry Text (max. 22 characters)

"E-mail addresses" submenu

Navigation Expert - Application - E-mail - E-mail addresses

Description Here, enter all the e-mail addresses messages should be sent to in the event of an alarm.

ﬂ Assignment to the alarms is performed later on.

E-mail address x

Navigation Expert - Application > E-mail - E-mail addresses > E-mail address x
Direct access code:
E-mail address 1: 510080-000
E-mail address 5: 510084-000

Description Here, enter an e-mail address a message should be sent to.

ﬂ Assignment to the alarms is performed later on.

User entry Text (max. 60 characters)

"Limit value violations" submenu

Navigation Expert - Application > E-mail - Limit value violations
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Description Specify who should receive e-mails when limit value violations occur (both on and off
messages).

ﬂ Only for limit values where "Save message" is set to "Yes".

Recipient x

Navigation Expert - Application > E-mail - Limit value violations - Recipient x
Direct access code:
Recipient 1: 510110-000; Recipient 2: 510111-000

Description Select who should receive the e-mail.

Options Not used, E-mail address x

Factory setting Not used

"On/off messages" submenu

Navigation Expert - Application - E-mail - On/off messages

Description Specify who should receive e-mails when "on"/"off" messages occur (for digital inputs or
maths channels).

ﬂ Only for inputs where "Save message" is set to "Yes"

Recipient x
Navigation Expert - Application > E-mail - On/off messages - Recipient x
Direct access code:
Recipient 1: 510115-000; Recipient 2: 510116-000
Description Select who should receive the e-mail.
Options Not used, E-mail address x
Factory setting Not used

"Errors (Fxxx/Sxxx)" submenu

Navigation Expert > Application > E-mail - Errors (Fxxx/Sxxx)
Description Specify who should receive e-mails when errors occur (Fxxx and Sxxx messages).
Recipient x
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Navigation

Description
Options

Factory setting

Expert-> Application - E-mail - Errors-> Recipient x
Direct access code:
Recipient 1: 510120-000; Recipient 2: 510121-000

Select who should receive the e-mail.

Not used, E-mail address x

Not used

"Maintenance required" (submenu)

Navigation Expert - Application > E-mail - Maintenance required
Description Specify who should receive e-mails when maintenance is required (Mxxx messages).
Recipient x
Navigation Expert - Application - E-mail - Maintenance required - Recipient x
Direct access code:
Recipient 1: 510130-000; Recipient 2: 510131-000
Description Select who should receive the e-mail.
Options Not used, E-mail address x
Factory setting Not used

"Printer" submenu

Navigation

Description

Endress+Hauser

Expert - Application - Printer

Contains printer settings.

ﬂ Only relevant if a printer is directly connected to the device.

Parameters | Description Direct access code
Printer Please select the printer you wish to use. For supported printers please 540000-000
refer to the Operating Instructions.
IP address Enter the IP address of the network printer here. If you do not know the |540001-000
IP address, contact your network administrator.
Note: A DNS name may also be used.
Port Please enter the port of your network printer (available from your 540002-000
network administrator). Note: Port 9100 is usually used.
Color printer | Please specify whether you are using a black and white or color printer. | 540003-000
Paper size Please select the paper size of your printer. 540004-000
Print Select the print direction as per the properties of the printer used. 540006-000
direction
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Parameters | Description Direct access code
Characters/ | Enter the maximum number of characters per line here. 540007-000
line

Blank rows Enter the number of blank lines required at the end of the printout to 540008-000
at the end make it easier to tear off.

Fault You can switch a relay if an error occurs during the printout. The relay 540005-000
switches remains switched until the printer is ready again or the device is

restarted.
"Serial Settings required if you are using the RS232 or RS485 interface of the 150101-000
interface" device. 150103-000
submenu

"Softkeys" submenu

Navigation Expert - Application > Softkeys

Description You can configure the functions that are assigned to the softkeys of the device.

Softkey 1-3

Navigation Expert - Application - Softkeys - Softkey x

Direct access code, softkey 1: 520000-000
Direct access code, softkey 2: 520001-000
Direct access code, softkey 3: 520002-000

Description Specify the function to be assigned to this softkey.

Options Not assigned, Safe SD Card removal, Remove USB stick safely, Printout, Enter batch info,
Event log/audit trail, Historic measured values, Log on to the device (login), Log out of the
device (logout), Screenshot, Search in trace, Show analyses, Change set point, Next group,
Operation

Factory setting Softkey 1: Event log/audit trail

Softkey 2: Historic measured values
Softkey 3: Search in trace

"Texts" submenu

Navigation Expert - Application > Texts

Description Settings only needed if you want to save text for subsequent reporting. Here, configure the
text that can be saved in the event log during operation.

Text 1-30
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Navigation Expert - Application - Texts > Text x
Direct access code, text 1: 530000-000

Direct access code, text 30: 530029-000
Description Generate or change the text.

User entry Text (max. 22 characters)

"Wastewater" submenu (option)

Navigation Expert - Application > Wastewater

Description Contains settings for using the device in the wastewater sector.

ﬂ Detailed descriptions of this device option can be found in the associated
documentation.

"Tele-Alarm" submenu (option)

Navigation Expert - Application > Tele-Alarm
Description Contains settings for alerts via a modem connected to the device or by e-mail.
ﬂ Detailed descriptions of this device option can be found in the associated
documentation.
"WebDAYV Client" submenu
Navigation Expert - Application > WebDAV Client
Description All recorded data are transmitted to an external WebDAV server (e.g. NAS). The format
can be specified or selected via "Setup > Advanced setup - System - External memory
-> Save as".
Parameters | Description Direct access code
Enable Switch the WebDAV Client functionality on/off. When active, the device |472000-000

copies the saved measured values automatically to the configured server.

E] Only possible using the Ethernet interface!

Selection: No, Yes, Yes (SSL)
Factory setting: No

IP address Enter the IP address of the WebDAV server here. 472001-000
E] A DNS name can also be used.

Entry: IP address
Factory setting: 0.0.0.0
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Parameters | Description Direct access code
Port This communication port is used to communicate with the WebDAV 472002-000
Server.

@ If your network is protected by a firewall, this port may have to be
enabled. Please contact your network administrator if this is the
case.

Entry: Numbers (max. 5 digits)
Factory setting: 80

User name Input of the user name that can access the WebDAV server. 472004-000
Entry: Text (max. 20 characters)

Password Password for accessing the WebDAV server. 472007-000
Entry: Text (max. 20 characters)

Directory Enter the directory in which the data should be saved. 472005-000
Entry: Text (max. 120 characters)

Save as "Protected format": All data are stored in a manipulation protected 472010-000
encrypted format. They can be interpreted only by the PC analysis
software provided.

"Open format": data are stored in a CSV format, this can be opened by a
number of different programs (e.g. MS Excel) (Attention: no
manipulation security).

Selection: protected format, open format (*.csv)

Factory setting: protected format

ﬂ Test of WebDAV Client settings under "Diagnostics - Simulation > WebDAV
Client".

17.1.6 "Diagnostics" submenu
Device information and service functions for a swift device check.

ﬂ Only some of the diagnostic functions are available under Expert - Diagnostics. For
other functions, see Main menu - Diagnostics.

Actual diagnostics
(Online configuration)

Navigation Expert - Diagnostics - Actual diagnostics
Direct access code: 050000-000

Description Displays the current diagnosis message.

Last diagnostics
(Online configuration)

Navigation Expert - Diagnostics - Last diagnostics
Direct access code: 050005-000

Description Displays the last diagnosis message.
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Last restart
(Online configuration)

Navigation

Description

Expert - Diagnostics - Last restart
Direct access code: 050010-000

Information as to when the device was last restarted (e.g. due to a power failure).

"Diagnosis list" submenu

Navigation

Description

Expert - Diagnostics - Diagnosis list

All diagnosis messages are listed in chronological order.

"Event logbook" submenu

Navigation

Description

Expert - Diagnostics - Event logbook

Events such as alarm set point infringement and power failure are listed in the correct
time sequence.

"Device information" submenu

(Online configuration)

Navigation Expert - Diagnostics - Device information

Description Displays important device information.

Device tag

Navigation Expert - Diagnostics - Device information - Device tag
Direct access code: 000031-000

Description Individual device tag name/unit identifier (max. 32 characters).

Serial number
(Online configuration)

Navigation

Description
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Expert - Diagnostics - Device information - Serial number
Direct access code: 000027-000

Individual serial number of the device. Please provide these details when ordering spare
parts or asking any questions about the unit.
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Order code
(Online configuration)

Navigation

Description

Expert - Diagnostics - Device information - Order code
Direct access code: 000029-000

Displays the order code.
The order code indicates the attribute of all the features of the product structure for the
device and thus uniquely identifies the device. It can also be found on the nameplate.

ﬂ Uses of the order code
= To order an identical spare device.
= To check the ordered device features using the delivery note.

Firmware Version
(Online configuration)

Navigation

Description

Expert - Diagnostics - Device information - Firmware Version
Direct access code: 000026-000

Displays the installed firmware version of the device. Please send these details with any
questions about the unit.

ENP version
(Online configuration)

Navigation

Description

Expert - Diagnostics - Device information - ENP version
Direct access code: 000032-000

Displays the version of the electronic nameplate. Please send these details with any
questions about the unit.

ENP device name
(Online configuration)

Navigation

Description

250

Expert - Diagnostics - Device information - ENP device name
Direct access code: 000020-000

Displays the ENP device name (electronic name plate). Please send these details with any
questions about the unit.
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Device name
(Online configuration)

Navigation

Description

Expert - Diagnostics - Device information - Device name
Direct access code: 00002 1-000

Displays the device name. Please send these details with any questions about the unit.

Manufacturer ID
(Online configuration)

Navigation

Description

Expert - Diagnostics - Device information - Manufacturer ID
Direct access code: 000022-000

Displays the manufacturer ID. Please send these details with any questions about the unit.

Manufacturer name
(Online configuration)

Navigation Expert - Diagnostics - Device information - Manufacturer name
Direct access code: 000023-000
Description Displays the manufacturer name. Please send these details with any questions about the
unit.
Firmware

(Online configuration)

Navigation

Description

Expert - Diagnostics - Device information - Firmware
Direct access code: 009998-000

Displays the installed firmware of the device. Please send these details with any questions
about the unit.

"Simulation" submenu

Navigation

Description
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Expert - Diagnostics - Simulation

Settings for simulation mode.
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Operating mode

Navigation

Description

Options

Factory setting

252

Expert - Diagnostics - Simulation - Operating mode
Direct access code: 010010-000

Normal operation: Unit plots the signals from the connected measurement points.
Simulation: Instead of operating with the real measurement points the signals are

simulated (using the actual settings).
Normal operation, Simulation

Normal operation
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Outputs (submenu) . .. ...................... 162
Overview of symbols . . . ............ .. ... ... ... 34
P
Paper size (parameter) . ..................... 111
Parity (parameter) ... ........... . ... .. ... ... 183
Password (parameter) . . ..................... 243
Pause between Modbus Master commands
(parameter) . . ... 188
Ping interval (parameter) . ................... 178
Ping retry (parameter) . ...................... 179
Ping timeout (parameter) . ................... 178
Pipe material (parameter) .. .................. 210
Plot type (parameter) . . ..................... 136
Poll timeout (parameter) . .................... 179
Port (parameter) . . . .. .. 120, 135,171,172, 185, 242
PRESET (parameter) . ....................... 112
Pressure (parameter) . . ...................... 194
Pressure engineering unit (parameter) . .......... 194
Printer (submenu) . . ......... ... .. ... .. .... 245
Productsafety .. ...... ... 9
Profibus DP (submenu) .. .................... 189
Profibus DP bit 0.0-0.7 (parameter) . ............ 191
Profibus DP byte x...y (parameter) . ............. 190
Profibus DP Master in/out (parameter) . ......... 190
Profibus DP Slave address (parameter) . .......... 189
Profibus DP slot X (submenu) . ................. 190
Protected by (parameter) . .................... 119
Protocol (parameter) ... ..................... 182
Pulse counter (parameter) .. .................. 138
Pulse width (parameter) ... .................. 164
Put timeout (parameter) . .................... 178
R
Range (parameter) . ........................ 132
Range start (parameter) . ................ 140, 147
Readout function (parameter) ... .............. 135
Recipient x (parameter) . ................. 244,245
Record duration (parameter) . ............. 160, 201
Record duration of LV on (parameter) ........... 230
Reference channel (parameter) . ............... 162
Register address (parameter) . ................. 136
Registered trademarks . . .. ..................... 7
Registers per Modbus Master command (parameter) 187
Relay (submenu) . .......................... 167
Remote control (parameter) . .................. 173
Remote controlled (parameter) ... ............. 167
Reset channel (parameter) . ................... 222
Reset relay (parameter) .. .................... 231
Reset to zero (parameter) .. .................. 221
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S
Save as (parameter) . .. ..................... 122
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Save group (parameter) . ..................... 240
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